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Welcome to the Vista What’s different about the Vista? 
 

1. Welcome to the Vista 
Welcome to the User Guide for the Jands Vista lighting console. This guide is 
intended to give you the information you need to get your Vista up and running 
as quickly as possible. 

Note that this guide will be regularly updated as enhancements are made to the 
Vista. A current version of the manual is available at jands.com/support-vista-
v2/download/. 

What’s different about the Vista? 
You’ll have noticed that the Vista is a bit different to most other consoles you’ve 
used. Instead of a keypad, it uses a graphic interface; instead of relying on you 
entering hundreds of key combinations, the Vista lets you do everything visually; 
instead of representing your show as numbers, the Vista represents it as events 
happening over time. 

If you’ve seen any of the digital editing software packages for sound and video 
that are available these days, the most different aspect of the Vista, the timeline, 
will be instantly familiar to you. If not, don’t worry, once you start using it you’ll 
pick it up very quickly. 

The Vista is different, but that’s what makes it so much easier to use. Once 
you’ve read this guide you’ll have enough of an idea of how this console works 
to create your first lightshow. 

What things are the same as on other 
consoles? 
Apart from the pen and the timeline concept, the Vista contains all the basic 
elements of live lighting that you’re familiar with. You’ll find controls for 
intensity, colour, beam, gobos and so on; you’ll find libraries of all the 
manufacturers’ most popular fixtures to choose from; you’ll find a console that 
has the usual faders, buttons and LCD displays. 

So don’t worry, the Vista has a lot in common with other consoles – we’ve taken 
all the best elements of existing consoles and added a whole new dimension to 
them. You’ll soon be right at home with the Vista. 
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About the generic fixture model Welcome to the Vista 

About the generic fixture model 
One thing about the Vista that’s not immediately obvious is the ‘generic fixture 
model’. What is it? It’s a part of the software that works in the background and 
enables all fixtures, no matter what type or manufacturer to be treated the same 
way.  

Lets say you’ve programmed a show using one brand of fixture but need to 
replace some of them with a different kind. Normally this would be a major 
hassle because you’d have to find a similar fixture then re-program each and 
every cue. 

With the Vista, you can replace a fixture and you don’t have to do any re-
programming. Why? Because everything you’ve programmed is stored in 
generic form rather than as specific DMX channel values. For instance if you’ve 
programmed the lights to be red, the Vista can send that information to any light 
and achieve the same colour. 

Sure, if you replace a fixture that has colour mixing with a fixture that has a fixed 
colour wheel, you won’t expect to get the exact same result, but even in this case, 
the Vista will adapt and provide as near a match as the replacement fixture is 
capable of. 

Need more information? 
If you have questions about the Vista or you’d like more information, go to our 
website at HTUwww.jands.com/lightingUTH, or call us on +61-2-9582-0909. 
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Getting started Setting up the console 

2. Getting started 

Setting up the console 

Power 
Connect the Vista L, T, I or  S series console to any mains supply between 100 
and 240vAC. The Vista M series obtains power via the USB port. 

External displays 
You can attach two external displays, including touch screen monitors to the 
Vista T series consoles using standard VGA connectors.  
Vista I series consoles have connections for  one DVI and one VGA monitor. A 
DVI – VGA cable can be used if you prefer to use two VGA monitors. 
Vista L series consoles have connections for one DVI / HDMI  and one DVI / 
VGA monitor. 

Ü Vista has been tested with Wacom pen tablet LCDs and  ELO ‘Intellitouch 
and Accutouch’ monitors.  ELO makes many different touch screen monitors 
and not all models may be compatible. Please check for compatibility before 
purchasing touch screen monitors for use with your Vista console. 

For Vista M and S series control surfaces, monitor configuration will depend on 
the configuration of the computer you are using. 

Desk Lights 
You can attach two Littlelite or equivalent desklights to the Vista L and T series 
console and one to the I and S series consoles.  
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Switching on Getting started 

Switching on 
When you switch the console power on or launch the application on your PC, 
Vista starts up and displays the opening splash screen: 

 

Once it finishes loading the program offers you the option to open or import an 
existing show file or create a newone. If you choose ‘Create a new show…’ Vista 
displays the Patch window: 

 

This is the Patch window, waiting for you to start creating a new show. To see 
the other Vista windows you use the buttons on the toolbar at the top left of the 
screen: 
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Getting started Switching on 

This button… does this… 

 
displays the Patch window  

 
displays the Console hardware simulation window 

 
displays the Programmer Fixtures window 

 
displays the Programmer Timeline view.  

 
displays the Playback control window  

 
displays the fixture Output window 
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Creating and loading shows Getting started 

Creating and loading shows 

Creating a show 
To create a new show at any time, choose the New Show option from the File 
menu. 

Loading existing shows 
To load a show you’ve already created, choose the Open  Show option from the 
File menu. Vista displays the Open Show window: 

 

To load a show archive you’ve previously saved (or transferred to the console 
using the export / import function), find the directory containing it, then click on 
the filename to select it and hit the Open button to load it. 

Saving shows 
To save a show at any time, choose the Save Show option from the File menu. As 
with any computer, it’s a good idea to save regularly in case of power failure. 
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Getting started Creating and loading shows 

The first time you save a new show, Vista displays the Save As window: 

 

Type a name for the file and then click the Save button. Vista automatically 
creates a show folder, with the same name and puts the show file inside it. Once 
you’ve named the file, each time you choose the Save option from then on, Vista 
overwrites that file with the new details without displaying this window. 

Saving copies of shows 
To save a separate version of a show with a different name, choose the Save 
Show As… option from the File menu. You can then give the file another name 
and save it in a separate show folder. 

Importing show archives 
You can also open shows you’ve created on a PC or another console onto the 
Vista. The shows must be on a CD or any kind of storage device that connects to 
the Universal Serial Bus (USB) port (such as a memory stick). 

To open a show, attach the USB device or put the CD in the CD drive (if 
available) and choose the Import > Show… option from the File menu. 

Exporting show archives (backing up) 
It’s extremely important to make backup copies of your show user data folders. 
Like any other computer, the Vista stores your shows on a hard drive, and 
although it’s extremely unlikely, if this drive were to fail (e.g. if the console was 
dropped) you could lose all the show files stored on it.  

For this reason we recommend that you make regular backups of your work, 
onto a storage device that you can connect via a USB port.  
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Creating and loading shows Getting started 

To export a show archive onto an external storage device: 
1. Connect a USB Flash drive or  external disk  to the USB port. 

2. Choose the Export option from the File menu. Vista displays the Export 
window: 

 

3. Click on the Show button and then select the show(s) to backup from the list 
of show files. 

4. Click the Next button. Vista displays the Export window: 

 

5. Click the Browse button and choose a drive and directory on the computer 
or storage device and hit the Export button. 

6. Click the Finish button to close the Export window. 
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Getting started Creating and loading shows 

Deleting shows 
To delete a show, choose the Open show option from the File menu, then right-
click on the show folder name and choose ‘Delete’ from the popup menu. 

 

Password-protecting your console or show 
You can lock your  console or show file or disable editing, with a password. To 
do this: 
1. Choose the Lock option from the File menu. Vista displays a popup menu 

with three options: 

This option… does this… 

Lock entire 
console 

the password is required to use any console functions or 
controls.  

Disable all 
editing 

the password is required to edit cuelists, groups, presets and 
all other show components  

Lock current 
show 

the password is required to save changes to the show file 

 

2. Select an option from the popup menu. Vista displays the Password 
window: 

 

3. Enter your password in both  boxes and click ‘OK’ 

 Your show or console is now password protected. 
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User Preferences Getting started 

User Preferences 
There are a number of user preferences  that configure and determine how the 
Vista software operates. To set these preferences, choose the ‘User Preferences’ 
option from the File menu. Vista displays the User Preferences screen: 

 
This window has 8 tabs: 

General 
This tab includes options for Patching, Presets and the Fixture Chooser. 

This option… does this… 

Auto generate fixture 
type groups 

Automatically creates fixture group icons, in the 
Chooser window whenever new fixture types are 
added to the patch 

Preview Parked 
Fixtures 

Shows changes on the Fixture icons even though the 
fixture(s) or some features are parked . 

Enable Quick Picker 
page filtering 

When a preset containing multiple features (i.e. 
Intensity, Position, Colour, etc) is selected from a 
filtered page (i.e. Presets > Colour) only one feature 
type will be applied to the selected fixture(s). 

Use the Home Preset 
when clearing 
fixtures or features. 

When fixtures or individual features of fixtures are 
Cleared, in the programmer, they will go to values 
saved in the Home preset. If there are no values 
saved for the fixture(s) they will go to their defaults. 
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Getting started User Preferences 

This option… does this… 

Zoom with mouse 
wheel 

Allows you to zoom in and out on the chooser 
window by using the scroll wheel on your mouse. 

Use these settings for 
new shows 

Makes the current settings the default for all new 
shows. 

Reset to factory 
defaults 

Resets all settings on the current tab to their factory 
defaults. 

 

Naming 
Most components are 
identified by a number 
(ID) and name. 

You can adjust how the 
names of Cuelists, Cues, 
Fixtures, Groups, Presets, 
Extracts, SmartFX FX 
Templates, Fixture Layouts 
and Snapshots appear by 
setting a format for each 
component.  

This option… does this… 

# displays the components ID number 

$ displays the components name. 

Use these settings for 
new shows 

Makes the current settings the default for all new 
shows. 

Reset to factory 
defaults 

Resets all settings on the current tab to their factory 
defaults. 

 

Console 
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User Preferences Getting started 

The console preferences 
control how some of the 
Vista hardware controls 
operate .  

This option… does this… 

Fader action 
threshold 

Adjusts the amount a fader must be moved before 
triggering an action. For example when a cuelist is 
set to play when the fader is moved up ( Auto-Play) 
this setting will control how far off zero the fader 
needs to be moved to play the cue. 

Encoder sensitivity Adjusts how many times an encoder needs to be 
rotated to go from minimum to maximum value. 

Encoder acceleration Sets the encodes to make bigger changes the faster 
they are turned. 

Grand Master locked Locks the Grand Master at it’s current setting  

Page holdover when 
active 

Prevents cuelists and groups from being paged out if 
they are contributing to the current output. 
Components that are  held will join the new page 
when: 

• The component is released or fully over-
ridden or 

· You press the page up and down buttons 
simultaneously 

Inhibit fader jitter Old or dirty faders may ‘jitter’ and cause small level 
changes. Adjusting this setting to a higher level 
reduces the effect of this problem. 
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Getting started User Preferences 

This option… does this… 

Use these settings for 
new shows 

Makes the current settings the default for all new 
shows. 

Reset to factory 
defaults 

Resets all settings on the current tab to their factory 
defaults. 

 

Serial input 
To trigger cuelists with 
ASCII text messages the 
Vista serial port must be 
configured to match the 
sending device.  

For more details on using 
serial devices with Vista 
see Appendix 8, Using serial 
communication to control 
cuelists on page 21-1 

 

This option… does this… 

Serial port Enables or disables the serial input 

Baud rate Sets the speed used for the serial port.Use a lower 
Baud rate for more reliable performance 

Data bits Sets the number of data bits. 8 data bits is almost 
always used in newer applications. 

Stop bits Sets the number of stop bits. Most devices use one 
stop bit. 

Parity Sets the Parity to None, Odd, Even, Mark or Space. 
The most common parity setting, is "none". 

Flow control Sets whether signals are used to pause and resume 
the transmission of data. Normally set to Off 
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User Preferences Getting started 

This option… does this… 

Use these settings for 
new shows 

Makes the current settings the default for all new 
shows. 

Reset to factory 
defaults 

Resets all settings on the current tab to their factory 
defaults. 

 

For more details on using serial devices with Vista see Appendix 8, Using serial 
communication to control cuelists on page 21-1 

Midi input 
To use Midi Timecode 
(MTC), Midi Show Control 
(MSC) or Midi Notes to 
control Vista the Midi 
preferences must be 
configured to match the 
sending device.  

This option… does this… 

Midi Show Control Sets the Midi device ID used for MSC messages. (0 – 
128) 

Midi Timecode Sets the channel  ID used for MTC. (Any channel or 0 
– 127) 

Midi Show Control Sets the channel  ID used for Midi Note messages. 
(Any channel or 0 – 16) 

External Midi Ports Displays a list of any external Midi ports that are 
available on a Mac or Windows systems. To select an 
external port tick the corresponding checkbox. 
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Getting started User Preferences 

This option… does this… 

Use these settings for 
new shows 

Makes the current settings the default for all new 
shows. 

Reset to factory 
defaults 

Resets all settings on the current tab to their factory 
defaults. 

 

For more details on using Show Control with Vista see MSC lighting messages on 
20-2 

For more details on using Midi Notes with Vista see Midi Notes on page 7-29 

For more details on using Midi Timecode with Vista see Using Timecode to control 
Cuelists on page 10-1 

Autosave 

 

You can set Vista to automatically save copies of your show while you are 
programming.  

This option… does this… 

Auto save current 
show 

Sets Autosave on or off for the current show. If 
Autosave is on a disk icon appears in menu bar. 
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User Preferences Getting started 

This option… does this… 

Auto save every Sets the interval, in minutes, between autosaves. If 
autosave is on the colour of the disk icon indicates its 
status: 

Grey - autosave is enabled but idle. 

Blue - autosave is saving a copy of the show. 

Red - autosave has not been able to save a copy of 
the show for 2 x the specified interval because the 
console has been busy with other tasks. 

Use these settings for 
new shows 

Makes the current settings the default for all new 
shows. 

Reset to factory 
defaults 

Resets all settings on the current tab to their factory 
defaults. 

Playback 

 

The playback preferences set how some playback actions are performed. 

This option… does this… 

Play reasserts entire 
cuelist 

Plays the tracked state of a cue even if it has been 
partially over-ridden by other playbacks. 

Reassert uses Live 
Time 

Uses the Live Time setting, rather than the cue 
timing when a cue is reasserted. 

Home stops effects Stops any effects running on a fixture feature when it 
is sent to its Home setting. 
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Getting started User Preferences 

This option… does this… 

Force refresh of all 
features 

Forces Vista to recalculate the output state more 
regularly. Normally only required for 
troubleshooting output errors on very large shows. 

Set options for 
highest refresh rate 

Sets ‘Reassert uses Live time’ On and Force refresh to 
Never. Has no effect on ‘Home stops effects’ 

Use these settings for 
new shows 

Makes the current settings the default for all new 
shows. 

Reset to factory 
defaults 

Resets all settings on the current tab to their factory 
defaults. 

 

Network 
This tab is used to set 
networking options for 
Tracking Backup and for 
systems using D1 
processing units. 

This option… does this… 

Vista Network 

Node Name Sets the name for this Vista device. 

Group Name Sets the name of the Group the Vista device belongs 
to. Devices in the same Group can operate together 
for tracking backup and distributed processing. 

Tracking Backup 
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User Preferences Getting started 

This option… does this… 

Timeout (sec)  After not receiving any communication, from the 
tracking backup console, for the Timeout period an 
alert window opens. This window provides options 
for dealing with the communication loss. 

Auto Failover (sec) Sets the time, before the Tracking backup console 
automatically takes over from a failed Master 
console. 

D1 Disconnection 

Auto run Cuelist after 
(sec) 

Sets the option to run one or more cuelists, from a D1 
if the unit loses communication with the Vista 
console. To set the cuelist(s) to run select the ‘Auto-
run on failure’ option on the Cuelist Properties 
window. For more information see Cuelist Properties 
on page 7-26 

Art-Net  

Broadcast address Sets the broadcast address for Art-Net outputs. The 
options are: 

Subnet Directed – broadcast is on the local LAN 
subnet 

Art-Net Primary (IP 2.255.255.255) 

Art-Net Secondary (IP 10.255.255.255) 

Limited Broadcast (IP 255.255.255.255) 

Network Ports (Advanced users only) 

VistaNet Sets the TCP port used for VistaNet communications. 

Show Control Sets the TCP port used for Show Control 
communications. Must not be the same port 

D1 Control Sets the TCP port used for communications with D1 
units. 

Use these settings for 
new shows 

Makes the current settings the default for all new 
shows. 

Reset to factory 
defaults 

Resets all settings on the current tab to their factory 
defaults. 

 

Ü The ports used for Vista networking can be changed but none of the three 
port numbers should be the same as any other
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3. The Console control panel 

System settings (L, T & I series only) 
There are a number of system settings that configure and determine how the 
Vista L, T and I series consoles operate. To set these preferences, choose the 
‘Control Panel’ option from the File menu. Vista displays the Settings screen. 

 

Calibrating the Pen tablet 
Sometimes you may have to re-calibrate the pen tablet or external touch screens. 
To begin calibration, choose the Calibration button from the settings window. 
Vista lists the pen tablets and touchscreens that are connected and configured. 

If you don’t see a screen, make sure that it has been configured in the ‘Display 
and Input devices’ window – see below. 

 

When you click on the button corresponding to the screen you want to calibrate 
Vista displays the calibration window on the monitor you selected: 
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Follow the on screen prompts to complete the calibration process. 

Keyboard layout 
If you are using a non-QWERTY keyboard, you can use this panel to select an 
alternate keyboard type (AZERTY etc). 

Display and Input Devices 
If you are using a S or M series control surface the display and  input device 
(mouse, pen tablet, etc) settings are controlled by the PC operating system. 

Ü Vista has been tested with Wacom pen tablet LCDs and  ELO ‘Intellitouch’ 
model 1715 monitor.  ELO make many different touch screen monitors 
including the ‘AccuTouch’ type which may not be compatible. Please check 
for compatibility before purchasing touch screen monitors for use with your 
Vista system. 
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To set the Pen tablets and Touchscreens that are connected to your L, T or I series 
console click the Display and Input Devices button. Vista displays the Display 
and Input Devices window: 

 

In this window: 

· Screen #0 is the built in Pen tablet on a L or T series console 

· Screen #1 is the monitor you have connected to monitor out 1. 

· Screen #2 is the monitor you have connected to monitor out 2. 

To configure the monitors click on the drop down arrow and select the screen 
type connected to each output. If your monitor does not appear it may not be 
supported. 

Using the screensaver 
If you are using a S or M series control surface the display, screensaver, settings 
are controlled by the PC operating system. 
To set a screensaver on a L, T or I series console click the Screen Saver button. 
Vista displays the screensaver window: 

 

This option… does this… 

On / Off Turns the screensaver on or off 

Standby Sets the how long the console must be idle before the 
screensaver starts. 
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This option… does this… 

Suspend Not required for LCD type monitors. 

Sets the how long the console must be idle before 
CRT type monitors go to suspend mode. 

Off Not required for LCD type monitors. 

Sets the how long the console must be idle before 
CRT type monitors turn off. 

 

Network preferences 
If you are using a S or M series control surface the local area network (LAN) 
settings are controlled by the PC operating system. 
To set the LAN preferences, on a L, T or I series console click the Network 
settings button on the Settings screen: 

 

This option… does this… 

Host name This field is not used but a name is automatically 
assigned. 

DHCP / Static IP Sets the console to either obtain an IP address from a 
DHCP server or use a Static IP as set below 
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This option… does this… 

IP Address Sets the IP address of the Vista console, e.g. 
192.168.0.65 

IP Netmask Sets the subnet mask for the IP address, e.g. 
255.255.255.0 

Default Gateway Sets default gateway for the console. Used when the 
destination address is outside the local subnet. 

Date and time 
Vista displays the time in the title bar of the main windows. If you are using a S 
or M series control surface the date and time settings are controlled by the PC 
operating system. 
To set the date and time, on a L, T or I series console click the date and time 
button on the Settings screen and follow the on screen prompts. 

USB disk utility 
To completely re-install the Vista software on a L, T or I series console you need a 
bootable USB thumb drive with the software install package copied onto it. The 
USB disk utility will prepare a drive and make it bootable. To do this: 

1. Choose the Control panel option from the File menu. Vista displays a system 
settings menu. 

2. Select the USB disk utility option to open the disk utility window. You 
should see a line with the name of your USB drive (i.e. SanDisk Cruzer): 

 

3. Select and highlight the USB drive. 

4. Select the ‘Prepare for Installer’ option from the file menu. Vista displays an 
alert showing the name of the drive you have selected. If this is correct click 
‘Confirm’ and the drive will be made bootable. 
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You can now connect the USB drive to your Windows or Mac computer and copy 
the Vista install files onto it. For more details on this and how to do a clean install 
on your console see Technote Tbjlt169.pdf available for download from 
jands.com/support-vista-v2/
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4. Using the interface  
The latest version of Vista features a new simpler layout. No matter whether you 
have worked with Vista before or are seeing it for the first time it’s worth taking 
some time to get familiar with the new window layout and options.  

Menu bar 
At the top of the window you’ll see the main menu bar. Click on any menu 
heading to access Vista’s dialog boxes, submenus and commands. 
The main menu bar also shows: 

· The show file name. 

· The Grand Master level setting. 

· The Autosave (disk) icon. See Autosave on page 2-13 

· The time. 

Main toolbar 
At the top of the window you’ll see the main toolbar which is common to ALL 
windows. This toolbar contains the most frequently used buttons and is divided 
into three sections. The centre section contains 12 buttons that map to the 
Function buttons on Vista consoles and the ‘F’ keys on your keyboard. They can 
be customized to suit your style of operation. 

Window navigation 
You switch between the main windows using the 6 buttons on the top left side of 
the main toolbar. You can also switch between windows by selecting the Patch, 
Console, Fixture Chooser, Timeline, Playback or Output option from the View 
menu. 

 

Ü Hovering over the icons shows the button name. 

This button… does this… 

  (Alt + 1) displays the Patch window  
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This button… does this… 

  (Alt + 2) displays the Console hardware simulation window 

  (Alt + 3) displays the Programmer Fixtures window 

  (Alt + 4) displays the Programmer Timeline view.  

  (Alt + 5) displays the Playback control window  

  (Alt + 6) displays the fixture Output window 

V1 classic style window navigation 
If you prefer to select windows from the bottom of the screen you can open a 
toolbar that emulates the earlier versions of Vista. To do this select the ‘Vista 
Toolbar’ option from the View menu.  

Vista places the toolbar at the bottom of the window: 

 

Click on the buttons to select the Patch, Console, Fixture Chooser, Timeline, 
Playback or Output window. 

The Soft buttons 
The twelve buttons in the centre of the main toolbar provide quick access to 
frequently used commands, functions and windows. 

· If you are using a L or T series console these buttons are automatically 
mapped to the function buttons, above the LCD / tablet. 

· If you are using an I or S series unit the first 6 (5 on the S3) buttons are 
automatically mapped to the function buttons in the top centre section of 
the control surface. 

· For all Vista systems you can use your keyboard F1-F12 buttons to 
activate these buttons. 

 

Ü You can display text labels, for the function buttons, at the top of your tablet 
or monitor. To do this select the ‘Softkey Toolbar’ option from the View 
menu. 
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Standard buttons 
When you first start a new show Vista loads the standard set of buttons but you 
can customize each and every button, as described below. 

This button… does this… 

 
Saves the show file to disk 

 
Opens a new Cuelist in the Editor 

 
Opens an existing Cuelist in the Editor  

 
HiLite 

Turns on the Editor’s ‘Highlight’ mode. When you are focusing 
or testing your fixtures you can use Highlight  to bring up the 
intensity of each fixture automatically when you select it in the 
Fixture Chooser.  

 
Store Part 

Displays the Store Part window where you can save the 
contents of the editor to any cue in any cuelist. Store part 
provides many options and must be used for tracking to 
operate correctly.  See Store Part on page 7-7 

 
Store All 

Displays the Store Look window where you can save the 
complete output (the look on stage). Storing this way will 
ensure that when you play a Cue back it will appear exactly as 
it did when you saved it. 

 
Clear 

Clear all information coming from the Live tab. 

If a Cuelist tab is selected this button closes that tab.  

 
Update 

Displays the Update window where information coming from 
the Editor (the Live tab or any Cuelist tab) can be used to 
update one or more Cues and Presets. 

 
Blind 

Turns the output from the editor off. In this mode you can still 
edit cues but there will be no output sent from the editor to 
your fixtures. 

 
Live 

Displays the Live time window where you can set a fade time 
that applies to  any selections you make from the editor 
palettes or presets.  

 
FX 

Displays the SmartFX window where you can create and edit 
effects. The SmartFX window is normally docked in the 
Chooser / Timeline window Sidebar. If you prefer it to be  
floating window you can drag it off the sidebar. See SmartFX  
on page 8-1 
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This button… does this… 

 
Release All 

Clicking this button releases all the fixtures from their current 
settings as determined by the cuelists that are running and 
returns them to their default state. 

Modified soft buttons 
The soft buttons provide different functions when you press the Red (Shift), 
Green (Alt), Yellow (Control) or Blue (Control+Alt) modifier. 

Shift set (Red modifier) 
Hold down the Red modifier button or the Shift button, on your keyboard, to 
access and display the Shift set. 

 
 

This button… does this… 

 
Next Fixture 

Used to step through fixtures, selects the 1st fixture (or the one 
after the current selection) and de-selects the others. Each 
subsequent press selects the next fixture. Useful when focusing 
fixtures.  

 
Previous 
Fixture 

Used to step through fixtures, selects the last fixture (or the one 
before the current selection) and de-selects the others. Each 
subsequent press selects the previous fixture. Useful when 
focusing fixtures.  

 
Invert 

Inverts the fixture selection (i.e. all selected fixtures are de-
selected and all de-selected fixtures are selected). 

 
Active 

Selects all the active fixtures (i.e. those that have Intensity). 

 
Programmed 

Select all the fixtures that are programmed in the current cue. 

 
All 

Selects every fixture. 
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This button… does this… 

 
De-select all 

De-selects all fixtures 

 
Previous 
selection 

Vista remembers the last set of fixtures you selected; you use this 
button to toggle back to your previous fixture selection. 

 
Next selection 

If you have used the previous selection command this button 
will toggle back to the fixture selection you had before pressing 
previous selection. 

 
Strike 

Ignites the lamps in the selected fixtures 

 
Douse 

Switches off the lamps in the selected fixtures off. 

 
Reset 

Resets the selected fixtures to their factory default settings. This 
is useful if a fixture has a control problem and you need to get it 
‘back to normal’.  

Alt set (Green Modifier) 
Hold down the Green modifier button or the Alt (Option) button, on your 
keyboard, to access and display the Atlt (Option) set. 

 
 

This button… does this… 

 
Open Cuelist 

Opens a new Cuelist in the Editor. 

 
New cuelist 

Opens an existing Cuelist in the Editor . 
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This button… does this… 

 
Append cue 

Adds a new cue at the end of the cuelist being edited. 

 
Insert before 

Inserts a new cue, before the cue that is being edited. 

 
Insert after 

Adds a new cue after the cue that is being edited. 

 
Not assigned 

Not assigned. 

 
Clear Fixtures 

Clears all features from the selected fixtures. 

 
Clear Intensity 

Clears Intensity from the selected fixtures. 

 
Clear Intensity  

Clears Position from the selected fixtures. 

 
Clear Colour 

Clears Colour from the selected fixtures. 

 
Clear Gobo 

Clears Gobo from the selected fixtures. 

 
Clear Beam 

Clears Beam  from the selected fixtures. 
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Ctrl set (Yellow Modifier) 
Hold down the Yellow modifier button or the Control button, on your keyboard, 
to access and display the Control set. 

 
 

This button… does this… 

Live properties Opens a Live tab properties window. 

Cuelist 
properties 

Opens the Cuelist properties window. 

Insert 
Command 

Opens the Insert Command window where you can add a 
command to the cue you are editing (i.e. to play another cue) 

Convert to 
release events 

Sets the selected events to release the feature. 

 
Merge Cues 

Merges the events in 2 or more selected cues into a single cue. 
Select the cues in the Cue navigator bar. 

Show tracked 
events 

Shows or hides tracked events in the time line. Tracked events 
are shown in a lighter, transparent colour and cannot be selected. 

Clear Fixtures Clears all features from the selected fixtures so that they return 
to their previous state. 

Home Fixtures Sends the selected fixtures to their Home settings 
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This button… does this… 

Block cue Blocking copies any tracked events into the selected cue and 
prevents any future changes, to earlier cues from tracking 
through. This means that no matter what changes are made to 
other cues in the list, the cue will play back the exact look it had 
at the time it was blocked. 

See Working in Cue only mode 

If you want to add a number of cues that do not track through to 
subsequent cues you can switch to ‘Cue only’ mode. This means 
that any settings in the cue you create are automatically undone 
in the following cue. 

To do this: 
1. Select the ‘Cue Only Editing’ option from the Tools menu. 

This command is normally assigned to F3 on the Blue 
function key set (or Ctrl + Alt + F3). 

2. When you have finished creating cues this way, deselect the 
Cue Only Editing option. 

Blocking a cue on page 7-18 

Super - Block 
cue 

When a ‘Super Block’ cue runs,  any features for the fixtures in 
the cue, that aren’t already  included in the cue are automatically 
sent to their home value. This means that the cue will look as it 
would if no other cuelist was playing. 

Un-Block cue Removes redundant events, from the selected cue. This means 
that if the selected cue includes an event that is the exactly the 
same as an event that is tracking through from a previous cue, 
that event will be removed. Unblocking will not change the cue’s 
look. 

 
Move in Black 

Opens the Move in Black window where you can Mark a cue 
and add MIB events that pre-set the selected fixtures so that 
when they turn on you don’t see them moving, changing colour 
etc. 

Ctrl + Alt set (Blue Modifier) 
Hold down the Blue modifier button or the Control & Alt  buttons, on your 
keyboard, to access and display the Control-Alt set. 

 
 

This button… does this… 
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This button… does this… 

Show selection 
order 

Shows selection order numbers on the fixture icons. 

Show Tracked 
Events 

Shows timeline events for tracked features. 

Cue Only 
Editing 

When ‘Cue-only’ editing is on all new cue events will be 
automatically undone in the next cue. 

Not used  

Not used  

Set Event 
Timing 

Opens the event timing window. 

 
Stop All FX 

Stops all running Smart Effects. 

 Stop 
Intensity FX 

Stops all running Intensity Smart Effects. 

 Stop 
Position FX 

Stops all running Position Smart Effects. 

 Stop 
Colour FX 

Stops all running Colour Smart Effects. 

 Stop 
Gobo FX 

Stops all running Gobo Smart Effects. 

 Stop 
Beam FX 

Stops all running Beam Smart Effects. 
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Configuring the soft buttons 
To change the function of a soft button, right click on the button and choose a 
command or function from the popup menu. Any command from any menu can 
be assigned to the soft button. To change one of the alternate sets hold the Shift, 
Alt or Ctrl key while right clicking. 

Soft key toolbar 
The soft buttons correspond to the hardware buttons above the main screen on L 
and T series consoles. To make it easier to identify the buttons you can add on-
screen labels below the buttons. To do this select the ‘Softkey Toolbar’ option 
from the View menu.  

Vista places the softkey labels toolbar at the top of the window: 

 

The Sidebar 
The sidebar provides access to different features, depending on the window you 
have open: 

· In the Patch window you use the sidebar to select fixtures from the 
library, and configure them. 

· In the Console window you use the sidebar to select components (i.e. 
Cuelists, Groups, Presets and more) and assign them to the Playback 
sets. You can also assign fader and button functions to the playback 
controls. 

· In the Fixture Chooser and Timeline the sidebar contains the Palettes 
(i.e. Intensity, Position, Colour, Gobo, Beam), Component panels (i.e. 
Groups, Presets, Extracts, Effects and more) and the Smart FX panel 

· There is no sidebar in the Playback Control and Output windows. 

Undocking and re-docking the sidebar tabs 
To undock any of the sidebar tabs, click on the title bar and drag it away from the 
sidebar or click the ‘undock’ icon at the end of the title bar. 

To re-dock the window double click on the title bar. 

You can adjust the width of the sidebar by clicking on the 
window divider and dragging to the left or right. 
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Toolbars 
Most windows have optional toolbars that provide buttons for sets of menu 
commands. To show or hide any of the optional toolbars select the ‘Toolbars’ 
option from the view menu.  

Patch window toolbars 
There are three toolbars available on the Patch window 

View toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 

This button… does this… 

Table view Switches the main panel of the Patch window to the standard 
Table view. 

List view Switches the main panel of the Patch window to the List view 
where the patched fixtures are shown as a list. 

DMX view Switches the main panel of the Patch window to the DMX view 
where the output of each channel of each fixtures is shown, on 
the patch table. 

Fixture Macro toolbar (also available on the Chooser & Timeline window 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 

This button… does this… 

 
Strike  Ignites the lamps in the selected fixtures.  

 
Douse Switches off the lamps in the selected fixtures off. 

 
Reset 

Resets the selected fixtures to their factory default settings. 
This is useful if a fixture has a control problem and you need 
to get it ‘back to normal’.  
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Connections toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 

This button… does this… 

Connect Open the DMX Connections window where you can connect 
your console’s DMX outputs and any external Ethernet-DMX 
interface boxes to the patch universes. 

 

Chooser & Timeline window toolbars 
There are nine toolbars available on the Editor windows 

Update toolbar 
All the buttons, on this toolbar, are available on the standard soft button set. 
However if you have re-configured the soft buttons this toolbar may be useful: 

 

This button… does this… 

 
Opens a new Cuelist in the Editor. 

 
Opens an existing Cuelist in the Editor. 

 
Store Part 

Displays the Store Part window where you can save the 
contents of the editor to any cue in any cuelist. Store part 
provides many options and must be used for tracking to 
operate correctly.  See Store Part on page 7-7 

 
Store Look 

Displays the Store Look window where you can save the 
complete output (the look on stage). Storing this way will 
ensure that when you play a Cue back it will appear exactly as 
it did when you saved it. 

 
Clear 

Clear all information coming from the Live tab. 

If a Cuelist tab is selected this button closes that tab.  

 
Update 

Displays the Update window where information coming from 
the Editor (the Live tab or any Cuelist tab) can be used to 
update one or more Cues and Presets. 
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This button… does this… 

 
Blind 

Turns the output from the editor off. In this mode you can still 
edit cues but there will be no output sent from the editor to 
your fixtures. 

 
Live 

Displays the Live time window where you can set a fade time 
that applies to  any selections you make from the editor 
palettes or presets.  

Edit  toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 

This icon… does this… 

 Ctrl X 
Cuts the selected item. 

 Ctrl C 
Copies the selected item. 

 Ctrl V 
Pastes the selected item. 

Undo toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 

This icon… does this… 

 Ctrl+Z Undo the last action. 

 Ctrl+Y Redo the last action. 
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Fixture selection toolbar 
To open or close a toolbar select the ‘Toolbars’ option from the View menu: 

 
 

This icon… does this… 

 
Previous selection 

Vista remembers the last set of fixtures you selected; 
you use this button to toggle back to your previous 
fixture selection. 

 
Next selection 

If you have used the previous selection command this 
button will toggle back to the fixture selection you had 
before pressing previous selection. 

 
Previous Fixture 

Used to step through fixtures, selects the last fixture (or 
the one before the current selection) and de-selects the 
others. Each subsequent press selects the previous 
fixture. Useful when focusing fixtures.  

 
Next Fixture 

Used to step through fixtures, selects the 1st fixture (or 
the one after the current selection) and de-selects the 
others. Each subsequent press selects the next fixture. 
Useful when focusing fixtures.  

De-select all De-selects all fixtures. 

 
Invert 

Inverts the fixture selection (i.e. all selected fixtures are 
de-selected and all de-selected fixtures are selected). 

 All 
Selects every fixture. 

 
Active 

Selects all the active fixtures (i.e. those that have 
Intensity). 

 
Programmed 

Select all the fixtures that are programmed in the 
current cue. 
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Command Line toolbar 
See Using a keypad in the programmer window on Page 6-56 

Fan toolbar 
The fan toolbar is used to set how Feature values and Event times are spread. 

 

This option… does this… 

 Linear Fan 

Diverged from centre.  

Fanned values radiate in both positive and negative 
directions from the base value, starting from the centre 
of the fixture selection. 

 Fan from end 

Linear from Start 

The fanned feature values radiate in one direction from 
the base value, starting from the first selected fixture. 

 Fan from start 

Linear from End 

The fanned feature values radiate in one direction from 
the base value, starting from the last selected fixture. 

 Fan from centre. 

Linear from Extremities 

The fanned feature values radiate in one direction from 
the base value, starting from the first and last selected 
fixtures. 

 Inverted fan 

Diverged from 
extremities 

The fanned values radiate in both positive and negative 
directions from the base value, starting from the first 
and last selected fixture. 

 Fan from both ends 

Linear from Centre 

The fanned feature values radiate in one direction from 
the base value, starting from the centre of the fixture 
selection. 

 

Ü To fan a feature or events, select the fan mode and hold the Yellow modifier 
or Control key while setting the feature value or dragging the event bars. 

Components toolbar 
The components toolbar includes buttons to create new Presets, Groups and 
Extracts 
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This option… does this… 

 Preset Opens the create New Preset window. 

 Group Opens the create New Group window. 

 Extract Opens the create New Extract window. 
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5. Patching your rig 
Once you’ve got your Vista system connected and powered up you can patch 
your fixtures the way you want them using the Patch window. 

If it’s not already open click on the Patch icon or select the ‘Patch’ option from the 
Window menu, Vista displays the Patch screen: 

 

This is where you set up all the fixtures in your rig. You tell the Vista which DMX 
channels each fixture is assigned to, and in which universe, and can set a range of 
parameters to customise how each fixture operates. 

Adding fixtures to the patch 
The Fixture Type box in the sidebar gives you a few ways to add fixtures to the 
patch. You can: 

· choose a fixture from the ‘Factory’ folder, which lists the most up to date 
fixtures in the Vista library by manufacturer and then in alphabetical 
order. 

· choose a fixture from the ‘Generic’ list, which includes files that match 
many common fixtures. 

· choose a fixture from the ‘User’ list, which includes all fixtures that you 
have created. 

· choose a fixture by first typing in the ‘Search’ box to filter the list down 
to just those fixtures that match what you’ve typed. 
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Choosing a fixture from the Factory list 
To add a fixture from the Factory list: 
1.  Click the ‘+’ symbol beside ‘Factory’ in the Fixture Type box. Vista displays 

a list of manufacturer’s folders. 

2. Click the ‘+’ symbol beside the name of the manufacturer you want, to 
display the list of fixtures in that folder. 

3. Scroll down the list until you find the fixture you want. 

Adding the fixture to the patch panel 
Once you’ve selected the fixture you want, there are two ways to add it to the 
patch panel: 

· you can drag and drop one or more fixtures onto a specific DMX 
location on the panel, or 

· you can use the Patch tab to place multiple copes of the fixture onto the 
patch panel. 

Dragging and dropping individual fixtures 
To patch fixtures this way, just click on the name of the fixture in the Fixture type 
box, type a number in the ‘Quantity’ box and drag the fixture(s) over to the spot 
on the patch panel where you want it.  

When you ‘drop’ the fixture, Vista fills the required number of DMX channels 
with that fixture’s details. This example shows 8 Vari*lite VL2500 spot fixtures 
that use 22 DMX channels each, dropped onto channel 1: 

 

Once you’ve dropped a fixture onto the patch panel you can move it around to 
any channel by clicking on it and dragging it to a new location.  

Vista represents the fixture as a solid coloured bar with an ID number before the 
name. The bar covers as many DMX channels as the fixture needs, and some 
fixtures will take up more channels than others.  

A solid colour shows that this fixture is currently selected. If you click anywhere 
else in the patch panel, Vista de-selects the fixture and makes the colour 
transparent to show that it’s no longer selected. 
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In our example above the selected fixture is called ‘2 VL2500Sp’. This title 
consists of two components: 

· a unique ID number [2], that Vista assigns automatically. This number 
identifies the fixture uniquely within the whole system, across all the 
universes (i.e. no two fixtures will ever have the same unique ID 
number). 

· a name (VL2500Sp)), which you can change if you want in the Name 
field on the Properties tab.  

Patching multiple fixtures with the Patch box 
If you prefer using the keyboard to patch your fixtures you can use the Patch tab 
in the sidebar. 

You use this feature to add multiple instances of a fixture at once. To do this: 
1. Select the fixture you want from the ‘Factory’ or ‘User’ lists in the Fixture 

Type box. 

2. In the Quantity field, enter how many of this type of fixture you want to add. 

3. If not already selected, click the Patch tab to display the Patch box: 

 

4. If you want to give the fixture a different name, type it in the Name field. 

5. If you want to assign a specific set of unique ID numbers to this group of 
fixtures, click in the Fixture Number from field and set the unique ID 
number (e.g. <44>) you want for the first fixture in the group. If you don’t set 
this, Vista assigns the next valid number. 

6. Type a number in the ‘Multi Patch’ box if you want multiple copies to be 
patched as one fixture. Use this option, for example, when patching multiple 
dimmers as a single fixture. 
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7. In the DMX Universe field, Vista automatically displays the number of the 
currently selected universe. If you want to add these fixtures to another 
universe, enter the universe number.  

8. In the DMX address field, set the number of the DMX channel where you 
want this group of fixtures to start. If you’ve already added any fixtures to 
this universe, Vista displays the next channel number in sequence. 

9. If you prefer, you can patch fixtures to an ‘absolute address’ For example 
typing 513 in the Absolute address field, automatically sets the Universe to 2 
and the DMX number to 1. If you’ve already added any fixtures to this 
universe, Vista displays the next channel number in sequence.  

10. In the Spacing field, Vista displays the number of channels each instance of 
the fixture you’ve selected will take up. If you want to leave empty channels 
between each fixture you can increase this number. For example, if a fixture 
normally uses twelve channels and you increase this number to 14, Vista 
leaves a gap of two channels between each fixture in the group. 

11. When you’ve set all the fields the way you want them, click the Patch button. 
Vista adds the group of fixtures to the patch panel.  

Ü If you’ve already added a bunch of fixtures between say, channel 10 and 
channel 50, and you add another batch starting at channel 1, Vista fits as 
many of them as it can into channels 1 to 9, then ‘flows’ the rest over to 
channel 51. 

Ü After you type in the search box you can use the ‘Down Arrow’ button on 
your keyboard to move the cursor into the list of fixtures and then tab 
through the Quantity and other fields. 

Patching with a keyboard 
You can patch dimmer channels using the Command Line Interface. To do this 
open the command line by clicking View -> Command Line. 

 

The syntax for patching  is: 
{Fixture ID(s)} @ {Universe}.{Start Address} 

Ü If you are patching in the selected Universe tab you do not need to specify 
the Universe. 
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Examples: 
· 1/10 @ 1 Enter – patches 10 dimmers in the selected universe starting at 

address 1. 

· 31/40 @ 8.10  Enter – patches 10 dimmers in universe 8 starting at 
address 10 

· 10 / 15 – 13 @ 9.101 Enter – patches  fixtures 10, 11, 12, 14, 15 in universe 
9 starting at address 101 

Hardware Keypad 
You can use the keyboard number keys or a separate keypad when the CLI 
window is showing. In addition to the number keys the following special keys 
are used while patching: 

This button… does this… 

/ (Through) Indicates a range of fixtures IDs 

- (Minus) Minus – exclude following fixture number or range 

+ (Plus) Plus – include the following fixture numbers 

* or @ (At) Precedes the patch address  

. (Period / Dot) Divides the Universe and Start Address numbers 

Changing universes 
Each universe can only handle a certain number of fixtures, depending on the 
number of DMX channels each fixture needs. To add fixtures to another universe, 
click another Universe tab at the top of the patch panel to display the next set of 
DMX channels. 

Re-arranging fixtures on the patch panel 

Moving fixtures around the patch panel 
Once you’ve added fixtures to the panel you can re-arrange them however you 
want. Just select the fixtures you want and drag them to a new channel; when 
you drop them on the screen, Vista re-arranges them all from that channel. 
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Note that you can’t place them in such a way that any of the channels will ‘fall 
off’ the end of the universe.  

Renaming fixtures 
To rename one or more fixtures select them in the universe panel and choose the 
Properties tab in the sidebar: 

 

Enter the name you want to give the selected fixtures in the ‘Name’ field and hit 
Enter. Vista renames all the fixtures you had selected. 

Renumbering fixtures 
To change the unique system-wide ID number (e.g. <12>) of a fixture (it is not 
possible to renumber more than one fixture using this method): 
1. Select the fixture in the universe panel. 

2. Choose the Properties tab in the sidebar. 

3. In the ID field, enter the new ID number and hit Enter on your keyboard. 

Renumbering multiple fixtures 
To renumber more than one fixture: 

1. Select a range of fixtures in the universe panel 

2. Right-click and select the ‘renumber’ option from the popup window. Vista 
displays the Renumer window: 
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3. Set a start number for range of fixtures. 

4. Set the increment between the new fixture numbers. 

5. Click OK to complete the renumbering. 

Deleting fixtures 
You can delete fixtures from the patch panel at any time. To do this: 

1. Select the fixture in the universe panel. 

2. Select the ‘Delete fixtures’ option from the Patch menu or right click on the 
fixture(s) you want to delete and select ‘delete’ from the popup menu. 

Customising Gobo and Colour Wheels 
If you have changed the gobos or colours in fixture’s wheels you can customise 
the fixture so that the correct images show in the chooser window.   To do this: 

1. Select the fixture(s) in the universe panel. 

2. Select the ‘Customise Gobo and Colour wheels option from ‘Properties’ tab. 
Vista opens the ‘Customise Gobos window’: 

 

 

This field… does this… 

Collection Name When you customise colours or gobos for one 
fixture, a collection is automatically created and 
you can apply it to other fixtures. 
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This field… does this… 

Colour Wheels Displays the colours in the fixture’s colour wheel. 
To change a colour click on the existing colour and 
select a new colour in the ‘Selected Slot’ section. 

Gobo Wheels Displays the gobos in the fixture’s gobo wheel(s). 
To change a gobo click on the existing gobo and 
select a new colour in the ‘Selected Slot’ section. To 
use a gobo from the existing image library navigate 
to the FixtureTypeLibrary\Images\gobos folder. 
To use a custom pattern save a 128x128px jpeg or 
png file in the 
 ..\Vista Data\FixtureTypeLibrary\Images. 

Selected Slot 
Name 

Allows a descriptive name to be added to the 
colour or gobo. 

Slot Type Sets the slot type to a colour or gobo. You can add 
colours to gobo wheels and vice versa .  

Category Allows you to group a gobo into a category. This is 
used to match similar gobos when swapping 
fixtures or copying programming to fixtures that do 
not have the same gobos. 

Select image Click this button to select a colour or gobo. 

Custom Gobo 
collections 

Allows you to select a colour or gobo collection and 
apply it to a new fixture. 

Reset to Factory 
defaults 

Resets the colour or gobo wheels in the selected 
fixture to it’s default configuration. 

 

Setting fixture properties 
Once you’ve added the fixtures to the patch panel and placed them where you 
want them, you can set a number of properties for each fixture using the 
Properties and Transforms tabs in the sidebar. 

To view and set the properties for one or more fixtures, use the pen to select the 
fixtures you want on the patch panel. Vista displays the details of those fixtures 
in the Properties and Transforms tabs: 
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Ü If you select multiple types of fixture, Vista displays the details of the first 
type you selected. If the Patch box is currently displayed, press the 
Properties tab to display the Properties box. 

Properties tab 

Name The name you entered or Vista assigned to this fixture when you 
dropped it onto to the patch panel. You can edit this here if you 
want to. 

ID The unique system-wide ID number assigned to this fixture 
when you dropped it onto the patch panel. You can change this 
number here if you want to, but note that Vista won’t allow you 
to use a number that’s already assigned to another fixture. 

Type This field displays the fixture model type and is not editable. To 
change the type of fixture without having to remove it click on 
the ‘Change Fixture Type’ button (see XSwapping a fixture typeX). 

Customise 
wheels 

Click this button to open the ‘Customise Gobo and Colour 
wheels’ window. You can change the colour and gobo wheel 
settings for the selected fixture in this window. These changes 
are saved with the show file – not to the fixture file. 

Change 
Fixture type 

Click this button to change the type of fixture without having to 
remove it from the patch. (see XSwapping a fixture typeX). 

Notes This field is used to display notes about the fixture. You can add 
whatever you like in this field. 

Transforms tab 

Preheat A percentage value that sets the voltage the fixture lamp will sit 
at until you switch it on. This is useful for lamps such as Par 64s 
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that take time to switch on from a cold start.  

Limit A percentage value that determines the maximum intensity the 
fixture will ever reach. This is useful if you want to prolong 
lamp life or prevent fixtures from ever reaching full intensity.  

Dimmer 
Curve 

This popup lets you select a dimmer fade curve. The default 
option is Linear but you can select one of the available options; 
Linear, Damp, Snap Start, Snap end,  Square Law, Inverse 
Square, Switch, Hot power, Flourescent and Sinus 

Preview in 
Chooser 

Check this box if you’d like the fixture icons, in the chooser, to 
display the effects of the Intensity transforms. 

Invert pan Selecting this checkbox reverses the sweep of the pan for this 
fixture. This is useful when you’re coordinating the sweep 
directions of fixtures hung in different directions. 

Invert tilt Selecting this checkbox reverses the sweep of the tilt for this 
fixture. This is useful when you’re coordinating the sweep 
directions of fixtures hung in different directions. 

Swap 
pan/tilt 

Selecting this checkbox swaps the pan and tilt controls, so the 
fixture will pan when given a tilt command and vice-versa. This 
is useful for coordinating the movements of fixtures hung on 
vertical trusses or pipes. 

Preview Check this box if you’d like the fixture icons, in the chooser, to 
display the effects of the Position transforms. 

Advanced transforms 
The advanced button provides access to more Fixture ‘Transformers’ that allow 
you to further customize fixtures. For example the Pan and Tilt Offset parameters 
allow you to correct the home position for fixtures that are hung at an angle. 

To add a transform click the Advanced button to open the transform window 
then click the Add button to choose a transformer. 
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Some of the transformers are also available from the Properties tab as described 
above. To choose one of the advanced transformers click on Pan offset or Tilt 
Offset. 

This option… does this… 

Minimum Sets the minimum (percentage) value for this feature. 
For example setting a value of -25 on Pan means the 
fixtures will only pan left ¾ of their normal range 

Maximum Sets the maximum (percentage) value for this 
feature. For example setting a value of -25 on Pan 
means the fixtures will only pan left ¾ of their 
normal range 

Offset Sets the offset angle. For example setting a Pan offset 
of 45 would move the fixtures Home position by 45 
degrees 

Value Curve This popup lets you select a fade curve. The default 
option is Linear but you can select one of the 
available options; Linear, Damp, Snap Start, Snap 
end,  Square Law, Inverse Square, Switch, Hot 
power, Flourescent and Sinus 

Invert Tick this box to invert the ouput value. 

Preview in Chooser Check this option to see the effect of the transform 
shown on the fixture chooser icons. 
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Channels tab 
This is a list of the features and channel numbers of the fixture and which DMX 
channel is controlling each feature. 

Macros tab 
This tab displays and allows you to edit the Strike, Douse and Reset macros for 
the selected fixture(s). 

 

The syntax is: 

[channel] @ [value] # [wait time in milliseconds] ; [next command] 

i.e. 15@249#4000;15@0#2000 

Some fixtures require more complex macros. For example a fixture might require; 
ch1 to 255, ch4 to 17,ch 6 to 1, ch 8 to 0, ch 11 to 0 and ch 15 to 84 and for these 
channels to be held for 6 seconds, and sent back to default 

In this case each command must state a wait time. For the example above the 
macro would be:  

1@255#0;4@17#0;6@17#0;8@0#0;11@0#0;15@84#6000 

That will send the specified values to all channels simultaneously and hold them 
for 6 seconds. 

Ü If you add or modify a fixture macro the new setting is automatically applied 
to all fixtures of the same type. 

Viewing the patch in different ways 
Vista gives you three different views of your patch so you can get different types 
of information about the patch. To change the view, select the table, List or DMX 
option from the View menu or click one of the three corresponding buttons in the 
toolbar. 

 

Table view 
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The Patch screen defaults to the Table view, as shown earlier in this section. This 
is the view you will use most of the time, here you can drag and drop fixtures 
into the patch panel for each universe and arrange them the way you want them. 

List view 
If you choose the List option Vista displays the fixtures as a list with columns for 
the fixture: 

 

You can choose the columns you want to show or hide by right-clicking in the 
header row and choosing the fields you want from the popup menu. You can 
also re-arrange the columns by clicking on the column name and dragging it to 
the left or right. The default column arrangement is: 

Fixture Label (as shown in the chooser window), 
ID number 
Name 
Fixture type 
Patch part – for fixtures which re patched in 2 or more parts. For example some 
fixtures have a Intensity (Dimmer) part that is patched separately  
DMX Universe 
DMX Address 

If you click on any of the column headings the list will sort by that column. Click 
again to change the sort from ascending to descending or vice versa. 

DMX view 
If you choose the DMX option Vista displays a table view where each cell shows 
the DMX channel and its output level: 
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You use this screen to display the output values of each and every DMX channel. 
Each cell displays the channel number and it’s DMX output value. The cells are 
clear if there is no output and change to a highlighted box if the output is 
adjusted. To display another output simply click on one of the other Universe 
tabs at the top of the display. 

Controlling the fixtures 
The Patch menu includes commands to control whatever fixtures are currently 
selected on the Patch panel.  There are also buttons for three of these commands:  

 

Note that only some fixture types support these functions; refer to the user guide 
for your fixture types.  

This command… does this… 

 
Strike  Ignites the lamps in the selected fixtures.  

 
Douse Switches off the lamps in the selected fixtures off. 

 
Reset 

Resets the selected fixtures to their factory default 
settings. This is useful if a fixture has a control problem 
and you need to get it ‘back to normal’.  

 Park 

Holds the fixture in it’s current settings.  

For example to provide fixed lighting for backstage.. Once 
you’ve parked a fixture it will ignore all instructions until 
it is un-parked. 

 Unpark Sets a parked fixture to operate normally. 

 

Ü These five commands are available through the Fixture menu and by right-
clicking on the fixture icons in the Programmer or Patch window. 

Cloning fixtures 
Cloning is a special way to add fixtures to your patch. This method is useful if 
you’ve already programmed your show and want to include some new fixtures 
automatically in any Cuelists, Groups and Presets that you’ve created. 

To clone one or more fixtures: 
1. Select the fixture(s) you want to clone from the Patch table or list view. 
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2. Select the ‘Clone Fixtures’ option from the Patch menu or right-click on the 
patched fixture and select Clone from the popup menu. Vista creates a clone 
of the selected fixture(s) in the fixture pool at the bottom of the Patch 
window 

3. Drag the cloned fixture(s) into the patch table. 

Ü You can change the fixture type of the cloned fixture(s) by selecting the 
‘Change Fixture Type’ option from the Patch menu. 

Exporting and importing patch information 
To save time, you can import and export patch information from comma-
separated value (.csv) files. 

Exporting the patch 
You can export a .csv file containing your  current show’s patch information. To 
do this: 

1. Select the ‘Export Patch file…’ option from the Patch menu. Vista opens the 
Export Patch window. 

2. Give the file a name. The .csv extension is automatically appended. 

3. Navigate to the directory or folder where you want to save the file. 

4. Click the Save button to confirm and the new fixtures are added to the patch. 

Importing the patch 
You can also import a .csv file containing your patch information. You can 
import a file that you have exported from another show or you can create a file in 
a text editor or spreadsheet program. The easiest way to do this is to create a 
spreadsheet laid out as follows and save it as a .csv file using the Save as 
function. 

ID Univ:Adrs Fixture Type Fixture Name 

1  3:2  Dimmer  Dimmer 

36  3:24  Dimmer  Dimmer 

41  3:75+3:34  copy_of_Scroller Dimmer  Scrl Dim 

42  3:76+3:35  copy_of_Scroller Dimmer  Scrl Dim 

101  1:1  Mac 2000 Wash (Colour Wheel) 16 bit  Mc2000Wc 

102  1:22  Mac 2000 Wash (Colour Wheel) 16 bit  Mc2000Wc 

201  2:1  ColorSpot 700E AT Mode 1  CSp700a1 

202  2:37  ColorSpot 700E AT Mode 1  CSp700a1 

301  1:221  VL2000 Spot Enhanced 16 bit  V2000Se6 
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302  1:241  VL2000 Spot Enhanced 16 bit  V2000Se6 

316  5:1  Color Block 2 Mode 3  ColBk2m3 

317  5:17  Color Block 2 Mode 3  ColBk2m3 

432  9:1  MediaMaster Layer Full 1.0  MeMaLF10 

433  9:44  MediaMaster Layer Full 1.0  MeMaLF10 

437  12:22  VL3000 Spot  VL3000Sp 

438  12:50  VL3000 Spot  VL3000Sp 
 
In this example the spreadsheet has a header row, which is optional, but shown 
here for explanation. The columns are laid out like this: 

· an ID (1), which determines the fixture’s unique ID  

· a Universe : DMX address number (1:1), that sets the Universe and DMX 
start address for this fixture 

· a Fixture Type (<VL3000 Spot>), that sets the type of fixture that will be 
patched 

· a Fixture Name (<VL3000Sp >), that sets the fixture name. 
For two-part fixtures (i.e. fixtures with an external dimmer that is patched 
separately) you need to include both parts of the patch included in the 
Universe/Address column. The format for the two parts is Control+Intensity. 

In the example above, Fixture ID 41 is a Scroller Dimmer with the scroller part 
patched to Universe 3 Channel 75 and the Intensity part patched to Universe 3 
channel 34. 

The ID, Universe:DMX Address information and Fixture Type must be in the .csv 
file. If you don’t specify a valid Vista Fixture Type, Vista prompts you to choose 
the correct fixture from a list when you import the file. The fixture Name does 
not need to match the name used in the Vista library. 
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Configuring the DMX & Ethernet Outputs 
Vista v2.3 automatically connects Universes to the DMX outputs on your console 
but not to devices connected via Ethernet. To add or change connections you 
click the Connect Universes button on the toolbar to open the DMX Connections 
screen: 

 

You use this screen to connect to Vista’s DMX outputs, to external Ethernet-DMX 
interface boxes and to broadcast Art-net and streaming ACN. 

Vista consoles provide up to four 512-channel DMX outputs. Depending on your 
dongle licence you can add more outputs by connecting your own external 
sACN, Art-Net or PathPort devices to the Ethernet port. You can also add DMX 
outputs to a console or computer using the Vista UD512 USB to DMX cable. 

To configure these connections, click the ‘Connect Universes’ button on the Patch 
screen toolbar or select the ‘Connect universes’ option from the Patch menu. 

This window shows any devices connected via Ethernet or USB to the console or 
PC and the connection details of the universe. You use it to set up the DMX 
connections for each of your universes and to check that they are working 
correctly.  

Ü You can also connect more than one output to the same Universe. For 
instance you can connect Universe 1 to DMX output 1 and to an Art-Net 
broadcast device. 
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Connecting Universes to the Console DMX & Ethernet 
Outputs 

The DMX connections window lists all the internal DMX connections, USB-DMX, 
Ethernet-DMX connection boxes and Art-Net compatible devices attached and 
visible to the Vista: 

 

In this example above you can see several entries: four are the L5 console’s 
inbuilt DMX connections; the others are the DMX outputs which are on a Vista 
D1 unit connected via Ethernet. You may also have other entries including Art-
Net, sACN, Pathport , a UD-512 and other compatible devices. 

Ü If you can’t see a device that you’ve attached to the Vista it is generally still 
possible to connect to it by using the ‘Art-Net Broadcasting’ mode or by 
using streaming ACN (sACN). 

To connect a console or control surface DMX output: 
1. Find the row that corresponds to the DMX output . 

2. Click on the box in the ‘DMX Universe’ column and either type a Universe 
number or use the up and down arrow buttons to select the Universe you 
want. 

To connect an external interface box: 
1. Find the row that corresponds to the Interface box output. Some boxes will 

have multiple outputs. 

2. Click on the box in the ‘DMX Universe’ column and either type a Universe 
number or use the up and down arrow buttons to select the Universe you 
want. 
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Disconnecting an output 
To disconnect a DMX output or interface box: 
3. Find the row that corresponds to the DMX output or interface box output. 

4. Click on the box in the ‘DMX Universe’ column and either type ‘0’ or use the 
down arrow buttons to select the ‘Not Assigned’ option. 

Ü To change the settings of an interface box you may have to disconnect it and 
re-connect it with the new settings. 

Art-Net Broadcast Mode 
Some Art-Net compatible devices may not appear in the DMX Connections 
window. In this case you can set Vista to broadcast Art-Net information without 
first establishing communication with the device. You can broadcast to up to 256 
universes. To add an Art-Net Broadcast output do this: 
1. In the ‘Connect Universes’ window click on the ‘Add Network Connection’ 

button.  Vista opens the ‘Add Broadcast port’ window: 

 

2. Enter the Sub-net and port ID then click ‘OK’ 

3. Click on the box in the ‘DMX Universe’ column and either type a DMX 
Universe number or use the up and down arrow buttons to select the 
Universe you want to associate wth the Art-Net broadcast port. 

Ü Within any Art-Net subnet, the maximum number of universes is 16. But 
you can patch more than 16 universes by using any of the 16 different 
subnets. 
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Streaming ACN 
sACN is another method used to carry DMX packets over Ethernet and operates 
in much the same way as Art-Net. To add a sACN multicast output you do this: 
1. In the ‘Connect Universes’ window click on the ‘Add Network Connection’ 

button.  Vista opens the ‘Add Broadcast port’ window: 

 

2. Enter the streaming ACN universe number and priority then click ‘OK’ 

3. Click on the box in the ‘Universe’ column and either type a DMX Universe 
number or use the up and down arrow buttons to select the Universe you 
want to associate wth the sACN port. 

Ü If sACN devices are receiving information from more than one console (or 
other controller)  they will respond to the one with the highest priority. 

Pathport xDMX 
Vista can output to Pathport Output Nodes via the Ethernet port on your console 
or computer. To connect to Pathport output nodes you do this: 
1. In the ‘Connect Universes’ window click on the ‘Add Network Connection’ 

button.  Vista opens the ‘Add Broadcast port’ window: 
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2. If it’s not already selected click on the ‘Pathport xDMX Port’ button. 

3. Use the Up and Down arrow buttons to select the ‘DMX Offset’ The xDMX 
universe will start at the next address after the offset number.  

4. Click ‘OK’ 
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6. The Chooser window 

The Chooser screen 
To get all your fixtures up and running you click the Chooser button on the 
toolbar at the top of the screen. If this is the first time you’ve opened this window 
you should be in the Live tab, otherwise click on the Live tab to make it active.  

Vista displays the Fixtures screen: 

 

This screen consists of four main elements: 
1. The Editor control section where you can select to work with the Live editor 

tab or any Cuelist you have open. If you have a Cuelist open this section 
expands to include the Cue navigation controls. 

2. The Fixture layout panel, where you can display and arrange the fixture 
icons to suit your requirements. 

3. The sidebar where you can use the palette and component panels to adjust 
Intensity, Position, Colour, Gobo, Beam and other settings for each fixture. 

4. The Quickpicker panel where you can select Presets, Groups and other 
components. This panel is optional and can be placed at the bottom or side of 
the fixture layout panel. 

Arranging fixtures in a layout 
Vista displays all of the fixtures you added on the Patch screen as icons on the 
Fixture layout panel. When you first view this screen, the fixtures are arranged in 
numerical order, by unique ID, as a bank of icons.  
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To re-arrange the fixtures: 
1. Click on the ‘Locked’ button at the bottom of the Chooser window so that it 

changes to ‘Unlocked’. 

2. Drag and drop the fixture icons around to new locations on the screen so 
that they suit you. 

3. To undo a move press Ctrl + Z or select the undo option from the Edit menu. 

4. When you are finished Click on the ‘Unlocked’ button so that it changes back 
to ‘Locked’. 

Ü If you are moving a Group icon, click and hold on it while moving to avoid 
selecting and moving the individual fixtures in the group. 

Zooming in and out 
You can adjust the magnification of the fixture layout panel or the size of 
individual fixture and group icons. 
To zoom the fixture layout panel in or out click on the magnify icons in the 
bottom left corner of the fixture chooser window: 

 
To zoom an individual fixture and group icon, hold down the yellow modifier 
button or Control key while clicking the icons. 

This icon… does this… 

 zooms in or increases the size of the fixture icons. 

 zooms out or decreases the size of the fixture icons. 

 zooms to the icons to the normal scale. 

Ü You can use the ‘Wheel’ on a suitable mouse to zoom the layout or icons. 

Using different layout views 
You can create as many different views of your fixtures as you like, each 
arranged in its own away. To create a new layout view: 
1. Right-click in the fixture chooser window and select the ‘New Layout’ option 

from the popup menu. Vista opens the New Layout window. 

2. Type a name for the layout and click OK. Vista creates a new layout and 
adds a corresponding  ‘tab’ at the bottom of the layout panel: 

 

3. Arrange the fixtures as described above. 
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4. When you are finished Click on the ‘Unlocked’ button so that it changes back 
to ‘Locked’. 

To switch between layouts click on the tab you want to use. You can select 
fixtures on one tab, switch to another tab and add more fixtures to the selection. 

Managing layout views 
You can add, rename, duplicate or modify a layout view. To do this select the 
‘Manage Layouts’ option from the Chooser menu. Vista opens the Layouts  
window: 

 
The layout window is divided into three panels: 

Layouts 
The Layouts panel shows all the layouts you have created. You can: 

· Rename a layout by double-clicking on the name and 
typing a new one. 

· Change the order of the layout tabs by selecting a layout 
and moving it up or down the list using the Move Up, 
Move Down, Move to Top and Move to Bottom buttons. 

· Add a new Layout by clicking on the Add Layout button. 

· Delete a layout by selecting it and clicking on the Delete 
Layout button. 

This icon… does this… 

<< Moves the selected layout to the top. 

<< Moves the selected layout up. 

Vista User Guide, Version 2.3 6-3 



Arranging fixtures in a layout The Chooser window 

This icon… does this… 

>> Moves the selected layout down. 

>> Moves the selected layout to the bottom. 

 + Adds a new Layout. 

 -  Deletes the selected layout. 

Layout properties 
The Layout properties panel lets you configure how a layout displays names, IDs 
and other properties. To do this: 

1. Select the Layout you want to adjust in the Layouts panel: 

This option… does this… 

Lock positions Locks the layout so the fixtures cannot be moved. You 
can also lock and unlock a layout using the 
Locked/Unlocked button beside the layout tabs in the 
Fixture Chooser window. 

Labels show  Names Sets the fixture icon text labels to show. 

Labels show IDs Sets the fixture icon ID numbers to show. 

Labels ignore zoom The label size remains fixed when the fixture icons are 
zoomed in or out. 

Notes ignore zoom The size of the notes remains fixed when the fixture 
icons are zoomed in or out. 

Auto-show new 
fixtures 

Sets the layout to automatically include any new 
fixtures added in the Patch window. 

Snap to Grid Locks or Unlocks the current layout. Fixture and 
Group icons can not be moved when a layout is 
locked. But they can be scaled. 

Show Gridlines Display a grid on the Fixture Chooser layout pane. 

Grid Spacing Sets the space between the grid lines. The higher the 
number, the larger the grid spacing. 

Save as Default Saves all options set in the current layout as the 
default for any new layout. 

Ü You can also adjust some of these settings on the ‘Layouts options’ menu. 
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Hiding and ‘un-hiding’ fixtures and groups 
You can use the Item Visibility panel to hide any fixtures, fixture types or groups 
in a layout. This removes them from the display, but not from the patch.  

To hide Fixture or Group icons or Notes: 
1. Select the Layout you want to work with from the list in the Layouts panel. 

2. Click the + symbol beside the Fixtures or Groups or Notes heading in the 
Item Visibility section to show all the Fixtures types that you’ve patched, the 
Groups that have been created and any Notes. 

3. To hide all Fixture icons of a type, un-tick the checkbox beside that fixture 
type, or click the + symbol beside a fixture type to show all the individual 
Fixtures of that type. 

4. To hide all Groups, un-tick the checkbox beside ‘Groups’, or click the + 
symbol to show all the Groups that have been created. 

5. To hide all Notes, un-tick the checkbox beside ‘Notes’, or click the + symbol 
to show all the Notes that have been created. 

6. To hide individual Fixtures, Groups or Notes of a type un-tick the checkbox 
beside the items(s) you want to hide. 

To reveal (unhide) hidden fixtures, tick the checkbox beside the items you want 
to reveal. 

Ü You can also hide fixture  and group icons and  notes by right-clicking on the 
icon(s) or note(s) and selecting Hide from the popup menu. 

Layout options 
The Layout options submenu lets you quickly configure some commonly used 
layout properties. To do this: 

1. Select the Layout you want to adjust by clicking on its tab at the bottom of 
the Fixture Chooser panel. 

2. Select ‘Layout options’ from the Chooser menu. Vista displays the submenu: 

This option… does this… 

False Intensity Gives the fixture icon intensity without sending any 
level to the fixture(s) 

Show selection order Sets the icons to show a selection order number 
whenever they are selected. 

Show grid Display a grid on the layout pane. 
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This option… does this… 

Snap to grid When on, fixture icons snap to the grid cells. 

Show names Sets the fixture icon text labels to show. 

Show IDs Sets the fixture icon ID numbers to show. 

Auto-add new 
fixtures 

Sets the layout to automatically include any new 
fixtures added in the Patch window. 

Preview refresh rate Sets the refresh rate for the icons. Higher refresh rates 
and / or large numbers of icons use more processing 
power. 

Detail Level Set the amount of detail shown as  the chooser 
window is zoomed out. High can be more demanding 
on the system, but provides the most detailed view. 

Activating layout views 
To activate a layout view, click on the tab for the layout you want to display: 

 

Duplicating a layout 
To duplicate a layout view, click on the tab for the layout you want to duplicate 
then select the Duplicate Layout option from the Chooser menu. Vista displays 
the Duplicate Layout window. 
Type a name for the layout and click OK. Vista creates a copy layout and adds a 
corresponding  ‘tab’ at the bottom of the layout panel. 

Layout organisation 
There are a number of ways to customise layouts and the way the fixture icons 
are displayed. To make a change select an option from the Chooser menu. 

This option… does this… 

Colours and 
Background 

Opens a submenu. 

- Background colour Opens a colour picker to set the background colour of 
the layout panel. 

- Background image Opens a window to select an image to use as a 
background of the layout panel. An image size of 
about 700 x 560px will fill the layout pane. 
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This option… does this… 

- Erase Background 
image 

Removes the background image, if you’ve added one. 

- Resize Background Selects the background image which can be moved or 
resized by dragging on the bottom right hand corner. 
Click outside the background when finished. 

- Icon Colour Opens a window to set the outline colour of the 
selected icon(s). 

- Gel Colour Opens a window to set the intensity colour of the 
selected icon(s). Useful for simulating the colour filter 
on a conventional fixture. 

- Set note colour Opens a window to set the colour of the selected 
note(s). Changes the leader and fill colour. 

Shrink to fit Zooms the layout panel to fit all fixtures.  

Label position Moves the icon label to the right, left, top or bottom of 
the icon. 

Manage Layouts Opens the Manage Layouts window. 

Duplicate Layout Creates a copy of the current layout and opens a 
window where it can be named. 

Layouts options Opens the Layouts options window. 

Layout organisation popup menu 

Ü You can also adjust the layout and icon appearance  by right-clicking on the 
layout or icon(s) or note(s) and selecting an option from the popup menu. 

This option… does this… 

Manage Layouts Opens the Layouts window where you can add, 
delete, organise and customise your layouts. 

New Layout Opens the New layout window. 

Duplicate Layout Duplicates the current layout and opens a window to 
name it. 

Delete Layout Immediately deletes the current layout. 

Rename Layout Opens the Rename Layout window where you can 
edit the name of the current layout. 
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This option… does this… 

Rename Opens the Rename window where you can type a new 
name for the selected fixture(s). 

Renumber Opens the Renumber window where you can type a 
new name for the selected fixture(s). 

Delete item Deletes the selected item immediately. 

Hide items Hides the selected fixture or group icon or note. 

Unhide all items Reveals all hidden items, on the current layout. 

Resize items(s) Allows you to resize the selected matrix. 

Rotate items Lets you rotate the fixture icon(s), using an onscreen 
handle, to any angle. 

Icon Colour Opens a window to set the outline colour of the 
selected icon(s). 

Gel Colour Opens a window to set the intensity colour of the 
selected icon(s). Useful for simulating the colour filter 
on a conventional fixture. 

Label Position Moves the icon label to the right, left, top or bottom of 
the icon. 

New Fixture Group Creates a new fixture group containing all the 
currently selected fixtures. 

Update Fixture 
Group 

Updates the current group to contain whatever 
fixtures are selected. 

Create Matrix Creates a new matrix grid that you can resize by 
dragging on the bottom right hand corner. 

Tip: Deselect all fixtures to enable this option. 

Resize Matrix Allow you to resize the selected matrix. 

Add note Adds a text box to the layout panel. If a fixture icon is 
selected a leader line will be drawn between the icon 
and the text box. 

Set note colour Opens a window to set the colour of the selected 
note(s). Changes the leader and fill colour. 

Delete Matrix Deletes the selected Matrix 
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This option… does this… 

Align Lets you align a group of fixture icons  to the right, 
left, top or bottom of the group. 

Distribute Lets you distribute a group of fixture icons vertically 
between the top and bottom fixtures or horizontally 
between the furthest left and furthest right fixture in 
the selection. 

Flip Swaps the vertical or horizontal position of a group of 
fixture icons. The left most fixture will move the right 
most and so on. 

Arrange in Grid Opens the Grid window to arrange the selected items 
in a grid. Items can be arranged into rows and 
columns and sorted by ID or selection order. 

Background Colour Opens a colour picker to set the background colour of 
the layout panel. 

Background Image Opens a window to select an image to use as a 
background of the layout panel. An image size of 
about 700 x 560px will fill the layout pane. 

Erase Background 
Image 

Removes the background image, if you’ve added one. 

Resize Background Selects the background image which can be moved or 
resized by dragging on the bottom right hand corner. 
Click outside the background when finished. 

Adding notes to the layout window 
You can add text boxes to the fixture window to help identify different fixture 
types or areas. Notes can be either attached to an object on the layout, such as a 
fixture, or can be independent.  
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To add a note you do this: 
1. To attach a note to a fixture or group, first select the item. For an 

independent note make sure no fixtures or groups are selected. 

2. Right-click in the fixture window and select ‘Add Note’ from the popup 
menu. Vista creates a note on the layout. 

3. Type a note and then click on the layout background to finish. 

To move a note, first unlock the layout then click on the text and drag it to a new 
location. To edit a note double click on the text and replace or change the text. To 
delete a note select it then press the delete key. 

Arranging fixtures in a grid 
You can arrange fixtures in rows and columns. To do this: 
1. Select the fixtures you want to arrange into a grid. 

2. Right-click in the fixture window and select ‘Arrange in grid…’ from the 
popup menu. Vista opens the Arrange in Grid window: 

 

This option… does this… 

Rows Specify the number of rows you want in the grid. If you 
enter a value here the number of columns is calculated 
automatically. 

Columns Specify the number of columns you want in the grid. If 
you enter a value here the number of rows is calculated 
automatically. 

User ID Sort the fixtures by ID number. 

Type / User ID Sort the fixtures by type, name then ID number. 

Selection Order Sort the fixtures into the order they have been selected. 
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3. Click the OK button to arrange the fixtures. 

Placing fixtures in a Matrix 
You can put fixtures in a special ‘Matrix’ container so that they can be controlled 
individually or as a whole. When fixtures are placed on a matrix you can: 

· Select the matrix and apply settings to all fixtures within it. 

· Select fixtures, in the matrix and apply individual settings to just the 
ones you have selected. 

· Apply matrix effects that run on the X and Y axis of the matrix. For 
example you can have an intensity effect that runs across the matrix like 
a sliding door or a colour effect that runs around the matrix like a clock 
hand. 

· Apply an animated gif Video effect. 

To create a matrix container and place fixtures in it: 
1. Right-click on the fixture layout panel and select the Matrix, then Create 

Matrix option from the popup menu. Vista creates a matrix container on the 
current layout: 

  

2. Adjust the size of the matrix by clicking on the handle on the bottom right 
hand corner and dragging to the size you want. 

3. Drag your fixtures into the matrix. You can either drag them one by one or as 
a group. If you drag a group of fixtures onto the matrix Vista places them 
across and then down the matrix in ID order. 
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Selecting fixtures 
The simplest way to select fixtures is to click on the fixture or group icons one by 
one but Vista provides three selection tools and several options to make more 
complex selections. 

Selection tools 
To select a number of fixtures you can draw a ‘marquee’ around (or over) the 
fixtures you want. Vista provides three marquee tools. 

To select the tool you want, click on one of the icons in the lower right corner of 
the fixture layout panel or choose one of the ‘Selection tool’ options from the 
Layouts menu: 

 

This icon… does this… 

 Draws a rectangular marquee as you click and drag 
across a group of fixtures. 

 Lets you select fixtures by drawing a freehand shape 
around the ones you want. 

 Lets you select fixtures by drawing a line through the 
ones you want. 

Sorting fixtures 
It’s often important to sort fixtures in a certain order. For example when you are 
storing groups, applying effects, fanning parameters or copying and pasting 
information from one set of fixtures to another. 

Vista lets you show the selection order and quickly sort fixtures based on their 
ID, selection order, layout position and more. 
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Displaying the selection order. 
To display the selection order, choose the ‘Show selection order’ option from the 
Options sub-menu on the Layout menu.  

Vista displays the selection order number in a small circle on the top left side of 
the fixture icon: 

 

Sorting fixtures 
You can sort fixtures in a number of ways. To do this, select the fixtures then 
click the Sort order dropdown on the main toolbar. Vista displays the Sort popup 
window: 

 

This option… sorts the fixtures in… 

Custom Sort an order you create in the Custom sort window. Custom sort 
includes several advanced options as described below. 

Selection the order in which you selected them on the Fixtures chooser 
layout. 

ID ID number order. 

Random random order. Each time you de-select and re-select fixtures 
they are sorted into another random order. 

Position by columns and rows, from top left to bottom right, based on 
their position in the layout window. 
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Manage Sorts This option opens the Manage Sorts window where you can 
customise and save sorts. 

Creating custom sort orders 
When you select the ‘Custom Sort’ option Vista displays the Custom Sort 
window: 

 

You can use this window to create a new sort that includes advanced options for 
grouping fixtures together, repeating applied settings and setting the type of fan 
shape that will be used when fanning a value across the selected fixtures. 

This option… does this… 

Sort Fixtures 
by.. 

Sets the basic sort type. The options are as described above – 
ID, Selection Random or Position. 

Fan Shape Lets you store a fan shape that will be recalled when a saved 
sort order is selected. See ‘Fan shapes’ on page 6-16. 

Curve Sets the distribution of fixtures, along the fan shape. The 
normal setting is ‘Linear’ and in this case the fixtures are 
evenly distributed. Other curves, such as square and inverse 
square will bunch some of the fixtures together and spread 
others out. 

Sort Direction Sets the sort order to ascending or descending. 
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Fixture 
Ganging 

Allows fixtures to be grouped together, so that if you spread 
or fan a feature setting across some fixtures, the settings can 
be in blocks and / or repeated throughout the selection. See 
the examples below. 

Blocking Lets you group fixtures in  "blocks" of consecutive fixtures. 
You can set just one block size, for example 2 or set several 
different block sizes (e.g. first block has 4 fixtures, second 
block has 6 fixtures and so on). 

To set complex blocking separate the block sizes with a / 
(forward slash). For example 4/6 creates a group of 4 fixtures 
and then a group of 6 fixtures. 

You can use more than one slash. Enter 2/4/5/3 to create a 
grouping of two fixtures, then four, then five, then three, 
repeated until all fixtures are used. 

Repeat 
Ganging 

Lets you repeat feature settings on every 2nd, 3rd,  4th or any 
increment of fixtures. To set complex repeats separate the 
increments with a / (forward slash).  

Save as… Opens the Custom Sort ‘Save as’ window where you can 
name and save your custom sort. 

Selecting Odd and Even numbered fixtures 
You can select just the odd or even numbered fixtures from the fixtures you have 
selected  by setting “Sort fixtures by” to ID and  "repeat ganging" to 2 in the sort 
dialogue. Then, using the next and previous fixture buttons, you can toggle 
between controlling the odd and even fixtures.  

Custom Ganging examples 
In these examples, there are 10 colour mixing fixtures selected and colour is 
fanned across the fixtures using a Custom sort with the following Ganging 
(Blocking and Repeat) settings: 
1. Blocking set to 3, Repeats set to ‘0’ (No repeats) 

  

2. Blocking set to 3, Repeats set to ‘2’ 
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3. Blocking set to 1/2/3, Repeats set to ‘0’ (No repeats) 

  

4. Blocking set to 2/3, Repeats set to 2. 

  

Custom Fan shapes 
In these examples, there are 10 fixtures selected and intensity is fanned across the 
fixtures using the following Fan shapes: 
1. Fan from Centre: 

  

2. Fan from both ends: 

  

Fan shapes 
The are several fan shapes that can be set and saved in a Custom sort. 

This option… does this… 

 Linear Fan 

Diverged from centre.  

Fanned values radiate in both positive and negative 
directions from the base value, starting from the 
centre of the fixture selection. 

 Fan from end 

Linear from Start 

The fanned feature values radiate in one direction 
from the base value, starting from the first selected 
fixture. 

 Fan from start 

Linear from End 

The fanned feature values radiate in one direction 
from the base value, starting from the last selected 
fixture. 

 Fan from centre. 

Linear from Extremities 

The fanned feature values radiate in one direction 
from the base value, starting from the first and last 
selected fixtures. 
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This option… does this… 

 Inverted fan 

Diverged from 
extremities 

The fanned values radiate in both positive and 
negative directions from the base value, starting 
from the first and last selected fixture. 

 Fan from both ends 

Linear from Centre 

The fanned feature values radiate in one direction 
from the base value, starting from the centre of the 
fixture selection. 

 

Ü To fan a feature or events, select the fan mode and hold the Yellow modifier 
or Control key while setting the feature value or dragging the event bars. 

Ü The Vista V1 "Mirror" option is replaced by the ‘Fan from Centre’ and 
‘Inverted Fan’ shapes. 

Managing your saved Sorts 
You can rename, duplicate or modify a saved sort. To do this select the ‘Manage 
Sorts’ option from the Sort order drop down list. Vista opens the Manage Sorts 
window: 

 

To modify one of the built in sorts or a custom sort you’ve saved, do this: 
1. Select the Sort name in the left hand panel. 

2. Modify the Fixture sort, Fan options and other settings. 

3. Click the ‘Save’ button. 
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Renaming a Sort 
You can rename a sort by double clicking on the name, in the left column, and 
typing a new name. 

Duplicating a Sort 
To make a copy of a sort, select it and click on the ‘Duplicate’ button. 

Deleting a Sort 
To delete a sort, select it and click on the ‘Delete’ button.  

Using the Programmer Sidebar 
The Programmer Sidebar has three tabs: 

 

The Palette tab includes panels to control all the main aspects of your  lighting 
fixtures: intensity, position, colour gobo and beam. 

The SmartFX tab includes panels to create and edit effects. 

The Components tab includes the items you store such as Groups, Presets, 
Extracts and Snapshots along with the in-built effects. 

The Palette tab 
If it’s not already selected, click on the Palette tab in the sidebar 

Summary or detailed view 
You switch between the ‘All’ (or summary) view and the detailed views of the 
different control panels using the 7 buttons below the Palette tab. 

 

This button… does this… 

All displays a combined view of the most commonly used 
controls for Intensity, Position, Colour, Gobo and Beam. 

 
displays a detailed view of the Intensity controls. 

 
displays a detailed view of the Position controls. 

 
displays a detailed view of the Colour controls. 
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This button… does this… 

 
displays a detailed view of the Gobo controls. 

 
displays a detailed view of the Beam controls. 

Custom displays controls for every feature of the selected fixture(s). 
These controls are mainly used to control features that do 
not appear on the other panels or to set chanels to values 
that are normally not used. 

Common features of the palettes 
All palettes have a popup menu that you open by clicking the palette type 
button: 

  

Click on the drop down arrow  on any of the palette type button to open a 
popup menu 

This option… does this… 

Clear This option lets you clear all events for that parameter 
type or just some of those events. For example the 
Colour popup lets you clear the Colour wheel or Colour 
Mix or just the individual CMY events. 

 
Home 

This option lets you reset all events for that parameter 
type to their default or a user defined setting. For 
example no intensity, 50% pan and tilt, colour white etc. 

 
Create Preset 

This option opens the Preset window so you can create 
a new preset.  

  
New Effect 

Clicking on this option opens the Create effect window 
where you can select an effect type, the features to 
include and enter a name for the effect. 

 

Stop effect 

This option lets you stop effects that are running for that 
parameter type  

 

Many of the palettes have slider bars that provide a quick and easy way to set a 
value: 
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To adjust a slider setting, either: 

· click the arrows at the left or right hand end to go to 0% and 100% 
respectively; 

· click and drag in the slider bar to set the value you want; 

· click in the value box and type a value using the keyboard. 

To set attributes for one or more fixtures, select the fixtures you want in the 
Fixture Chooser panel, then click on the Palette you want to use. 

Checking that everything is working 
One of the first things you’ll probably want to do after setting up your rig and 
patching it all in on the Patch screen, is check that everything’s working. The 
quickest way to do this is to select the fixtures, one-by-one or in groups on the 
Fixture panel, and crank the intensity and colour up a bit.  

To do this: 
1. Select the ‘All’ view of the palettes. 

2. Select one or more fixtures in the Fixture panel.  

3. Click the right-arrow icon at the end of the Intensity slider on the intensity 
palette. 

4. Click anywhere in the colour palette. 

5. The selected fixtures show that colour at full intensity. 

Ü You can also use the encoder wheels to set Intensity, Position, Colour and 
any other parameter. 

Ü If you can’t see any output from your fixtures check that the Grand Master is 
turned fully clockwise and that the faders on the Superplayback panel are 
up. 

Highlight and Lowlight 
When you are focusing or testing your fixtures you can use Highlight feature to 
bring up the intensity of each fixture automatically when you select it. 

To do this, either: 

· Click the  Highlight button – normally softbutton #4 (F4 on your 
keyboard or, 

· Select the Highlight option from the Tools menu (Ctrl+H). 

You can alter how highlight works by updating the highlight and lowlight 
presets. See The Highlight and Lowlight presets on page 6-50. 
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Ü When Highlight is on you can use the Next and Previous buttons, located 
above the 3 encoder wheels, to step between the selected fixtures. Press both 
buttons together to reselect all fixtures. 

 

Using the All panel 
The All panel has controls for all the most commonly used features of your 
fixtures. It provides a quick easy way to set Intensity, Position, Colour, Gobo and 
Beam without swapping panels. The same controls plus any advanced ones are 
available on the individual feature panels. See Using the detailed panels on page 6-26 

Intensity  
In this view the Intensity panel shows the most used intensity features : 

 

In this view: 

· the 10 to 90 buttons sets the intensity of the selected fixtures to the 
corresponding percentage value. 

· the Intensity slider controls the intensity of the selected fixtures in a 
percentile range. 

You’ll notice that as you change the intensity settings, the icons on the Fixture 
panel change to reflect this. 

Position 
The Position panel gives you control of the direction in which the selected 
fixtures are aimed: 

 

To adjust the position, click on the round target symbol and drag it to the spot 
you want . 
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You’ll notice that as you change the position ‘compass’ the icons on the Fixture 
panel change to reflect this. 

Fine Mode 
Some parameters, such as position, can be difficult to control when the palette is 
in normal mode. To switch to fine click on the ‘Fine’ button. Repeat this to turn 
fine mode off. 

Setting colour 
The Colour palette provides four buttons so you can choose the way you want to 
set your colours: 

 
· HSV – hue and saturation values, 

· Sliders – Cyan, Magenta, Yellow or Red, Green, Blue or Hue, Saturation 
Value sliders, 

· Swatch – colours by Lee name and number, 

· Colour wheel – for fixtures that have colour wheels. 

Hue and Saturation values 
The HSV tab provides a colour spectrum and a value slider: 

 

To pick a hue and its value, just click on the shade you want in the spectrum 
area, and drag the slider bar below the colour panel  to set the value level. 

Cyan, Magenta and Yellow/Red, Green Blue 
This tab gives you the option of setting your colour using either CMY or RGB or 
HSV values: 
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Click the relevant ‘slider mode’ button to choose the method you want, then 
adjust the sliders to set the colour. 

Swatch 
This tab provides the actual gel colours, numbers and names from the Lee 
swatchbook so you can pick the exact colour you want: 

 

Click in the Colour, Number (#) or Name (N) button to sort the list by name 
number or colour. You can also search for a name or number by typing in the 
search box. 

Colour wheel 
When using fixtures with colour wheels, you can use this tab to select the colour 
slot (or position) you want this fixture to use: 

 

Fixtures that have more than one colour wheel will show a line of available 
colours for each wheel.  The colours are displayed in the same order as they are 
on the wheel. Just click on the colour swatch to select it. 

You can move the colour wheel by small increments, to create slit colours, by 
clicking on the Index button and adjusting the slider to rotate the wheel forwards 
or backwards. 

You can also rotate or spin the by clicking on the Rotate button and slider to spin 
the wheel forwards or backwards: 

If the colour wheel is spinning you can reverse the spin direction by clicking on 

the  Reverse icon or stop it by clicking on the  Stop icon. 
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Setting gobo 
The Gobo summary panel displays icons of the gobos available on the selected 
fixtures: 

 

If you have only one type of fixture selected, the icons Vista displays represent all 
the gobo types of that fixture. Fixtures that have more than one gobo wheel will 
show a line of available gobos for each wheel.  The gobos are displayed in the 
same order as they are on the wheel. You can select a gobo from one wheel and 
leave the other set to open or a gobo from each wheel to combine the patterns. 

To choose a gobo, click on the icon representing the gobo shape you want.  If you 
have more than one type of fixture selected there will be a tab for each type. 
Clicking on a tab will display the gobos available for that fixture type. 

Rotation 
You can move the gobo wheel by small increments, to create split patterns, by 
clicking on the Wheel and Index buttons and adjusting the slider to rotate the 
wheel forwards or backwards. 

You can also rotate or spin the Gobo wheel by clicking on the Wheel and Rotate 
buttons and adjusting the slider to spin the wheel forwards or backwards. If the 

gobo wheel is spinning you can reverse the spin direction by clicking on the  

Reverse icon or stop it by clicking on the  Stop icon. 

On some fixtures you can rotate the individual gobos. For these fixtures: 

· You can move the selected gobo by small increments, to align the image, 
by clicking on the Gobo and Index buttons and adjusting the slider to 
rotate the gobo clockwise or anti-clockwise. 

· You can also spin the selected gobo by clicking on the Gobo and Rotate 
buttons and adjusting the slider to spin the gobo clockwise or anti-
clockwise. 

· If the gobo slot is spinning you can reverse the spin direction by clicking 

on clicking on the  Reverse icon or stop it by clicking on the  Stop 
icon. 
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Setting beam size and focus 
The summary Beam  panel has two tabs for controlling the most used beam 
attributes: 

Focus 
The Focus tab controls the focus and zoom of the selected fixtures: 

 

Use the focus slider to soften or sharpen the beam shape. Use the Zoom slider to 
make the beam spread softer or sharper. 

Iris 
The Iris tab controls the beam size (or diameter) of the selected fixtures, if they 
have an iris. 
Use the iris slider to make the beam size. Use the Zoom slider to make the beam 
size smaller or larger. 
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Using the detailed panels 

Intensity  
Click on the Intensity button to select the detailed settings panel for all fixture 
channels in the Intensity group: 

 

In this view: 

· the 10 to 90 buttons set the intensity 
of the selected fixtures to the 
corresponding percentage value. 

· the end most percentage buttons set 
the level to 0% or 100% while the 
others increase or decrease it in 5% 
or 10% increments. 

· the Intensity slider controls the 
intensity of the selected fixtures in a 
percentile range. 

· if the selected fixtures have a strobe 
capability, the Strobe slider controls 
the speed of the strobe. 

· if the selected fixtures have blackout 
shutters, the Opened and Closed 
buttons set the shutter position. 

 

Custom values 
Some fixtures have effects and other special features that can be used by setting a 
channel to a particular value. These features vary from fixture to fixture so they 
aren’t included in Vista’s ‘generic’ controls. 

See About Custom values on page 6-35 for more details on using the custom control 
panels. 
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Position 
The detailed Position panel provides a larger version of the position target panel. 

You’ll notice that on this panel you can also adjust just the pan or just the tilt by 
using the Pan and Tilt sliders located on the bottom and left side of the target 
panel. 

 

Fine mode 
Position, can be difficult to control when 
the palette is in normal mode. To switch 
to fine mode click the ‘Fine button’. 

Flip 
Click this button to rotate and invert the 
fixture(s) so that it is pointing at the same 
position. 

Custom values 
Some fixtures have effects and other 
special features that can be used by 
setting a channel to a particular value. 
These features vary from fixture to 
fixture so they aren’t included in Vista’s 
‘generic’ controls. 

See About Custom values on page 6-35 for 
more details on using the custom control 
panels. 

 

 

Colour 
The detailed Colour palette lets you choose how to control the colour mixing 
mechanism and the colour wheel(s) in your fixtures: 
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The buttons, in the middle of the colour panel select the colour mechanism. There 
are three options. 

· HSV – hue and saturation values. 

· Lee – Lee colour swatch. 

· Wheel – pick a colour from the fixture’s colour wheel 

If a fixture only has a colour mixing mechanism (CMY / RGB) you can choose a 
colour from the HSV or Lee swatch section and  it will be applied to the mixer 
mechanism. The colour wheel section will not be available. 

If a fixture has a colour mixing mechanism (CMY / RGB) and a Colour wheel 
you can choose a colour from the HSV or Lee swatch section and it will be 
applied to the mixer mechanism. You can also choose a colour from the Wheel 
section of the colour panel it will be applied to the colour wheel. This means you 
can set different colours for the mix mechanism and the wheel. 

If a fixture only has a Colour wheel(s) you can choose a colour from the HSV, Lee 
or Wheel section of the colour panel it will be applied to the colour wheel. If you 
choose colours from the HSV or Lee section the nearest colour on the wheel is 
selected.  
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Hue and Saturation values 
When you select the HSV colour option the colour panel provides a colour picker 
panel and a set of sliders: 

 

To pick a hue and its saturation, just click 
on the shade you want in the spectrum 
area, and drag around to select a colour 
and set the saturation level. 

You can also adjust the colour using the 
three sliders. Click the HSV, CMY or 
RGB ‘slider mode’ button to choose the 
method you want, then adjust the sliders 
to set the colour. 
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Lee Swatch 
This option provides a list of Lee filters so you can pick a colour by it’s name, 
number or swatch. 

 

Click in the Colour, Number (#) or 
Name (N) button to sort the list by 
name number or colour swatch. You 
can also search for a name or number 
by typing in the search box. 

 

 

Wheel 
When using fixtures with a colour wheel(s), this option provides a graphic 
representation of the colour wheel so you can see exactly what colours are 
available and where they are on the wheel. 

 

If a fixture has more than one colour 
wheel the buttons above the colour 
wheel will be available. To choose the 
colour wheel you want to work with 
click on the corresponding button. 

You can move the colour wheel by 
small increments, to create split 
colours, by clicking on the Index 
button and adjusting the slider to turn 
the wheel forwards or backwards. 

You can also rotate or spin the colour 
wheel by clicking on the Rotate 
buttons and adjusting the slider to 
spin the wheel forwards or 
backwards. 

If the colour wheel is spinning you 
can reverse the spin direction by 
clicking on the Reverse icon or stop it 
by clicking on the Stop icon.  

If you have more than one type of 
fixture selected, Vista displays a tab 
for each fixture type at the top of the 
panel. To choose the fixture type you 
want to work with click on the 
corresponding tab. 
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Custom values 
Some fixtures have effects and other special features that can be used by setting a 
channel to a particular value. These features vary from fixture to fixture so they 
aren’t included in Vista’s ‘generic’ controls. 

See About Custom values on page 6-35 for more details on using the custom control 
panels. 

Gobo 
The detailed Gobo panel provides a graphic representation of the gobo wheel so 
you can see exactly what patterns are available and where they are on the wheel. 

 

If a fixture has more than one gobo wheel 
the buttons above the gobo wheel will be 
available. To choose the wheel you want to 
work with click on the corresponding 
button. 

Rotation 

You can move the gobo wheel by small 
increments, to create split patterns, by 
clicking on the Wheel and Index button and 
adjusting the slider to turn the wheel 
forwards or backwards. 

You can also rotate or spin the wheel by 
clicking on the Wheel and Rotate buttons 
and adjusting the slider to spin the wheel 
forwards or backwards. If the colour wheel 
is spinning you can reverse the spin 
direction by clicking on the Reverse icon or 
stop it by clicking on the Home icon. 
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On some fixtures you can rotate the individual gobos. For these fixtures: 

· You can move the selected gobo by small increments, to align the image, 
by clicking on the Gobo and Index buttons and adjusting the slider to 
rotate the gobo clockwise or anti-clockwise. 

· You can also spin the selected gobo by clicking on the Gobo and Rotate 
buttons and adjusting the slider to spin the gobo clockwise or anti-
clockwise. 

· If the gobo slot is spinning you can reverse the spin direction by clicking 
on the Reverse icon or stop it by clicking on the Stop icon. 

If you have more than one type of fixture selected, Vista displays a tab for each 
fixture type at the top of the panel. To choose the fixture type you want to work 
with click on the corresponding tab. 

Custom DMX 
Some fixtures have effects and other special features that can be used by setting a 
channel to a particular value. These features vary from fixture to fixture so they 
aren’t included in Vista’s ‘generic’ controls. 
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Beam 
The detailed Beam panel provides sliders for all the beam features and a graphic 
representation of frame (shaping shutters) , if the fixtures have this feature: 

 

Focus 
Use the focus slider to soften or 
sharpen the beam shape.  

Zoom 
Use the Zoom slider to make the beam 
angle narrower or wider. 

Iris 
The Iris tab controls the beam size (or 
diameter) of the selected fixtures. 
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Framing 
The Frame tab is specifically for fixtures that have beam shaping frames, so you 
can shutter-off parts of the beam. 

 

To set the positions you want the 
frames to be in on the selected 
fixtures, click and drag each frame to 
the position you want, as shown in 
this example: 
You can also set the rotation angle of 
the shape or continuously rotate the 
whole shape using the slider: 

· Index – to turn the framing 
shutters to the preferred angle 
click the Index button and move 
the slider to set the position. 

· Rotate – to continuously rotate 
the whole shutter assembly click 
the Rotate button and move the 
slider to set the speed and 
direction. 

Custom values 
Some fixtures have effects and other 
special features that can be used by 
setting a channel to a particular value. 
These features vary from fixture to 
fixture so they aren’t included in 
Vista’s ‘generic’ controls. 

See About Custom values on page 6-35 
for more details on using the custom 
control panels. 

 

Custom 
The detailed Custom panel provides a separate mini setting panel for every 
channel of the selected fixture. The mini panels are arranged in sections 
according to their feature type – Intensity, Position, Colour, Gobo, Beam and 
Miscellaneous. The ‘Misc’ section contains all the mini control panels for all 
channels that don’t belong in the IPCGB feature groups. 

Click on any of the Feature type headings to open that section. 
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About Custom values 
Some fixtures have effects and other special features that can only be used by 
setting a channel to a particular value. These features vary from fixture to fixture 
so they aren’t included in Vista’s ‘generic’ controls. 

For example some fixtures have special settings for the Strobe channel that 
provide a random strobe effect. Moving the Vista strobe slider to the left or right 
will never set the effect running because the slider only operates in the (generic) 
range that sets the strobe to fast or slow. 

To access the special channel features you use the small Custom control panels. 

Custom panels 
The small custom panels are divided into 3 sections: 

 

· the top section shows the name of the channel in a colour coded bar. 

· the centre section shows the channel range. This will normally be the 
same as the channel name but will change if a special range is selected – 
see below. 

· the bottom section shows the channel value. Normally this is shown as a 
DMX value (0-255) but can be changed to a % value by de-selecting the 
DMX button. 

You can set a custom channel value in three ways: 

· click on the up and down buttons, in the bottom section, to adjust the 
value by + or – 1 each time you click a button. 

· click in on the value display to highlight it and type a new value with 
the keyboard. 

· click in on the value display to highlight it and while holding the pen or 
mouse button down, not that the cursor changes to an up/down arrow. 
Now move the pen or cursor up or down as though you were adjusting 
a slider. 

 

For many fixtures the Vista library includes information about the value channels 
need to be set to for a particular effect. In this case you can click on the custom 
panel’s title bar or double-click anywhere on the panel to open the Custom 
feature window. 
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Custom feature window 
The custom feature window lets you select any special values or a value within a 
range that is in the Vista library for the selected fixture. 

 

 

This field… does this… 

Name Shows the name of the channel or selected channel 
range. 

Range Fader (top) Adjusts the channel value within the selected range if 
such a range exists. 

Channel Fader (lower) Adjusts the channel value to any value in the DMX 
range – 0-255. 

Search For fixtures with large numbers of custom values (for 
example media servers) you can type in this field to 
locate a special value or range by name. 

Sort For fixtures with large numbers of custom channels 
(for example media servers) you can sort the values 
by ID# (usually as the values appear in the fixtures 
DMX channel chart) or by Name. 

Icon Size Adjusts the size of the custom value/range selector 
buttons in the right hand column. 
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This field… does this… 

Range buttons In this column there will always be one button that 
selects the entire channel range (i.e. 0-255). 

If the Vista library includes information about the 
fixtures custom values there will be a button for each 
of the special values or value ranges. Clicking on the 
button will set the channel to that value or range. If 
it’s a range you can adjust the value, within that 
range, using the top slider. 

DMX / Units This button selects between DMX values (0-255) and 
units (normally 0-100) 

Associated feature 
panels 

If there are other features that are associated with the 
selected feature,they can be selected and adjusted 
from within the window. 

The SmartFX tab 
If it’s not already selected, click on the SmartFXs tab at the top of the sidebar: 
This is where you can modify the settings for any of Vista’s inbuilt effects or 
build one from scratch. 
For more details on using the SmartFX window see SmartFX on page 8-1 

The Components tab 
If it’s not already selected, click on the Components tab at the top of the sidebar: 

 

This is where you store, select and organize your Groups, presets, Extracts, 
Effects, Cuelists and Snapshots. The window is divided into different areas that 
allow you to: 

· choose how you want to view the components. 

· choose the type of component you want to work with – Groups, Presets, 
Effects, Extracts and  Snapshots. 

· choose a component and either activate it or modify it in some way. 

· create new pages that let you group components into custom sets. 

This screen provides quick access to all the elements used for programming and 
playback of a show. To choose the component type you use the buttons at the top 
of the left column: 

This button… does this… 
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This button… does this… 

QP1 displays  a multi-panel ‘Quick picker’. The Quick pickers 
provide an easy way to arrange and select Presets, Groups, 
Extracts SmartFX and more. 

QP2 displays a second multi-panel ‘Quick picker’.  

Groups displays and lets you select or modify the groups you’ve 
saved. 

Presets displays and lets you select or modify the presets you’ve 
saved. 

FX displays and lets you select any of Vista’s built in effects  

Extracts displays and lets you select or modify the Extracts. you’ve 
saved. 

The parameter Filter bar 
If you are working with Presets, Effects or Extracts the Parameter Filter bar can 
be used to filter the items that are displayed or the features that are stored. 

 

If you are recording a Preset the filter bar shows which parameters are being 
recorded and which are not. You can click on any of the icons to either include it 
or exclude it. Included parameters are highlighted.  

For more information about presets and filters see Presets on page 6-46. 

If you are applying an item that includes more than one parameter type you can 
use the filter bar to filter out any parameters you don’t want to use. For example 
you might have a Preset that includes Intensity, Position and Colour but you 
only want to use the Colour part. In this case you would click on all the filter bar 
icons except Colour before selecting the preset. 

When you are applying presets from the Components panel the Preset will fade 
in over the ‘Live Time’. For example you might be working in the Live 
programmer tab and want to fade some lights into a colour or position over 
several seconds. To do you use the Live Time window: 

Components window tools 
If you are working with Groups, Presets, Effects or Extracts there is a toolbar at 
the bottom of the panel that acts on the list of items. 

This button… does this… 
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This button… does this… 

[ + ] Creates a new component of the selected type. 

[ - ] Allows you to delete a component. 

Search Typing in the ‘Search’ box filters the list down to just the 
items that match what you’ve typed. 

X Clears the search box. 

 

Quicker Picker panels 
The Quick Picker panels provide an easy way to select any of the following items 
you’ve created: 

· Groups 

· Presets 

· SmartFX (FX templates) 

· Cuelists 

· Extracts 

· Favourites 

· Snapshots. 
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The Sidebar has two panels (QP1 and 
QP2) that normally display three 
quickpicker panels. To adjust size of a 
Quick picker click on the divider bar 
and drag up or down. To hide one or 
two of the Quickpickers drag the 
divider(s) to the bottom of the panel. 

You can set what a Quick picker 
displays by choosing an option from 
the drop-down menu at the top left 
side of each column. Once you’ve 
chosen the type of information you 
want the column to display, you can 
also select what page you want to 
display within that column using the 
second drop-down menu. 

To add a page to a quickpicker right 
click on the panel you want and select 
‘add new page’ from the popup 
menu. 

To delete a page from a quickpicker 
right click on the panel you want and 
select ‘remove page’ from the popup 
menu. Deleting a page does not delete 
the items on that page. 

To copy an item hold the ‘Alt’ key (or 
Green modifier) while dragging the 
item from one page to another. 

 

Ü You can also have Quickpickers at the bottom of the main programmer 
window and on external touchscreen monitors. 

The Multi Quickpicker 
The multi-quickpicker contains 4 quickpicker panels and normally appears at the 
bottom off the Fixture Chooser and Timeline window. If it’s not already open 
select the ‘Multi Quick Picker’ option from the View > Add Dockable Window 
menu, Vista displays the Multi Quickpicker. 
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The Multi Quickpicker is a dockable window, it can either be docked inside the 
main window or it can float on top of or beside the main window. 

To un-dock a dockable window, click on the header bar and drag it off the main 
window. To dock a floating window drag it inside the fixture layout or timeline 
panel and drop it on the left, right, top or bottom of the panel. 

The Multi Quickpicker normally displays four quickpicker panels. To adjust the 
width of a Quick picker click on the divider bar and drag left or right. To hide 
one or two of the Quickpickers drag the divider(s) to the right of the panel. 

Ü You can also have Quickpickers on external touchscreen monitors. 

Ü To re-dock a floating window double click on the window’s title bar. 

Quickpicker popup menu 
Depending on the component there are various options available on the 
Quickpicker context menu. To open this menu right-click on the label area of any 
component. Vista displays the context menu: 

 
 

This option… does this… 

Edit Opens the selected item in the editor. 
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This option… does this… 

Duplicate Makes a copy of the selected item. 

Rename Opens a window where you can rename the selected 
item. 

Renumber Opens a window where you can renumber the 
selected item. 

Change Icon Opens a window where you change the icon for the 
selected item. 

Delete Opens a window where you can delete the selected 
item. 

Properties Opens the Properties window if a Cuelist is selected. 

Add new page Adds a new empty page to the selected  quickpicker 
panel. 

Remove page Removes the selected page. 

Rename page Opens a window where you can rename the selected 
page. 

Ü You can also play and release cuelists by selecting them (Alt + select to 
release) in a Quickpicker that has been configured this way – see below. 

Ü You can open the Update Preset window by pressing the Yellow modifier (or 
Ctrl key) and selecting the preset. 

Arranging the Quicker Picker panels 
When you first display a Quick picker panel you’ll see the items are laid out as 
buttons in a grid. You can re-arrange the items into a single or multi-column list 
and change the how each item is displayed.  
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To do this click on the  settings icon to open the Quickpicker settings window: 

 

 

This button… does this… 

Icon size Adjusts the size of the icons displayed in the Quickpicker.  

Text size Adjusts the amount of space available for the label.  

Padding Adjusts the amount of space between the icons. 

Icon Click this button to display just an icon for each item. 

Label Click this button to display just a text label for each item. 

Both Click this button to display both an icon and a text label for 
each item. 

Multi-list Click this button to arrange the items in a multi column list. 
The items are laid out across and then down. 

Single list Click this button to arrange the items in a single column list. 

Touch screen Click this button to arrange the items in a grid suitable for 
use on an external touchscreen. 

Icon view Click this button to arrange the items in a compact grid of 
icons without labels. 
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This button… does this… 

Auto-arrange Arrange the icons by Name (alphabetically) or by ID 
(number) 

Cuelist 
Playback 

When the selection box is ticked, selecting a cuelist will play 
it. To release a cuelist hold the green modifier (or press Alt) 
and select the cuelist. 

Apply to all Click this button to apply these settings to all Quickpicker 
windows. 

 

Presets labels 
When you select some fixtures, the preset labels change to indicate which are 
available: 

This label… indicates… 

Greyed This preset does not have any settings stored for the 
selected fixtures. 

Normal This preset has settings for some or all of the selected 
fixtures. 

Ticked This preset is being used on the selected fixtures. 

Groups 
If you have a big rig, the last thing you want to do is manipulate dozens of 
individual fixtures. To make it easy to control all the fixtures in your rig Vista 
automatically creates groups for each fixture type that you patch. You can also 
create your own groups.  

A group can consist of any number of any type of fixtures; it’s entirely up to you 
what you put in a group. Some typical groups might be all the even or odd 
fixtures of one type, all the fixtures on the back truss, or all the fixtures you’re 
using on one particular part of the stage. 

When you save a group, the fixture selection order is also stored. This can be 
useful if you are fanning colour or another feature, applying effects across a 
group and want a particular result 
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Creating groups 
When you are first creating groups it’s easier to be in a layout that shows the 
Groups panel in the sidebar. If you’re seeing something else, click on the 
Components tab and select the ‘Groups’ button: 

 

To create a group: 
1. Select the fixtures you want in the group. 

2. Click the [+] Add Group button at the bottom of the Group panel. Vista 
opens the Create New Group window. 

3. Type a name for the Group and click OK or press Enter. If you don’t want to 
name the Group right away you can accept the suggested name and rename 
it later. 

You can create as many groups as you want, and you can also create any number 
of ‘groups of groups’.  

Updating Groups 
You can use the Programmer to update the information stored in a group. To do 
this: 
1. Either in the Live tab or a cuelist tab, select the fixture group you want to 

change. Vista selects all fixtures in the group. 

2. Select additional fixtures or deselect any already in the group. 

3. Select the ‘Update Fixture Group’ option from the Components menu. You 
can also update a group by right-clicking on the group icon and selecting 
Update from the popup menu. 
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Presets 
Presets are the ‘building blocks’ that you use to create cuelists. They represent 
common sets of attributes that you know you’re going to want to use over and 
over again, such as a particular colour (e.g. Red) or position (e.g. on the 
drummer). 

Presets are useful for two reasons. First, with presets you can quickly assign  
Intensity, Position, Colour, Gobo, Beam and other values to any number of 
fixtures without having to adjust the settings individually for each one. Second if 
you store your cues using presets you can quickly update all your programming 
without having to edit every cue.  

Creating presets 
To create a preset: 
1. Select one or more fixtures. 

2. Set any of the Intensity, Position, Colour, Gobo, Beam values on the palette 
the way you want them. 

3. Then either:  

· Click on any of the palette type button  and select the the ‘Preset’ > 
‘Create Preset’ option from the popup menu or, 

· Select the ‘New > +Preset’ option from the Components menu, or 

· Click on the ‘+ Preset’ button in the Components toolbar. (To open the 
Components toolbar choose the Toolbar > Components toolbar from the 
View menu, or 

· Right-click in a Presets Quickpicker and select the Create preset option. 
 Vista displays the Create New Preset window: 

 

4. Enter a name for the preset in the name box (beside the icon). 

5. Click on the icon and select and different image if required. 

6. Set the Preset store options: 
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This option… does this… 

Name Allows you to name the new preset. 

Global Values Tick ‘Create Global Values’ if you want to be able to 
use this preset on any fixture, of any type, even if it is 
not selected when you store the preset.  

Tick ‘Create Fixture Type Values’ if you want to be 
able to use this preset on any fixture, of the same 
type, even if it is not selected when you store the 
preset.  

Filter Fixtures Normally only the selected fixtures are included in 
the Preset. If you want to include all fixtures, in the 
preset, click on the drop down box and select the 
‘All’ option. 

Filter Output Normally presets store the values that the fixture(s) 
are outputting, no matter whether they are coming 
the Live tab of the Programmer or from any Cue that 
is playing. 

To only store values coming from the active Cue (in 
the Programmer) click on the drop down box and 
select the ‘Current Cue’ option. 

Filter Features Presets are normally per-palette, i.e. you create 
separate presets for intensity, colour, gobo, beam and 
miscellaneous features. 

However the filter bar lets you include or exclude 
any features. 

To include a feature click on it’s icon so that it is 
highlighted. 

To exclude a feature click on it’s icon so that it is not 
highlighted. 

Display Preview panel Tick this checkbox to shows a preview of the fixtures 
you have selected and the features that will be stored 
in the preset. 

 

7. Click the OK button. Vista creates a new Preset that appears in the Presets 
panel of the Component Sidebar and in Quickpickers set to show All presets 
or ones of the feature type you’ve created. 
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Editing presets 
You can use the Programmer to add, remove or change information stored in a 
preset. There are two ways to open a preset for editing: 

· in the Sidebar Components tab you can right-click on the the Preset and 
select the ‘Edit’ option from the popup menu. 

· in the Multi Quickpicker you can right-click on the the Preset and select 
the ‘Edit’ option from the popup menu. 

 
Once the Preset is open in the Programmer you can make changes in the same 
way as you do when editing a Cue: 

· select fixtures in the Fixture Chooser window and add, remove or 
change settings using the palettes or encoders, or 

· select fixtures or Event bars in the Timeline window add, remove or 
change settings using the palettes or encoders. 

To save changes to a Preset, choose the Save changes to Preset option from the 
Components menu (Alt / Option + S). Or click the red close icon on the Preset 
tab and you will be prompted to save or discard the Preset changes. 

Updating presets 
You can use the Programmer to update the information stored in a preset. To do 
this: 
1. Either in the Live tab or a cuelist tab, select the fixtures you want to change 

or add to the preset. 

2. Make the adjustments you want using the palettes. 

3. Either right-click on the preset and select Update from the popup menu or 
hold the yellow modifier (Ctrl key) and tap the preset.. 

4. Vista displays the Update Preset window: 
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5. Set the Preset update options: 

This option… does this… 

Name Allows you to change the preset name. 

Global Values Tick ‘Create Global Values’ if you want to all 
fixtures, of any type, even if it is not selected when 
you store the preset.  

Tick ‘Update Fixture Type Values’ if you want to be 
able to use this preset on any fixture, of the same 
type, even if it is not selected when you store the 
preset. 

Don’t tick either box if you only want the change to 
apply to the selected fixture(s). 

Update Options Select ‘Merge’ if you want add new information to 
the preset. 

Select ‘Replace’ if you want to discard the old preset 
information and save the new settings. 

Filter Fixtures Normally only the selected fixtures are included in 
the Preset. If you want to include all fixtures, in the 
preset, click on the drop down box and select the 
‘All’ option. 

Filter Output Normally a preset update only saves settings coming 
from the selected Programmer tab (i.e. Live or a 
Cuelist). 

To store the values that the fixture(s) are outputting, 
no matter whether they are coming the Live tab of 
the Programmer or from any Cue that is playing click 
on the drop down box and select ‘All’. 

Filter Features Presets are normally per palette, i.e. you create 
separate presets for intensity, colour, gobo, beam and 
miscellaneous features. 

However the filter bar lets you include or exclude 
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any features. 

To include a feature click on it’s icon so that it is 
highlighted. 

To exclude a feature click on it’s icon so that it is not 
highlighted. 

Display Preview panel Tick this checkbox to show a preview of the fixtures 
you have selected and the features that will be 
updated. 

Edit Opens the preset in the programmer Chooser / 
Timeline window. 

Edit Blind Opens the preset in the programmer Chooser / 
Timeline window and allows you to make changes 
without them being visible on stage. 

 

6. Select ‘OK’ to keep the changes or ‘Cancel’ to discard them. 

Ü You can also update Presets when you Update a cuelist that’s being played 
back. 

The Highlight and Lowlight presets 
The Highlight and Lowlight presets set the behaviour of fixtures when Highlight 
mode is on. 

· When you select a fixture it goes to the Highlight preset. 

· When you deselect a fixture it goes to the Lowlight preset. 

Editing the Highlight and Lowlight presets 
You can use the Programmer to add, remove or change information stored in 
these presets. To do this: 
1. Select the Highlight or Lowlight option from the Edit menu. Then select the 

‘Edit’ option from the popup menu. Vista opens the preset, as a tab in the 
Timeline window. 

2. Once the Preset is open in the Programmer you can make changes in the 
same way as you do when editing other presets (see previous section). 

· select fixtures in the Fixture Chooser window and add, remove or 
change settings using the palettes or encoders, or 

· select fixtures or Event bars in the Timeline window add, remove or 
change settings using the palettes or encoders. 

3. Tap on the red ‘Close’ icon on the Highlight or Lowlight Preset tab. Vista 
opens the Save Preset changes window. 
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4. Select Save to keep the changes. 

Updating the Highlight and Lowlight presets 
You can update the Highlight and Lowlight presets in the same way as you 
update other presets. To do this: 
1. Set the fixture(s) Intensity and any other features, such as colour and beam, 

that you want included in the Highlight setting. 

2. Select the Highlight or Lowlight option from the Edit menu . Then select the 
‘Update’ option from the popup menu. You can also right-click in the 
Sidebar, Components, Presets panel and select this option from the popup 
menu. Vista opens the ‘Update Highlight (or Lowlight) preset window. 

You cannot change the name of the Highlight or Lowlight preset but otherwise 
updating the High/Lowlight presets works the same way as for standard 
presets. For more information see Updating presets on page 6-48 

The Home preset 
The Home preset is used to set the behaviour of fixtures when some or all of their 
features are sent to their ‘Home’ value. For example most fixtures with pan and 
tilt features will go to their default values of 50% pan and 50% tilt when they are 
sent to the Home position. 

Ü If a fixture is not going to the position you want when you clear the editor 
(or the focus setting or any other feature is incorrect) you can edit the Home 
preset to fix the problem. 

Editing the Home preset 
You can use the Programmer to add, remove or change information stored in the 
Home preset. To do this: 
1. Select the Home  option from the Edit menu . Then select the ‘Edit’ option 

from the popup menu. Vista opens the Home preset in the Programmer. 

 

2. Set any features (Intensity, Position, Colour, Gobo Beam etc) of the fixture(s) 
you want to go to non-default values. 

3. Tap on the red ‘Close’ icon on the Home  Preset tab. Vista opens the Save 
Preset changes window. 
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4. Select Save to keep the changes. 

Updating the Home preset 
You can update the Home preset in the same way as you update other presets. 
To do this: 
1. Set the fixture(s) Position and any other features, such as colour and beam, 

that you want included in the Home setting. 

2. Select the Home option from the Edit menu . Then select the ‘Update’ option 
from the popup menu. You can also right-click in the Sidebar, Components, 
Presets panel and select this option from the popup menu. Vista opens the 
‘Update Home’ preset window: 

 

You cannot change the name of the Home preset but otherwise updating the 
Home presets works the same way as for standard presets.  For more information 
see Updating presets on page 6-48 

Live Time 
If you are working live with Presets, Palettes or any of the Sidebar panels the 
‘Live Time’ window can be used to control crossfade time. 

When you are applying a preset or simply selecting a (non-linear) value in the 
sidebar palettes you can set a time for the Preset or selected value to fade in. For 
example you might be working in the Live programmer tab and want to fade 
some lights into a colour or position over several seconds.  

To set the Live Time: 
1. Click the ‘Live’ button on the main toolbar. This button is normally mapped 

to Function Key F10 on the keyboard. You can also select the ‘Live Time 
option from the Tools menu. 

2. Enter a time in seconds or click on the drop down box and select one of the 
live time presets. 

Ü When you are working in the Live tab of the editor and the Superplayback 
section is set to IPCG mode the right hand fader of the SPB can be used to 
scale the live timing. 
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Live time presets 
Vista comes with 2 Live time presets: 2s and 5s. But if you regularly use other 
time settings you can save these as presets that appear on the drop down list. To 
do this: 
1. Click the ‘Live’ button or select the ‘Live Time option from the Tools menu. 

2. When the Live Time window opens, select the ‘Custom Timing’ option from 
the drop down box. Vista opens the Custom Timing window. 

  

3. Set the Fade Time, Delay time and Fade curve for each of the features: 
Intensity (Up and Down) Position, Colour, Gobo, Beam and Miscellaneous. 

This field… Does this… 

Time Sets the fade time in seconds. You can also set the fade 
time by clicking on the timing bar and dragging the 
right handle forwards or backwards. 

Delay Sets the delay time in seconds. You can also set the 
delay time by clicking on the timing bar and when the 
cursor turns into a hand dragging the bar to the right. 

Fade Curve Sets the fade curve. To set the fade curve click on the 
icon and select an option from the popup list.  For more 
information about fade curves see fade curve on page 7-
32. 

 

4. Click on the ‘Save as’ button and give this Timing preset a name. 

5. Click OK to save. The new Timing preset will now be available on the Live 
Timing drop down box. 

SmartFX templates 
Vista comes with a number of built in effects that you can use to quickly create 
dynamic looks including intensity pulses, position shapes, colour chases and 
more.  
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To see the built in effects, click on the Components tab and select the ‘FX’ button. 
This lets you apply one of the built in  effects with just one click but you can also 
use the SmartFX window to modify the built in effect or create your own effects 
from scratch.  

See the SmartFX window on page 8-1 

Applying a built in effect 
To apply an effect: 
1. In the Fixture chooser window, select the fixtures you want. 

2. Click the FX button on the Components tab. Vista displays a list of the built 
in effects: 

 

3. You can click on the filter bar icons to either include or exclude effects that 
include the corresponding parameter types. 

4. Click the Stored (Canned) FX tab. Vista displays the list of available stored 
(canned) effects. The letters in the ‘content’ column each effect tell you which 
parameters are in this effect (e.g. I-Intensity, P-Position, C-Colour, etc). 

5. To apply an effect, click on the effect you want. 

6. To adjust the parameters of an effect, open the SmartFX window and use the 
controls to adjust it (see Effect controls on page 8-4). 

Effects that modulate or swing 
The built in effects are pre-set to either swing or modulate. Swinging means the 
fixtures move between two or more sets of attributes determined by the effect 
(e.g. moving from to left to right). Effects that are preset to modulate will apply 
their own varying attributes about a particular setting (e.g. creating a circle 
around a position). 
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Extracts 
Extracts are like programming templates and can contain any of the attributes 
you define on the palettes: intensity, colour, beam, position, and so on. They also 
store the timing associated with the events. 

An extract is a section of a cuelist (or range of events) that you can save and re-
apply in other cuelists. By re-using existing material to build new cuelists you 
can save yourself a lot of time re-creating your favourite lighting effects. 

Creating extracts 
To create an extract: 
1. Select the part of the cuelist or events on the timeline that you want to use as 

an extract. 

2. To store an extract, either: 

· Select the Extracts button on the Components tab, in the sidebar. Then 
click on the + button, or 

· Click on the ‘New Extract button – normally Alt-F8, or 

· Right-click in a Extracts panel and select the Create extract option. 

3. Type a name for the extract and click the OK button. 

4. Vista adds the new item to the extract list. 

Applying extracts 
To apply an extract: 
1. Select one or more fixtures in the Fixture chooser window. 

2. Click the Extracts button on the Components tab of the sidebar. 

3. Find the extract you want and click on it to select it. 

Set the mask buttons so that the attributes you want are applied. Any attribute 
that is masked, even if it is part of the extract, will not be applied.  
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Editing Extracts 
You can use the Programmer to add, remove or change information stored in a 
extract. There are two ways to open a preset for editing: 

· In the Sidebar Components tab you can right-click on the the Extract and 
select the ‘Edit’ option from the popup menu. 

· In the Multi Quickpicker you can right-click on the the Extract and select 
the ‘Edit’ option from the popup menu. 

Once the Extract is open in the Programmer you can make changes in the same 
way as you do when editing a Cue: 

· Select fixtures in the Fixture Chooser window and add, remove or 
change settings using the palettes or encoders, or 

· Select fixtures or Event bars in the Timeline window add, remove or 
change settings using the palettes or encoders. 

To save changes to a Extract, choose the Save changes to Extract option from the 
Components menu (Alt / Option + S). 

Using a keypad in the programmer window 
Vista includes a CLI (Command Line Interface) window that provides familiar 
keypad syntax for selecting fixtures, setting intensities and storing cues. The CLI 
appears at the bottom of the main editor window and is completely synchronized 
with the interface so that when you type a command you see the equivalent 
action happen on the fixture icons and control palettes 

The CLI accepts input from your keyboard or from a suitable USB keypad. The 
CLI window can be left open at all time and will only accept input when the 
keyboard or keypad is not being used by another window. 

Using the CLI  
· You can open and close the command line by clicking View -> 

Command Line. 

 

Hardware Keypad 
You can use the keyboard number keys or a separate keypad when the CLI 
window is showing. The ‘Num lock’ key should be on and in addition to the 
number keys the following special keys are available: 

This button… does this… 

/ Through (also used in storing cues – see below) 
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This button… does this… 

* or @ At 

** or @@ At +Full 

Backspace <- Backspace (Clear) 

F Fixture 

G Group 

A Store All (Look) 

S Store Part 

T Time 

Selecting fixtures in the CLI. 
For simple fixture selections you can just type the fixtures numbers. However 
you can also select Groups and Fixtures by prefacing the ID numbers with a ‘G’ 
for Group or ‘F’ for fixture.  

For example: 

· 1 + 5 + 10 Enter selects fixtures 1, 5 and 10 

· G1 + F20 Enter selects all the fixtures in group 1 plus fixture 20. 

· 1 / 10 – 4 / 6 Enter selects fixtures 1, 2, 3, 7, 8, 9 and 10 

Selecting fixtures and setting levels in the CLI 
You can also set levels with the keyboard. To simplify operation Vista 
automatically completes some entries. 

For fixture ‘through’ selections leaving off the second number means all higher 
numbered fixtures will be selected. 

For intensities single digits are interpreted as tens (@5 is the same as @ 50).  
Number. 

Setting ‘through’ levels can also fan intensities. 
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For example: 

· 1 / 10 @ 50 Enter selects fixtures 1 through 10 and sets them to 50%. 

· 1 / 10 @ @ selects fixtures 1 through 10 and sets them to 100%. 

· 1 / 3 @ 20 / 100 Enter selects fixtures 1 through 3 and fans their 
intensities between 20 and 100% (fixture 1=20%, fixture 2=60%, and 
fixture 3=100%). 

· 10 > @ 9 Enter selects all fixtures 10 and above and sets them to 90%. 

· 1  @ 05 Enter selects fixture 1 and sets it to 5%. 

· 1  @ 5 Enter selects fixture 1 and sets it to 50%. 

Storing with the CLI 
The Command Line can also be used to store cues and set timing. For example: 

· A 100 Enter 
Store Look Cue 100 to the open or the most recently used Cuelist. 

· A 2 / 10 Enter 
Store Look Cuelist 2 Cue 10. 

· A 5 / 8 T 2/3 Enter 
Store Look Cuelist 5 Cue 8 with a 2 second Infade and 3 second outfade 
time. 

· S 9 / 1 T 2/3 Enter 
Store Part Cuelist 9 Cue 1 with a 2 second Infade and 3 second outfade 
time. 

The Programmer hardware controls 
With the encoder wheels and associated LCD and buttons on the Vista consoles 
you can make more exact adjustments than the on-screen palettes. During 
programming you can use them to adjust setting for Intensity, Position, Colour, 
Gobo and Miscellaneous parameters. 

Programmer intensity 
The overall intensity from the Programmer is controlled by the fader located on 
the left side, below the encoder wheels. 
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Programmer mode 
If the controls are not already in Programming mode press the button labelled 
‘Menu’ and then select the ‘IPCGB’ button: 

 

Vista switches the controls to programming mode: 

 

This button… does this… 

I / Pos Press this button to put the encoders and lower 6 buttons in 
Intensity plus Position mode. Pressing it again cycles the 
controls through any available parameters or alternate 
modes (Angular position and Strobe & Shutter). Hold the 
red modifier (or the shift key) and click to cycle the controls 
in reverse.  

Colour Press this button to put the encoders and lower 6 buttons in 
Colour mode (HSV). Pressing it again cycles the controls 
through any available parameters or alternate modes (CMY, 
RGB, Frame / Index and Colour swatch). Hold the red 
modifier (or the shift key) and click to cycle the controls in 
reverse. 
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This button… does this… 

Gobo Press this button to put the encoders and lower 6 buttons in 
Gobo mode. Pressing it again cycles the controls through 
any available parameters or alternate modes. Hold the red 
modifier (or the shift key) and click to cycle the controls in 
reverse. 

Beam Press this button to put the encoders and lower 6 buttons in 
Beam mode. Pressing it again cycles the controls through 
any available parameters or alternate modes. Hold the red 
modifier (or the shift key) and click to cycle the controls in 
reverse. 

Custom Press this button to put the encoders and lower 6 buttons in 
Custom parameter control mode. Pressing it again cycles the 
controls through six pages of custom parameters. Hold the 
red modifier (or the shift key) and click to cycle the controls 
in reverse. 

To assign parameters to the custom pages see Creating 
Custom encoder pages on page 6-60 

Home Sets the associated parameter to it’s default values. I.E. 
would set Intensity to 0.  

Ü Holding the Yellow modifier (or Ctrl key) changes this 
button to Clear. 

Full Sets the associated parameter to it’s maximum values. I.E. 
would set Intensity to 100. 

Ü Press Home and Full together to set the parameter to it’s 
mid value. 

Ü Holding the Yellow modifier (or Ctrl key) changes this 
button to Zero. 

Encoders Rotate to set the associated parameter to the required value. 

<- Left arrow Selects the previous fixture. 

-> Right arrow Selects the next fixture. 

Creating Custom encoder pages 
The Intensity + Position, Colour, Gobo and Beam encoder pages are predefined 
by Vista but you can also create your own ‘Custom’ encoder pages. These can be 
useful for: 
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· Quick access to 3 commonly used features that don’t normally appear 
together (i.e., gobo, gobo index and  focus) 

· Controlling custom parameters that are not normally available on 
encoders (i.e. media server file and folder selection). 

Up to 6 pages of features can be assigned for each fixture type.  To create custom 
encoder sets, you do this: 

1. Select the ‘Assign custom encoders …’ option from the Console menu. Vista 
opens the Superplayback customisation window: 

 

2. Select the fixture type that this set will be used with. If you have a single  
fixture type selected it will appear in the ‘Patched fixture box’. To choose a 
different fixture type click on the drop down list. 

3. Click in the Page 1, Encoder 1 cell and select a parameter from the drop 
down list. 

4. Repeat steps 2 and 3 to assign parameters to the other encoders and make 
additional pages. 

Ü You can use the  ‘Assign All’ button to automatically assign up to 18  custom 
features to the available encoder pages. 

Ü Click the ‘Clear all’ button to clear all encoders and pages for the selected 
fixture type. 

Using Custom Encoder pages. 
To switch between the custom encoder pages, press the custom softkey again. 
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7. Working with cuelists 
Once you’ve set up your patch, arranged your fixtures, assigned them to groups, 
and created the presets you want, you’re ready to create a Cuelist.  

This is where the Vista differs in a big way from traditional keypad-controlled 
lighting consoles, because instead of telling it what you want by entering strings 
of numbers, you do it all visually, on a large screen using the pen or mouse and 
the hardware controls. 

Vista offers three ways to start a new Cuelist, you can either: 

· Store a cue directly to one of the playback controls with as few as three 
button presses. With this method the cuelist is automatically given a 
name and number and the cue you’ve stored is ready to play.  Later you 
can add more cues to the same cuelist, change fade times and modify 
other settings by opening it in the editor. 

· Use either  of the two Store buttons in the main toolbar to store directly 
to a playback or to an existing cuelist. Store Look is easy to use and 
automatically sets the most popular options. Store Part provides access 
to more advanced options. 

· Open a new, empty, cuelist in the editor and store one or more cues to it. 
With this method you can store and edit as you go refining the cue fade 
times and every other aspect of the cuelist. After you save the cuelist 
you can switch to the Console window and drag it onto one of the 
playback controls. 

Vista is a Tracking Console 
When you store a cue this way only the settings that are changing are saved in a 
cue. For example, if a fixture is set to 50% Intensity in cue 1 and is not changed 
until cue 5, there won’t be any Intensity events stored in cues 2-4 for that fixture.  
That means if you change the intensity for that fixture in cue 1 will affect the look 
of cues 2-4. 

The important difference in a tracking system is that if no level is stored no 
change will happen. 

Store All 
 

There are several important features of ‘Store All’:  
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· All the settings that the console is sending to your fixtures are saved. 
The settings could be coming from the Live tab or any other Cuelist 
being edited, a playback or any other control on the console. 

· Store All does not save settings for fixture features that are at their 
default. For example if a fixture has 100% intensity, and in colour blue, 
Store All saves those settings but doesn’t save anything for Gobo, 
Position or any other feature of the light. This means that if you play the 
cue back it’s possible that another cue will influence what you see. 

· When you Store All the default operation is to append a new cue at the 
end of the last cuelist you saved to. 

· If you choose to store to an existing cue it will be replaced. For example 
if a have a Cuelist with 10 Cues, Store Look will default to saving to Cue 
11. If you choose to save to Cue 4 whatever was in that cue will be 
replaced when you store. 

· If you insert a cue before an existing one it’s settings will not change the 
look you’ve have saved in the existing cue. This is called ‘Cue only’ and 
means that any settings in the inserted cue are automatically undone in 
the following cue. 

· When you Store All directly to a Playback it will immediately take 
control of the cue and any setting coming from the Live tab will be 
cleared. Because Store All includes all output of the console, this won’t 
change anything the fixtures are doing – just where the control is 
coming from. 

Storing a look in 3 clicks 
If you have the Fixture Chooser window open and you are working in the Live 
tab you’ve probably already selected some lights, given them Intensity, Colour 
and so on. To create a new Cuelist fast, you do this: 
1. Click on the ‘Store All’ button or select the Store All option on the Tools 

menu. Vista displays the Store All window with all the store options preset 
but just leave everything as is for now. 

2. Double-tap on the select button of an empty playback on your console. If you 
are using the PC version, switch to the Console window and double click 
one the select button there. 
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3. The new Cuelist is ready to use and you can move the fader to bring the 
level down and back up. 

Ü When you Store All this way the console fader is automatically set to be a 
Submaster. 

Storing a look with options 
When you want to adjust the timing of a cue or give it a new name or number 
before storing you use the Store All window. To do this: 
1. Click on the ‘Store All’ button or select the Store All option on the Tools 

menu. Vista displays the Store All window: 

  

2. Vista sets the ‘Store to’ cuelist to the cuelist you last saved. If you want to 
store to a new cuelist or another cuelist you’ve already started you can 
either: 
· Type a new number, or 

· Type a few numbers or letters from the name and select the cuelist you 
want from the popup window. Vista displays all the cuelists that include 
the letters or numbers you type: 
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3. Vista sets the ‘Store to’ cue to a new cue number at the end of the cuelist you 
last saved. If you want to a different cue number or store over an existing cue 
number can either: 

· Type a new number or, 

· Type a few numbers or letters from the name and select the cue you 
want from the popup window. Vista displays all the cues that include 
the letters or numbers you type: 

  

4. If you want to store to an existing cuelist but aren’t sure of it’s name or 
number click the ‘Browse’ button. Vista displays the Cuelist and Cues 
window where you can select from all your saved cuelists: 

 

This option… does this… 

All Filters the browser to show all the cuelists you’ve stored. 
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This option… does this… 

Recent Filters the browser to show just the last few cuelists you’ve 
stored. 

Playing Filters the browser to show just the cuelists that you are 
playing back. 

Console Filters the browser to show just the cuelists that you are 
visible on the console – i.e. cuelists that are on the 
playback pages you can see. 

New Creates a New cuelist with the next available number. 

Cuelist number 

field 

Displays the cuelist number to save. You can enter a new 
number in this field.  

Search (cuelists) Typing a few letters or numbers in the search box filters 
the browser to show just the cuelists that match what you 
type. 

Select Cue Displays all the cues already stored in the selected cuelist. 
Normally the ‘New Cue’ line will be highlighted 
indicating that you will be storing to a new cue at the end 
of the cuelist. 

To store over an existing cue highlight the one you want.  

 
Inserts a new cue before the line the icon is on. 

Search (cues) Typing a few letters or numbers in the search box filters 
the browser to show just the cues that match what you 
type. 

 

5. Click on the icon in the ‘Cue Start Mode’ section to set how the cue will start, 
the options are: 

· Halt - Press the Go button to play the cue. 

· Follow - Play ‘n’ seconds after the previous cue has ended. 

· Start - Play ‘n’ seconds after the previous cue has started. 

· Timecode – Play at the specified Timecode (i.e. 01:02:03:04 would start 
the cue when timecode 1 Hour, 2 Minutes, 3 Seconds and 4 Frames is 
received). 

6. If you’ve made the cue start mode ‘Follow’ or ‘Start’ enter the time, in 
seconds, after the previous cue has ended or started to start this cue. 

7. Set the fade times for the cue. To do this you can either:  
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· Set the in and out fade time by typing in the time box. For example 
typing 2/3 sets the Infade time, for all features to 2 seconds and the 
outfade time, for Intensity to 3 seconds or, 

· Click on the timing drop down and select from the list of preset times. 
For more information on Timing see page xxx or, 

· Click on the timing bars and drag them to the fade times you want or, 

· Cick on the  expand icon to reveal the detailed timing panel: 

  

In the detailed view you can set a fade time, delay time and fade curve for each 
of the six feature types – Intensity (in and out), Position, Colour, Gobo, Beam and 
Miscellaneous channels. To set times either type in the boxes or click on the 
timing bars and adjust them. To change the fade curve click on the icon and 
select from the popup list. 

1. If you’re are storing to a New Cuelist, you can give it a title, in the Cuelist 
Name box. 

2. If you’re are storing to a New Cue, you can give it a title, in the Cue Name 
box. 

3. Click OK to complete the Store Look operation or double-tap on a playback 
‘Select’ button to Store the cuelist to that playback. 

4. Check the buttons for the classes or types of events you want Vista to 
display. 

5. Type a name for the filter. 

6. Click the ‘Close’ button. Vista adds this filter to the drop-down filter list. 

Ü Hold down the Yellow modifier (Ctrl on a keyboard) on the console and 
press the Select button on an empty playback to Store your look and open 
the cuelist in the Editor window. 
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Store Part 
 

Store Part is Vista’s advanced recording method. It provides several options, not 
available with Store Look. 

If you’ve created information in the Live tab of the Editor (or another cuelist), 
you can add it or merge it into an existing cuelist, or use it to replace a cue 
altogether. You can also start a new cuelist using the Store Part method.  

To store this way you do this click on the ‘Store Part’ button or select the Store 
Part option on the Tools menu. Vista displays the Store Part window: 
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Selecting the Cuelist to Store to 
Vista automatically sets the ‘Store to’ cuelist to the last cuelist you saved. If you 
want to store to a new cuelist or another cuelist you’ve already started you can 
either: 

· Click on the ‘New’ button in the cuelist panel to start a new cuelist. 

· Tap on a console playback ‘Select’ button to select the Cuelist on that 
playback or, 

· Click on the Cuelist you want in cuelist panel, which displays all your 
saved items. 

To help find a particular cuelist you can filter using the source and search 
options: 

This option… does this… 

All Filters the browser to show all the cuelists you’ve stored. 

Recent Filters the browser to show just the last few cuelists you’ve 
stored. 

Playing Filters the browser to show just the cuelists that you are 
playing back. 

Console Filters the browser to show just the cuelists that you are 
visible on the console – i.e. cuelists that are on the 
playback pages you can see. 

New Creates a New cuelist with the next available number. 

Search (cuelists) Typing a few letters or numbers in the search box filters 
the browser to show just the cuelists that match what you 
type. 

 

Selecting the Cue and store options 
You can add a new cue, or merge to or replace the contents of an existing cue. 
When you first open the Store Part window the Cue ‘Add’ button will be selected 
automatically. The Merge and Replace options will not be available unless you 
select an existing cue first. 
1. If you are adding a new cue you can either accept the cue number Vista 

suggests or type a number in the Cue Number box or click on one of the 
insert icons in the list of cues to set the insert location. 

 - insert cue icon 

2. If you are Merging or Replacing you can either type a number in the Cue 
Number box or click on any cue in the cue list panel.  

3. For a new cue enter the cue number and name. 

7-8 Vista User Guide, Version 2.3 



Working with cuelists Store Part 
 

4. Click on the icon in the ‘Cue Start Mode’ section to set how the cue will start, 
the options are: 

· Halt - Press the Go button to play the cue 

· Follow - Play ‘n’ seconds after the previous cue has ended. 

· Start - Play ‘n’ seconds after the previous cue has started. 

· Timecode – Play at the specified Timecode (i.e. 01:02:03:04 would start 
the cue when timecode 1 Hour, 2 Minutes, 3 Seconds and 4 Frames is 
received) 

5. If you’ve made the cue start mode ‘Follow’ or ‘Start’ enter the time, in 
seconds, after the previous cue has ended or started to start this cue. 

6. Select the timing option to apply to the cue, the options are: 
· Destination - use the timing of the cue you are saving to. 

· Custom - use the timing from the Editor or set it manually. 

7. Select the fixtures to include when storing: 

This option… does this… 

All  Fixtures Includes settings for all fixtures with output coming from 
the Live tab, or any other cue that’s open in the editor. 

Selected Fixtures Only includes fixtures that are selected in the Live tab or 
cue being edited. 

 

8. Select the parameters to store using the filter bar. Click on any of the 
Intensity, Position, Colour, Gobo, Beam or Miscellaneous icons to mask or 
un-mask that parameter. 

9. Select the Store Source options. 

This option… does this… 

Current 

Editor tab 

Automatically set to ‘Live’ or the Cuelist being edited. 

All Output Select this button to store all information, from both the 
editor and any active playbacks. 

 

10. Select the tracking options 

This option… does this… 

Cue only Click this checkbox to undo any changes in the following 
cue. This option will not have any effect unless there is at 
least one cue after the one you are editing. 
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11. Select the Blocking options. 

This option… does this… 

No Blocking The cue is stored normally. 

Normal Blocking Ensures that events that are tracking through to the cue 
being stored will not be changed even if they are modified 
in the earlier cue(s). 

Super Blocking When a ‘Super Block’ cue runs, any features for the fixtures 
in the cue, that aren’t already  included in the cue are 
automatically sent to their home value. This means that the 
cue will look as it would if no other cuelist was playing 

Opening a Cuelist in the Editor 
 

The ‘Store Look’ and ‘Store Part’ methods let you store cues to an existing (or 
new) cuelist, without first opening the cuelist in the editor. 

You can also start a new cuelist from scratch or open an existing one in the editor. 
To do this click on the New Cuelist button (normally F2) or select the ‘New 
Cuelist option from the Components menu. 

Whichever method you choose, Vista creates a new Cuelist tab and displays the 
Editor window. 
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The Timeline window 
When you select fixtures in the Chooser window and apply intensity, position, 
colour and other features ‘events’ are created in the Timeline window. 

 

This screen consists of three main elements: 

· The Editor control section where you can select to work with the Live 
editor tab or any Cuelist you have open. If you have a Cuelist open this 
section expands to include the Cue navigation controls. 

· The Cue navigation section, where you can see all the cues in your 
cuelist, make selections, add and delete cues, and manage how your 
edits affect output when you are editing a cue that’s playing back. 

· The Timeline section where you can view and manipulate the fade times 
for all the features that are being applied to your fixtures. 

Cuelist tabs 
When you first open the Editor’s Chooser or Timeline windows you’ll see the 
Live tab – this is the equivalent of what other consoles call the ‘Programmer’ or 
‘Editor’. If you open a cuelist or start a new one from scratch, Vista adds a new 
tab labelled with the cuelist name. 

You can have several cuelists open at once and switch between them by clicking 
on the tab you want to work on.  

To close and save a Cuelist tab, choose ‘Close Cuelist’ from the Cuelist menu or 
click the close icon on the cuelist tab. 

Ü To save a cuelist at any time select the ‘Save Changes to Cuelist’ option (Alt 
+ S) from the Components menu. 
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Ü When there is information in the Live tab that is affecting the output, a red 
clear icon is added to the tab. Click on it to clear the Live tab output. 

Playing and moving around a cuelist  
At the top of the editor timeline and chooser screens there is a set of player 
controls: 

 

The buttons work in a similar way to the controls on a CD or DVD player: 

This button… does this... 

 
Jumps to the first cue in a cuelist. 

 
Steps backwards to the previous Cue in a cuelist. 

 
Pauses playback. 

 
Starts playback of the next cue in the cuelist. 

 
Steps forwards to the next Cue in a cuelist. 

 
Jumps to the end of last Cue in a cuelist. 

 

Cuelist Navigator 
The cuelist navigation section shows you an overview of all the cues in a cuelist.  

Each cue is represented by a mini cue icon in a scrollbar so you can see all the 
cues you’ve stored. As you add more cues more icons are added to the scrollbar. 
If there are more cues than can fit in the cue tile (or table or layout) view the 
scroll bar becomes shaded. You can drag the shaded area to show different parts 
of the cuelist in the list, table and layout views. 

 

The cue scrollbar includes buttons to switch the navigator view and to add or 
delete cues. 

This icon… does this… 

7-12 Vista User Guide, Version 2.3 



Working with cuelists The Timeline window 
 

This icon… does this… 

 
Tiles view 

Shows the cues as a series of tiles. If there are more cues 
than can fit in this area the scrollbar highlights the area 
you are viewing and you can drag it to show other cues.  

 
Table view 

Shows the cues as a table with columns for the cue’s name, 
number, fade time, follow time, blocking status, included 
features, fixture count and SmartFX. 

 
Layout view 

Shows the cues on a timeline. This view is useful if have 
cues with follow times that mean they overlap other cues. 
You can move cues and set follow times by dragging cues 
on the timeline. 

 
Zooms the layout view to fit all the cues in available space. 

Tiles View 

 

In the ‘Tiles’ view: 

· Each cue tile shows the number, name, duration and start of cue action. 

· The cue or cues that are visible in the timeline are shown with a green 
underline. 

· Cues that have played show with a blue fill colour. 

· The selected cue shows with a yellow 

·  outline and with white text. Click on a tab to select it, shift-click or ctrl-
click to select a range or group of cues. 

You can click on a tile’s start action, cue number, name or duration label and 
enter a new value. The cue number cannot be changed to a value that would 
mean changing the order of the cue tiles. 

You can right-click on a selected cue or in the blank area to the right of the cue 
list to open a popup menu: 
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With these options you can: 

· Open the cue or cuelist properties window. 

· Set the Cue Follow mode (aka Cue start action) for the selected cue(s). 

· Block, superblock  or unblock the selected cue. 

· Set the cue to be a Mark (Move in Black) cue. 

· Append a cue at the end of the cuelist or insert a new cue before or after 
the selected cue or at the playhead position. 

· Delete or renumber the selected cue(s). 

· Revert (or undo) changes to the selected cue(s). 

· Change the start time of the selected cue(s). 

· Remove any alias cue links (without deleting any cues or events). 

· Add an audio file. 

· Cut or copy and paste or paste special (paste with options) the selected 
cues. 

· Change the appearance of the cue tiles by adding or removing fields. 

Table View 
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In the ‘Table’ view: 

· Each cue shows as a row in a spreadsheet style view. 

· The selected cue shows with a blue fill and white text. Click on a row to 
select a cue, shift-click or ctrl-click to select a range or group of cues. 

You can double-click on a cue number, name or duration label and enter a new 
value. The cue number cannot be changed to a value that would mean changing 
the order of the cues. 

Layout View 

 

In the ‘Layout’ view: 

· The cues are laid out end to end, in timeline view. Cues that are set to 
start before the previous cue finishes overlap and appear on a separate 
line. 

· The selected cue shows with an outline and white text. Click on a row to 
select a cue, shift-click or ctrl-click to select a range or group of cues. 

You can double-click on a cue’s name and enter a new value. To move a cue click 
and hold while dragging the cue to the left or right. 

Adding and deleting cues 
A cuelist can contain as many cues as you like. To add a new cue after the one 
that’s currently selected: 

· Click on the  ‘New cue’ icon at the end of the cuelist scrollbar, or 

· Choose the ‘Tools > Cues > Insert cue after selected’ option from the 
Cuelist menu. 

You can also insert cues before or after an existing cue by first selecting a cue 

then clicking and holding the  ‘New cue’ icon until the insert popup appears.  

The popup provides option to: 

· Insert a new cue before the selected cue. 

· Insert a new cue after the selected cue. 

· Append a new cue at the end of the cuelist. 

These options are also available on the ‘Tools > Cues submenu on the Cuelist 
menu. 
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Deleting cues 
To delete a cue, first select it then: 

· Click on the  ‘Delete cue’ icon at the end of the cuelist scrollbar, or 

· Choose the ‘Delete Cue’ option Tools > Cues submenu on the Cuelist 
menu. 

Merging cues 
Sometimes it’s useful to merge the contents of two or more cues. To do this: 
1. Select the cues with the pen or mouse. Shift-click or ctrl-click to extend the 

selection. 

2. Choose the ‘Merge cues’ option from the Tools > Cues submenu on the 
Cuelist menu. 

Ü Cues always merge to the lowest cue number. 

Moving and copying cues 
Often you’ll have an effect in one of more cues of a cuelist that you’d like to use 
in another place or another cuelist. You can do this using the cuelist navigator 
panel. 

To do this: 
1. Select one or more cues by clicking on the cue tiles. 

2. Choose the Copy or Cut option from the Edit menu or right-click on the 
cue(s) and select Copy cue or Cut cue from the popup menu. 

3. Click on the cue before the location you want to move or copy to. 

4. Choose the Paste option from the Edit menu or right-click on the cue(s) and 
select Paste from the popup menu. The default paste action will restore the 
look of the copied cue by inserting release events for any features added in 
the intervening cues. To paste just the events or an alias of the cue, use the 
‘paste special’ option.  

Ü You can also copy cues by dragging and dropping cue tiles in the cuelist 
navigator. 

Paste options 
If you want to move or copy just the events in the original cue, without releasing 
any other events that occur in previous cues you can use the ‘paste special’ 
option on the edit menu.  
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The cue scrollbar includes buttons to switch the navigator view and to add or 
delete cues. 

This option… does this… 

Paste the entire 
look. 

Restores the look of the original cue by inserting release 
events for any features added in the intervening cues. 

Paste only the 
events 

Pastes the events in the original cue, without adding and 
release events. 

Alias cue Pastes an alias of the original cue. 

 

Alias cues 
If you want to use the same cue, in a cuelist, several times you can make an 
‘Alias’. This way if you update any one of the associated alias cues they will all 
update.  

To create an alias cue: 
1. Copy the cue by selecting it and choosing the copy option from the edit 

menu. 

2. Navigate to the cue before the position you want the new cue to appear. 

3. Choose the Paste special option from the edit menu. Vista opens the Paste 
Special window. 

4. Select the Alias cue option and click OK. Vista pastes an Alias cue after the 
selected cue. 

Alias cue tiles are marked with a small ‘Alias’ icon and you can view the cues 
that are aliased to each other in the ‘Aliased cues’ section of the Cue properties 
window. 

Ü When two or more cues are aliased to each other any one can be changed 
and all the others will also change. There is no ‘master’ cue in an alias set. 

Removing the link to an Alias Cue 
An Alias cue can be changed to normal cue. To do this: 

1. Select the Cue tile to be changed. 

2. Select the ‘Remove Cue Alias’ option from the edit menu, or, right-click’ on 
the cue tile ‘Remove Cue Alias’ option from the popup menu. 
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Making changes to a cue without affecting the next cue 
It’s often useful to make changes to a cue without those changes tracking through 
to the following cue. For example, you might have a cuelist where the lights 
change to colour blue in cue 1 and stay that way until they change to red in cue 
10. If you then decide you want them to be yellow in just cue 5 you could make 
that change but since there are no colour events in cues 6-9 the lights will stay 
yellow when you really want them to revert back to blue in cue 6. 

For this situation Vista provides a method to make changes to a cue only. To do 
this: 
1. Edit a cuelist and make the changes. 

2. In the timeline select the events – they will normally be highlighted already. 

3. Click on the ‘Untrack’ button on the toolbar or select the ‘Un-track events 
(cue only)’ option from the Tools menu. Vista inserts events in the following 
cue to set the lights back to the state they were in before the change. If there 
were no events of that type originally, Vista inserts release events instead. 

Working in Cue only mode 
If you want to add a number of cues that do not track through to subsequent cues 
you can switch to ‘Cue only’ mode. This means that any settings in the cue you 
create are automatically undone in the following cue. 

To do this: 
4. Select the ‘Cue Only Editing’ option from the Tools menu. This command is 

normally assigned to F3 on the Blue function key set (or Ctrl + Alt + F3). 

5. When you have finished creating cues this way, deselect the Cue Only 
Editing option. 

Blocking a cue 
Vista is a tracking console, which means that only changed information is stored 
in any cue and that any information in a cue tracks forward until it is replaced by 
a new event or cleared. Sometimes it’s useful to ‘block’ a cue so that any changes 
that are subsequently made to previous cues will not affect the final look of the 
chosen cue.  

To do this: 
6. Select the cue with the events you want to keep exactly as they are. You can 

select the cue by clicking on the cue tile or playing the cuelist until you reach 
it.  

7. Choose the ‘Block’ button on the toolbar (normally Ctrl F9) or select the 
‘Block cue ’ option from the Cuelist menu or right-click on the cue tile and 
select Block from the popup menu. Vista duplicates all tracked information 
into the selected cue. 
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Creating a Move in Black cue 
Sometimes you will want fixtures to move to a position, change to a colour, add a 
gobo or get set up in some other way while their intensities are at zero. You 
could do this by programming the necessary events, but you can also do it 
quickly using the ‘Mark Cue’ option on the Tools menu. 

When you create a Mark cue your original programming is preserved and will be 
restored if you delete the Move in Black (MIB) later. 

To Mark a cue and add  ‘Move in Black’ events: 
1. Select the cue you want to work with.  

2. Choose the ‘Mark Cue’ option on the Tools menu. Vista opens the Move in 
Black window: 

  

This screen shows the options available; you use it to set the way Vista stores the 
Move in Black event: 

This option… does this… 

Move in Black 
destination cue 

If the ‘Select existing cue’ button is not greyed out you 
can click it to select any cue, earlier in the Cuelist, for 
the Move in Black events. 

If you prefer to create a new cue for the MIB events 
select the ‘Insert a new move in black cue’ option. 
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This option… does this… 

Cue Details – Name 

 

Sets the name for the new cue that will be created. The 
default name is MIB. 

Cue Details – Duration Sets the duration for the new cue. 

Start action Sets how the MIB cue is started, the options are: 

Halt - Press the Go button to play this cue. 

Auto Follow - the cue plays automatically after the 
previous cue. 

Finish with preceding – the cue plays automatically 
and is set to finish at the same time as the previous 
cue. 

Disable Move in Black Removes the Move in Black events from the MIB cue 
but does not delete it. 

Marked Features 

 - Feature filter 

Only the selected features will be marked for move in 
black. 

Marked Fixtures 

 - All Fixtures 

 - Current selection 

Lets you choose to mark all fixtures or just the ones 
currently selected. 

3. Click OK to create the Move in Black cue: 

 

The move in black events are shown as 'ghosted' events and display the "MIB" 
icon. Move In Black cues show ‘MIB’ in the tiled cue display and ‘[M]’ in other 
views. 

Ü Individual events in a marked cue can also be excluded from move in black.  
To do this, select the events in the timeline view and select the  ‘Ignore Move 
In Black’ option from the  from the Timeline’ menu or right-click menu. 
Ignored events show a MIB icon with a red cross running through it. 
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Ü Intensity cannot be marked. 

Cue Properties 
Each cue has a number, name and fade time that you can set by clicking on the 
cue tiles and editing the fields. You can also set these properties and other 
advanced options more in the Cue Properties window.  

To do this: 
1. Select the cue you want in the Cuelist navigator. 

2. Choose the Cue Properties option from the edit menu or right-click on the 
cue tile and select the Cue properties option from the popup menu. 

Modifying cue name, duration, and end of cue action 
The cue’s name, number and how it starts are set in the properties section of the 
window: 

 

This option… does this… 

Cue name Sets the name that appears in all windows for this cue. 

Cue number Sets the number that appears in all windows for this cue 
The cue number cannot be changed to a value that would 
mean changing the order of the cue tiles. 
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This option… does this… 

Follow Time 

(Cue Start Mode) 

Sets how the cue will start, the options are: 

 (Halt) Press the Go button to play this cue. 

 (Follow) Play ‘n’ seconds after the previous cue 
ends. 

 (Start) Play ‘n’ seconds after the start of the 
previous cue. 

 (Timecode) Play when the timecode is received. 

Default timing Sets the timing for all events that have not been manually 
adjusted. The popup window lets you select from the 
saved timing sets or customise a new one. 

Ignore Learn 
Timing 

Tick this checkbox to ignore this cue when using the 
‘Learn Timing’ feature. 

Making a cue loop back and repeat previous cues 
A cue can be set to loop back to a previous cue and to repeat the loop any 
number of times. ‘Looping’ is set in the loop section of the window: 

 

This option… does this… 

Loop iterations Sets how many times the loop will repeat before the cuelist 
proceeds normally. 

Loop to cue Sets the cue that will play next. 

Loop tracking Sets whether the events stored in the cues after the ‘Loop 
to cue’ will track through to the loop cue. 
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This option… does this… 

Loop direction Sets the direction of the loop. The options are: 

· Forwards - loops from last to first. 

· Backwards - loops from last to previous. 

· Bounce - loops backwards then forwards. 

· Random -  loops to a random cue between the first 
and last cue in the loops. 

Ü Cues that are set to loop don’t play automatically, like a chase. If you want 
any of the cues in a loop to play without pressing Go you have to set the cue 
start mode. 

Alias cues 
Alias cue tiles are marked with a small ‘Alias’ icon and you can view the cues 
that are aliased to each other in the ‘Aliased cues’ section of the Cue properties 
window: 

 

Tracking 
Normally features that are stored in any cue track forward until they are replaced 
by a new event or cleared. If you only want some events to play in one cue and 
not track forward you can turn tracking off for one or more cues. To do this open 
the Blocking / Tracking section of the Cue properties window and tick the ‘Non-
Tracking’ checkbox: 

 

Blocking 
Normally only changed features are stored in any cue and information tracks 
forward until it is replaced by a new event or cleared. Sometimes it’s useful to 
‘block’ a cue so that any changes that are subsequently made to previous cues 
will not affect the final look of the chosen cue. 

Vista User Guide, Version 2.3 7-23 



Cue Properties Working with cuelists 

To view or modify the blocking for a cue open the ‘Blocking’ section of the Cue 
properties window: 

 

This option… does this… 

None The cue is stored normally. 

Blocking Ensures that events that are tracking through to the cue 
being stored will not be changed even if they are 
modified in the earlier cue(s). 

Super Blocking Ensures that events that are tracking through to the cue 
being stored will not be changed even if other cuelists, 
that include the same feature types are played prior to 
this cue being played. 

Block Features Sets which feature types are blocked. Click on the 
Intensity, Position, Colour, Gobo, Beam and 
Miscellaneous icons to turn that feature on or off. 

Block Fixtures Sets which fixtures are blocked. You can choose either 
‘All Fixtures’ or the ones you have selected in the editor. 

Free Effects mode 
In Vista effects can either have a ‘basepoint’ or be ‘free’. A Free effect is designed 
to run on top of a feature setting. For example a free circle effect will cause 
fixtures to move in a circle around whatever position has been set by another cue 
or setting from the console. 

To view or modify the Event mode for a cue open the ‘Free effects’ section of the 
Cue properties window: 

 

This option… does this… 

Events provide 
Basepoint 

Events in the cue will be used as a base point for any  
baseless effects that are running. 
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This option… does this… 

Events stop Free 
effects 

If the cue includes an event that a baseless effect would 
act on the effect will be stopped. 

Audio Playback 
To add and play an audio file, when the selected cue plays  click on the ‘Audio 
Playback’ heading to open that section. 

This property… does this… 

Browse Opens the ‘Select Audio’ window where you can 
choose an audio file. 

Clear Removes the audio file from the cue. 

 

Ü To add an audio file that plays through all cues use the Cuelist Properties 
window. 

Cue Defaults 
If you have a set of Cue properties that you use frequently you can save them as 
your ‘Show’ default and they will be used for all future cues. You can also 
quickly reset a Cue’s properties to the factory defaults or to your show defaults. 

 

This option… does this… 

Reset to show 
defaults 

Reset all cue properties to the settings you have saved as 
the show defaults (see below).  

Reset to factory 
defaults 

Reset all cue properties to their standard (factory) 
settings. 

Save as show 
defaults 

Saves the current cue settings as a default for all new 
cues. 
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Cuelist Properties 
Each cuelist has a set of properties that control how it plays back and interacts 
with other cuelists. You can also set these properties in the Cuelist Properties 
window.  

To do this: 
1. Open the cuelist in the editor. 

2. Select the Cue Properties option on the Edit menu. 

  

This property… does this… 

Name Sets the name for this cuelist. 

ID Sets the number for this cuelist. This field is not 
editable. 
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This property… does this… 

Priority Sets the priority for the cuelist. A cuelist set to High 
priority can’t be overridden by normal or low 
priority cuelists. Only a cuelist set to Programmer 
priority can override the Editor (aka Programmer) 

Play at end option Determines what happens after the last cue is 
played and fully over-ridden. The options are: 

Restart – the Cuelist starts again at the first cue. 

Release – the Cuelist is released. 

Ignore – do nothing. 

Ignore Release All The cuelist will ignore the release all command. 

Ignore Snapshots The cuelist will not be affected by a snapshot being 
loaded. 

Release in Black Releases cuelists when they are no longer 
contributing intensity to the output. 

HTP Enabled Causes the intensities of a cuelist to activate as soon 
as you move the playback fader from 0.  

Fader Type Normally the fader on a playback set will adjust the 
Intensity of a cue list. To fade all features (Intensity, 
Position, Colour, Gobo, Beam and Custom) in or 
out with the slider set this property to “All 
Features”. 

Fader Auto Play Sets the fader play and release actions. The options 
are: 

None – the fader only controls intensity. 

Auto Play – raising the fader above 0% also plays 
the cue (aka ‘Go on fader up’). 

Auto Play & Release – raising the fader above 0% 
also plays the cue (aka ‘Go on fader up’). Lowering 
the fader to 0% releases the cue (aka ‘Release on 
fader down’). 

Auto Release – lowering the fader to 0% releases 
the cue (aka ‘Release on fader down’). 

Fader Intensity mode Sets the fader precedence and actions.  

Normal – the fader is in normal LTP mode. 

Submaster – the fader is HTP and will go on fader 
up and release on down if there is only one cue. 

Vista User Guide, Version 2.3 7-27 



Cuelist Properties Working with cuelists 

This property… does this… 

Release on Override Releases a cuelist that is completely over-ridden. 
(i.e. is not contributing to the console output.)  

Auto Move in Black Sets the cue to automatically MIB if Intensity is off 
in the previous cue. 

Minimum MIB cue 
length 

Sets the minimum required time for MIB events. If 
the duration of the preceding cue is less than this 
time, the move in black won’t occur. 

Auto-run on failure When a Vista D1 unit is being used for distributed 
processing this Cuelist will run on the D1 if the 
main console fails. 

Cuelist Timing 
To set timing properties click on the ‘Timing’ heading to open that section. 

This property… does this… 

Release Timing Sets the fade time when the cuelist is released. 

Playback rate % Playback rate for the cuelist. Normally 100% 

Cuelist Timecode 
To set timecode properties click on the ‘Timecode’ heading to open that section. 

This property… does this… 

Mode Sets how the cuelist responds to timecode input. 

Disabled – timecode is ignored. 

Enabled – timecode will be followed if the cuelist is 
‘Armed’ (see the next property). 

Locked – timecode will always be followed. 

Armed If the cuelist is set to timecode ‘Enabled’ it will not 
respond to timecode until it is armed. To arm the 
cuelist either set this property to ‘Armed’ or press 
the play button on the cuelist. 

Cuelist Audio Playback 
To add and play an audio file click on the ‘Audio Playback’ heading to open that 
section. 
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This property… does this… 

Browse Opens the ‘Select Audio’ window where you can 
choose an audio file. 

Clear Removes the audio file from the cuelist. 

Chase properties 
To set a cuelist to chase and adjust the chase properties click on the ‘Chase’ 
heading to open that section. 

This property… does this… 

Chase Enabled Turns chase mode on or off. 

Chase direction Sets the step order for chases. Can be set to 
forward, backward, bounce or random. 

Chase Tracking Turns tracking, within the cuelist on or off. For a 
chase tracking is normally set to ‘Not Tracking’. 

Chase rate Chase rate when in chase mode, expressed as steps-
per-minute. 

Chase crossfade % Proportion of time spent fading vs. time spent at 
each step of a chase. 

Playback rate BPM Playback rate for the cuelist. 

Midi Notes 
You can set a set a cuelist to be controlled by Midi Note messages sent from an 
external source. To do this: 

1. Open the cuelist in the editor. 

2. Select the Cue Properties option on the Edit menu. 

3. Select the ‘Midi Notes’ section of the Cuelist Properties window. 

This property… does this… 

Play Sets the Midi Note that will Play the next Cue in the 
Cuelist.  

Release Sets the Midi Note that will Release the Cuelist. 
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This property… does this… 

Play / Release Sets the Midi Note that will Play the next Cue in the 
Cuelist or Release the Cuelist if it is already 
playing. 

Flash Sets the Midi Note that will Flash the current Cue 
in the Cuelist.  Note that Flash will not play a 
cuelist unless it set to ‘autoplay’. 

Setting the Midi note. 
To set the Midi note you can either: 

· Click in the ‘Note’ field and select from the popup list, or 

· Click the ‘Learn’ button to open the Midi Learn window. You can then 
play a note on your Midi device and the note will be automatically 
entered. 

To clear the Note field click the [X] icon. 

Ü The Midi port and Channel number may need to be configured before you 
use Midi notes with your console or control surface. To do this see Midi input 
on page 2-12 

Cuelist property defaults 
The properties you set for a cuelist can be used as the default settings for all new 
cuelists. You can also reset a cuelist to the (factory) standard properties or your 
own show defaults. To do this click on the ‘Defaults’ heading to open that 
section. 

This property… does this… 

Reset to show defaults Reset all properties to the settings you have saved 
as the show defaults (see below).  

Reset to factory 
defaults 

Reset all properties to their standard (factory) 
settings. 

Save as show defaults Saves the current settings as a default for all new 
cuelists. 

Cuelist Notes 
You can add notes about a cuelist and these will display in the Playback window. 
To do this click on the ‘Notes’ heading to open that section. 
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The Timeline panel 
The main section of the timeline is used to control the crossfade times for all the 
features that you apply to your fixtures. Unlike other consoles where you can 
only see these times as numbers, in Vista you can see everything laid out on a 
timelines so you know exactly how when changes will occur in relation to each 
other. 

This panel includes: 
1. The default timing section where you set ‘master’ fade times for all feature 

types (Intensity, Position, Colour, Gobo, Beam, Misc). 

2. The detailed timing section where you can set individual fade times for 
every feature being used on your fixtures. 

3. The Filter bar that you use to limit the timeline display to just the fixtures or 
features or events that you want to work with. 

Default times 
At the top of the timing section there’s a timeline ruler that controls the over all 
fade times for all events in a cue – except the ones you explicitly set elsewhere as 
explained below. When you first open the Timeline (or Chooser) window the 
ruler will be in it’s collapsed form, as shown here: 

 

The ‘up’ time determines how long it will take for all feature types to fade from 
their previous value to the value in this cue. 

The ‘down’ time is only used for Intensity events where fixtures are fading out 
(i.e. getting darker or turning off). It determines how long it will take for 
Intensity to fade from their previous value to the value in this cue. 

To adjust the up or down fade time click on the on the end point of the bar and 
when the cursor changes to a double arrow drag to increase or decrease the time: 

 

To set a delay time click on the bar and when the cursor changes to a hand drag 
to move the bar so that it starts after the 0s mark of the cue: 

 

Ü You can also set the up and down fade time by typing in the Timing box. For 
example typing 3 / 4 sets the Up (or infade) time to 3 seconds and the Down 
(or outfade) time to 4 seconds. 

To expand the default times ruler, click on the arrow icon. 
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Expanded Default time view 
You can set individual  default fade times, delay times and fade curves for the 
different feature types (Intensity, Position, Colour, Gobo, Beam, Misc) in the 
expanded default time view.  

To do this: 
1. Click on the expand arrow at the left end of the ruler bar. Vista displays the 

expanded view: 

  

2. To adjust a feature type fade time click on the on the end point of the bar and 
when the cursor changes to a double arrow drag to increase or decrease the 
time. Or type a value in the corresponding ‘Time’ box. 

3. To adjust a feature type delay time click on the bar and when the cursor 
changes to a hand drag to move the bar so that it starts after the 0s mark. Or 
type a value in the corresponding ‘Delay’ box. 

4. To adjust a feature type fade curve click on the fade icon and select from the 
drop down list 

This icon… does this… 

 
Linear 

Sets the curve to a normal linear fade. The feature fades 
evenly from the old setting to the new setting over time. 

 
Damp 

The fade is slower at the start. 

 
Snap start 

The feature goes to the end state very quickly. 

 
Snap end 

The feature doesn’t change until the very end of the fade 
time. 

 
Square law 

The feature starts with a delay, then slides up to the end 
state. 
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This icon… does this… 

 
Inverse square 
law 

The feature starts quickly and the finishes slowly. 

 
Switch 

The feature goes to the end state very quickly. 

 
Hot power 

The feature goes to the end state very quickly. 

 
Flourescent 

Similar to linear, slower at end of fade. 

 
Sinus 

Similar to linear, faster at end of fade. 

Ü If you make any adjustment the default time for Position, Colour, Gobo, 
Beam or Miscellaneous that feature type will no longer be changed when 
you adjust the ‘Up’ fade time in the condensed timeline ruler.  

Saving and re-applying timing configurations 
When you’ve set up a set of default fade times that you like, you can save it so 
you can apply it to other cues.  

Saving timing sets 
To save a default timing set: 
1. Click on the arrow in the timing drop down box: 
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2. Click on the ‘Custom Timing’ option. Vista opens the Custom timing 
window: 

  

3. Adjust the feature type fade times using the timing bars or by entering 
values in the time and delay boxes. 

4. Click on the ‘Save as’ button. 

5. Enter a name for the timing set in the popup box and click OK. 

6. Click OK to close the Custom Timing window. 

Applying saved timing configurations 
To apply a timing set to a cue: 
1. Select the cue. 

2. Select the timing set you want from the Timing drop-down list. 

3. Vista applies the timing set to the cue. This will not change the timing of any 
event in the cue that has already adjusted in some way. 

Modifying the cue number, name and duration 
To change cue name, duration, and end of cue action of a cue, in the tiles or 
layout view: 
1. Select the cue with the pen or mouse. Shift-click or ctrl-click to extend the 

selection. 

2. Double click on number, name or duration field. The field switches to edit 
mode: 

 

3. Enter a new value and press Enter on the keyboard. 
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About the timeline 
The Vista uses a ‘timeline’ concept that will be familiar to you if you’ve used any 
modern sound or video editing software on a personal computer. When you 
store into a cue Vista creates an ‘event’ for each feature of each fixture that you 
use in the cue. The events are placed, on the timeline, in the cue you working on 
and when you add more cues they strung together in a cuelist. 

The idea is simple: you create a series of lighting ‘events’ that occur in sequence 
when you hit the ‘Play’ button. With the Vista you can move back and forth 
through this piece of time and edit any aspect of the events that occur, in much 
the same way as you could drag a tape back and forth across the play head of an 
analogue tape deck. 

Events on the Timeline 
The default timing section lets you set the timing for all the fixtures in a cue but 
when you want to make timing changes for individual fixtures or events you 
work in the timeline panel. When you select a fixture, in the editor and set 
Intensity, Colour or any other feature Vista creates a horizontal ‘event’ bar on the 
timeline. These are the commands Vista is sending to your  fixtures. 

The event bars represent the activities of those fixtures over time. As you can see 
in this example, the bars go from the ‘0s’ point on the timeline scale to the ‘2s’ 
point. This means that these fixtures are moving to a new setting over two 
seconds: 

 

The settings you’ve applied to these fixtures on the palettes (e.g. intensity, colour 
and position) control the fixtures themselves. The timeline simply tells those 
fixtures to accept those commands, and the event bar represents the length of time it 
will take those fixtures to get to the desired state.  

Once the fixtures get to that state they will stay like that until they receive 
another command telling them to do something else (e.g. change to another 
colour or fade out). 

By placing the event bars where you want them on the timeline you’re giving 
commands to those fixtures that tell them how long a parameter will take to fade 
in. The parameter is determined by the palettes; the timeline only controls when the fade 
starts and ends. 
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Using the summary views 
You can view the events on the timeline in several ways: 

· Summarised by feature, i.e. intensity, position and colour. 

· Summarised by fixture type. 

· Filtered by feature type (Intensity, Position, Colour etc) or Fixture type. 

· Filtered by fixture selection. 

· Filtered by fade path, event type and event timing. 

You choose these views from the Filter view drop-down menu at the left hand 
end of the ruler bar. You can also switch between the minimised/maximized 
setting of each summary view using the + and – buttons beside the feature or 
fixture names in the left column. 

Summary by feature 
This view shows a set of fixtures by their attributes: 

 

By default, the view shows each bar minimised. To expand each attribute and see 
the details, click the ‘+’ symbol beside the attribute name (e.g. ‘colour’). Vista 
displays the details of that attribute: 

 

Summary by fixtures 
The fixture type view shows the same information but sorted by fixture rather 
than attribute: 
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The default fixture view has all the features minimised. To expand each fixture 
bar and see the details, click the ‘+’ symbol beside the fixture you want to see. 
Vista displays the details of that attribute: 

 

To quickly expand all items right click in the left hand column and select ‘Expand 
all default items’ from the poup menu. 

Filtering the All Events view 
As well as displaying the Feature and Fixture views, you can also choose to filter 
out different classes of information on the timeline. To do this, choose an option 
from the list below the line in the View drop-down menu: 

 

When you choose a filter, Vista displays only those types of events. 

You can create your own filters to show only those combinations of events you 
want to see. To create a filter: 
1. Choose the ‘Custom View Filter’ option from the menu. Vista displays the 

Custom Filter window: 
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With this window you can filter by fixtures, event features and advanced 
options: 

This option… does this… 

View Type 
Fixtures 

Shows fixtures in the left column. 

View Type 
Features 

Shows feature types in the left column. 

All Filters the timeline to show All fixtures. 

Selected Fixtures Filters the timeline to show only the fixtures that are 
selected in the Chooser window. 

In the Current 
cue 

Filters the timeline to show only the fixtures that have 
programming in the current cue. 

With New 
Programming 

Filters the timeline to show only fixtures that have new 
have been edited since the cue was last saved. 

Groups Shows just the fixtures, in the groups that are ticked. 
This filter is applied after the other Fixture filters. 

Event Types Filters the timeline to show only the feature types that 
are ticked. Click on the ‘+’ sign beside a feature type to 
select just a subset of that feature. 
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This option… does this… 

Fade Path Filters the timeline to show only events that are (or are 
not) set to a particlular fade path (i.e. Linear, Snap, etc). 

Event type Filters the timeline to show only events that are (or are 
not) a particlular type (i.e. Preset, Release, Move in 
Black, etc). 

Event Timing Filters the timeline to show only events that are (or are 
not) set to: 
• Follow the default times. 
• A Zero fade time. 

 
2. Click on the ‘Save As’ button. Vista shows the ‘Save As’ window. 

3. Type a name for the filter. 

4. Click the ‘OK’ button. Vista adds this filter to the drop-down filter list. 

Managing your saved Filters 
You can rename, duplicate or modify a saved filter. To do this select the ‘Manage 
View Filters’ option from the Filter drop down list. Vista opens the Manage View 
Filters window: 

 

To modify one of the built in filters or a custom sort you’ve saved: 
1. Select the Filter name in the left-hand panel. 
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2. Modify the View type, Fixture selection, Event types and advanced event 
options. 

3. Click the ‘Save’ button. 

Renaming a Filter 
You can rename a sort by double clicking on the name, in the left column, and 
typing a new name. 

Duplicating a Filter 
To make a copy of a filter, select it and click on the ‘Duplicate’ button. 

Deleting a Filter 
To delete a filter, select it and click on the ‘Delete’ button. 

One click filters 
At the bottom of the timeline screen there is a set of filter buttons that provide 
quick access to four popular filters. 

    

This icon… does this… 

 All 
Shows all fixtures in the cuelist. 

 Selected 
Shows just the selected fixtures. 

 Cue 
Shows the fixtures in the current cue. Useful for 
removing ‘white space’ in the timeline. 

 New 
Shows just the fixtures with new programming. 

Zooming in and out 
At the bottom of the timeline screen there is a set of zoom buttons that let you 
control the size of the events in the timeline. 

 

This icon… does this… 

 All Zoom out to show more of the cuelist. 
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This icon… does this… 

 Selected Zooms in to show more detail. 

 Cue Zooms to show a single cue. 

 Zooms out to show all cues in the cuelist. 

 New Zoom to show the selected cue(s). 

Auto Toggles auto zoom on or off. This means that whatever 
cue is elected is automatically zoomed to fit the window. 

 

Ü The zoom options are also available on the View menu. 

The Editor Status bar 
Below the cuelist navigator there’s a status bar that shows details about the 
cuelist you are working on and the cue(s) that’s being edited and played. If you 
are editing a cue that is not the one that is playing an alert field also shows: 

 

 

In the status bar the fields show: 

· The Cuelist that is open in the editor, this field will correspond to the 
selected tab. 

· The Cue that is being edited, this field will correspond to the cue that is  
selected (highlighted)  in the Cue navigator bar. 

· The cue that is playing and contributing to the console’s output. This 
field only appears if you are editing a different cue to the one that is 
playing. 

Ü The cuelist and cue fields to the left of the Q-View button can be used to 
navigate between cuelists and cues or open a cuelist. To do this select either 
field and type a name or number. As you type Vista will show a list of 
matching cuelists or cue names. Press enter or tab to open or jump to the 
selected item. 

The buttons on the status bar control how the editor interacts with the console’s 
output and playback: 

This button… does this... 
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This button… does this... 

 

Link joins the editor and any playback (of the cue being 
edited) to the cue you're editing. 

This means that when you click on a cue, in the editor it 
will play. Likewise if you play a cue from the cuelist 
being edited it will change the cue selection in the editor. 

If you want to edit a cue without seeing it on stage ‘Link’ 
should be de-selected (selecting Q-View automatically 
turns Link off). 

If you turn Link off and select a different cue a red alert 
field appears in the status bar to show you the cue that is 
actually playing. 

 

Allows you to edit a cue that is not being played. When 
Q-View is selected the Chooser window is outlined with 
a yellow border. 

In Q-View selecting a different cue does not effect 
playback and Link will automatically turn off. This 
means you can make a change to an upcoming cue 
without changing the look on stage then click Link again 
to bring the editor back in line with the playback. 

 

Ü If Q-View is on, clicking on the cue tile that is playing will automatically turn 
Q-View off. 

The progress indicator 
When you hit Play, the blue line starts moving from left to right across the event 
bars in the timeline panel. This line shows where you are up to in this cue. If you 
hit Pause, the line stops wherever it is on the timeline; if you hit Play it starts 
from the same spot. 

Timeline events 
You can create any number of cuelists, each of which can consist of any number 
of individual lighting events. You can then combine these cuelists and ‘play’ 
them interactively to produce your overall lightshow. 
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Adding events to the timeline 
Whenever you store a cue, using ‘Store Look’ or ‘Store Part’ you create events on 
the Cuelist’s timeline. To work with those events and make timing adjustments 
you open the cuelist in the editor and select the ‘Timeline’ window. 
You can also create a new Cuelist, from scratch, in the editor and work with the 
events straight away. To do this: 

1. Click the ‘New’ cuelist  icon or select the ‘New’ option on the Cuelist 
menu. 

2. Select the  icon on the main toolbar to display the Fixture Chooser 
window. 

3. Choose the fixtures you want (or select a group of fixtures by clicking on one 
of the Group icons). 

4. On the Intensity palette, turn up their intensity to a level above zero. You can 
also set any of the other features, such as position and colour on the other 
palettes if you like.  

5. Select the Timeline  icon on the main toolbar at the top of the screen. Vista 
displays the timeline window with the features you used shown in the left 
column and the timing events for those features to the right. 

About the Event bars 
The timeline event bars are labelled and include graphics to identify their 
function and edit status. 

Feature summary event 
Feature events are coloured to indicate their type (Intensity, Position, Colour, 
Gobo, Beam or Miscellaneous). 

 

The event label shows: 

· The number of fixtures the event applies to. 

· The fade time. 

Feature detail event 
You can open a feature summary event by clicking on the ‘+’ button, beside the 
feature name in the left column. 
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The event label shows: 

· The event setting. In the example above the event shows the CMY 
settings and an icon of the colour. Not all event types include icons. 

· The fade time. 

Snap events 
Events that are set to a zero second (0s) fade time are shaped like a banner with 
an arrow at the left end: 

 

When you select a snap event there is only one selection handle (the aqua 
coloured square). When you click on the handle you can drag in either direction 
and once the event has a length a second handle will appear. 

Changed events 
Events that you’ve edited, since the cue was last saved, show with a hatched 
pattern: 

 

Moving events around 
Each event has three attributes: a start point, duration and a finish point. The 
event bars on the timeline show you where each event starts and finishes and 
how long it will take to reach its end point: 

 

To adjust the start or end point of an event, select the event and drag it along the 
timeline to the left or right. Note that the grid has an automatic ‘snap-to’ feature 
that makes it easy to align start and end points. To make fine adjustments hold 
Red modifier (Shift key) while moving the start and end points. 

To change the duration of an event, click on it and select the ‘handle’ (aqua 
square) on the right-hand end and drag it left to shorten the event, or right to 
lengthen it. 
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Note that in the example shown above three separate attributes of the event have 
different timings: 

· the Intensity event starts at 0s and is complete at 2s 

· the Position event starts at 0s and is complete by 1s 

· the Colour event starts at 0s and is complete at 1.5s 

· the Beam event starts at 0s and is complete at 1.75s. 

Working with selection handles 
A quick and easy way to create dynamic lighting effects is to ‘skew’ the events on 
the timeline. When you select a group of events, Vista displays a selection box 
around them with aqua /black squares on the corners and sides known as 
‘handles’: 

 

You use these handles to change the duration of the selected events. In this 
example, the Intensity events of a set of fixtures are selected. By selecting a 
handle and dragging it you can change the start or finish point of the selected 
events.  In the example above the fixtures will fade in over 1s. 

In the next example, we’ve selected the middle handle on the lower edge of the 
selection and dragged it right to fade the events over 2 seconds, offsetting the 
start and end fade times while retaining the 1 second fade time for the individual 
fixtures: 

 

Using the selection handles in this way you can utterly transform the attributes of 
the selected events with just a few quick clicks. You can also adjust any of the 
intensity, colour and beam attributes at any time while adjusting the timeline 
events. 

Making precise timing adjustments 
If you want to set the start and end times and durations of events to a precise 
point on the timeline you can either zoom right in and line them up visually, or 
enter the actual time values. 

Using the set timing window 
You can set event timing and optionally scale events using the ‘Event timing’ 
window. To do this you can either: 
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· Select the event(s) and select ‘Set Event Timing’ option from the 
Timeline menu, or 

· Double click on an event, or 

· Right-click on the event(s) and select ‘Set Event Timing’ option from the 
popup menu.  

Vista displays this screen: 

 

This option… does this… 

Start Select to set the start time of an event. 

Middle Select to set the mid point of an event. 

End Select to set the end time of an event. 

Time 

Start / Mid / End 

Enter a time to set the start mid or end of an event to that 
position on the timeline. If you enter a number with no 
units Vista assumes seconds. Use h for hours, m for 
minutes, e.g. 1h2m3.5s. 

Duration Enter a time to set the duration (or length) of an event(s). If 
you enter a number with no units Vista assumes seconds. 
Use h for hours, m for minutes, e.g. 1m2s. 

Scale Events Select this option if you want all selected events to be 
scaled when the duration is increased or decreased. 
Scaling is based on the longest event. If this box is not 
ticked all events will be set to the same duration. 

Aligning start and end points 
You can also align the start and end times of selected events. To do this, select the 
events and then select the ‘Align Start’ or ‘Align End’ option from the Timeline 
menu. 

You can also right-click on select the event(s) and select these options from the 
popup menu.  
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Resetting events to follow the default times 
When you adjust the time of an individual event it no longer follows the cue’s 
‘default times’. To reset an event so that it follows the default, select the event 
and choose the ‘Reset to default timing’ option from the Timeline menu. 

You can also right-click on select the event(s) and select these options from the 
popup menu.  

Setting the event fade curve 
Vista automatically selects the most suitable fade curve for each feature type but 
you can choose from a set of pre-defined fade path shapes to set how an event 
will progress.  

Select the ‘Fade Curves’ option from the Timeline menu or right-click on the 
event(s) and choose the Fade Curves option to display the fade path options: 

 

For more information on the available fade curves see fade curve on page 7-32. 

Ü Instead of making an event very short, you can just set it to Snap at Start.  

Creating Release events 
Sometimes it’s useful to have a cue release control of a feature. For example a 
cuelist might set some lights to point downstage in the first cue but in the second 
cue you want the lights to revert to whatever position they were in previously. 
To do this you need to store a ‘Release’ event(s) for the fixtures and features you 
want the cue to relinquish control of. 

You can also right-click on the event(s) and select these options from the popup 
menu.  

Muting events 
If you want to temporarily prevent an event from being played back you can 
‘mute’ it. To do this select the event(s) and choose the ‘Mute event’ option from 
the Events menu. The event bar will be greyed and when the cue is played the 
event will be ignored. 
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To un-mute an event choose the ‘Unmute’ event option from the Events menu. 

You can also right-click on the event(s) and select these options from the popup 
menu.  

Stopping effects overriding an event 
 ‘Baseless’ effects are designed to run on top of a feature setting. For example a 
baseless circle effect will cause fixtures to move in a circle around whatever 
position has been set in a cue. If you want to stop a baseless effect running on an 
event, right click on the event and select the ‘Stop free effects’ option.  

Using commands within cuelists 
Commands let you use a Cuelist to control the playback of one or more other 
cuelists. 

To insert commands within a cuelist: 
1. Open a cuelist in the programmer and choose the ‘Insert Commands...’ 

option from the Tools menu. Vista opens the Insert Command window: 

   

2. Select the command to insert from the Action column: 

This option… does this… 
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This option… does this… 

Play, Back, Pause, 
Assert, Skip Fwd, 
Skip Back, 
Release,  

Acts on the cuelist as if you had pressed the 
corresponding button on the playback controls for that 
cuelist. 

Flash Equivalent to pressing the flash button on a cuelist’s 
playback controls. You must also enter either ‘on’ to flash 
or ‘’off’ to flash in the Parameter box. 

Inhibit Inhibits (blinds) or un-inhibits the cuelist. You must enter 
either ‘on’ or ‘off’ in the Parameter box. 

Rate This field is a text field and only allows valid input (e.g. 
numerical BPM value). 

Release All Releases All active cuelists. No other options are 
available when this command is selected. 

Timecode reset Resets the timecode to 00:00:00:00. 

Timecode enable Sets a cuelist to be activated by Timecode. 

Jump Allows you to Jump to a specific cue within a cuelist. 

Snapshot Activates the snapshot selected in the parameter field. 

Release all except Releases all active cuelists except the one containing this 
command. 

 

3. Select the Cuelist to be triggered from the Target column.  

4. Enter an on or off command or cue number, if applicable, in the Parameter 
field.. 

5. The command will be placed at the beginning of the selected cue. If you 
want to put it at a different position you can drag the event to a different 
position.. 

6. Click ‘Insert’ to insert the command and close the window. 

Updating Presets and Cuelists during 
playback 
When you make changes in the Programmer Live tab while a cuelist is being 
played back, you can make those changes apply to the presets from which you 
constructed the cuelist, or just make the changes to the cuelist itself.  
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Ü Update is designed to change settings that are already in a Cuelist and does 
not automatically add new events or fixtures to a Cuelist, but you can open a 
Cuelist and add new information in the programmer window on the Update 
window. 

Existing information 
To update existing information: 
1. While a cuelist is playing, go to the Live tab in the Programmer window and 

select the fixtures you want to change. 

2. Make the adjustments you want using the palettes or hardware controls. 

3. Click the Update icon , or choose the Update option from the Tools 
menu. 

4. Vista displays the Update window: 

  

Here you can choose whether to apply the changes to Cuelists or Presets if they 
are in use. You can also filter the changes by fixtures and parameter. By default, 
Vista selects both presets and cuelists. 

5. To make the changes to all Fixtures in the Cuelist or Preset, click the ‘All 
fixtures’ button. To make the changes to just the selected fixtures click 
‘Selected fixtures’ button. 

6. You can use the parameter filter icons to select or de-select the features you 
want to include in the preset - Intensity, Position, Colour, Gobo, Beam and 
Misc. For more information about the parameter filter bar refer to Presets on 
page 6-46. 
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7. To apply the changes to presets, click the checkboxes beside the preset names 
in the Presets pane or, click the checkboxes beside the cuelist names in the 
Cuelists pane to apply the changes to one or more cuelist rather than to the 
presets.  

8. When you’ve defined how you want to apply your changes, click the OK 
button to return to the Programmer screen.
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8. SmartFX 

Effect types 
Vista provides several effect types: 

· Wave effects where Intensity or Colour or Position or any other feature 
of your lights follows a waveform. With this sort of effect you can create 
Intensity chases, Position shapes such as a circle and Colour mix effects 
including rainbows and more. 

· Swing effects where Intensity or Colour or Position or any other feature 
of your lights crossfade between presets or other IPCGBM settings. 

· Video effects that use an animated gif to control the Intensity and 
Colour of a group of fixtures – usually arranged in a matrix. 

Using effects 
To run an effect on your fixtures you can either: 

· apply one of Vista’s built in template effects, or  

· modify a template effect, or  

· create your own effects from scratch, using the SmartFX window. 

Applying a stored template effect 
To apply an effect: 
1. In the Fixture Chooser window, select the fixtures you want to use. 

2. Click the Components tab in the sidebar and select the FX button. Vista 
displays the list of available template effects: 

  

The icon indicates the effect type and letters in the ‘Content’ column show which 
features are in this effect: 
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This icon / letter… indicates this… 

 I 
An Intensity effect. 

 P 
A Position effect.  

 C 
A Colour effect.  

 Matrix / 
Multi-element 

An effect designed to run on a matrix (See Placing 
fixtures in a Matrix on page 6-11) or multi-element 
fixture (a fixture with more than one light source – for 
example a 4 cell ColourBlock).  

Multi-feature 
(i.e. IPC---) 

An effect that includes more than one feature. For 
example the ‘BallyColour’ effect. 

Ü If a template effect is greyed out it means that the template cannot be applied 
to the fixture type(s) you have selected. 

3. To apply an effect, click on the one you want. The effect you’ve chosen starts 
running on the selected fixtures. 

4. To adjust the speed and other settings of an effect, open the SmartFX 
window and use the controls to adjust it. See the following section. 

Using the SmartFX window to modify an effect  
To adjust the speed and other parameters of an effect, open the SmartFX tab in 
the sidebar by either: 

· Clicking on the SmartFX tab at the top of the sidebar, or 

· Clicking the SmartFX button on the main toolbar – usually F11, or 

· Selecting the SmartFX Editor option from the Tools menu (Ctrl + K). 
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The SmartFX has two panes: the effects list, at the top and effect controls below: 

 

The Effects list 
The top pane normally shows ‘All 
effects’. You can filter the list by 
clicking on the ‘Show…’ field and 
selecting from the following options: 

· Selected Cuelist. 

· Editor. 

· Selected Cue. 
You can filter the list further by: 

· Whether they are active. 

· The fixtures they are being 
applied to. 

 

 

This option… does this… 

Source 

Popup selector 

The source popup filters the effects list by source: 

· Show All..  includes all effects 

· Selected Cuelist includes just the effects running 
on the Selected Playback 

· Editor includes effects running in the Live tab 
and any Cuelists (tabs) that are open in the 
Editor 

· Selected Cue includes effects running in the 
selected cue in the Cuelist being edited. 

Active only Filters the effects list to only show effects that are 
being played – that is the ones you can see on stage.  
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This option… does this… 

Selected Fixtures Filters the effects list to only show effects that are 
being run on the selected fixtures.  

New Effect Creates a new effect with your own settings.  See 
Creating an effect from scratch on page 8-12 

Save as template Click this button to save the effect as a template that 
will appear in the Components list and Quickpickers. 

When you click on an effect in this list, Vista displays the settings and controls 
for this effect in the right hand pane. 

Effect controls 
The SmartFX Control Panel contains: 

· Rate controls that apply to all feature types in your effect. 

· Feature type  tab(s) (IPCGBM) with controls for the effect waveform, 
size, rate multiplier, and direction. 

· A Sequence tab with controls for fixture overlap, sorting, spread and 
ganging. 

· An Advanced tab, where you can add additional effects and synchronise 
or offset the effect waveforms. This tab is also used to set how the effect 
interacts with other cues and effects during playback. 

Rate control 
Effects can include one or more feature types (IPCGBG). The rate controls apply 
and are common to all features in the effect. 

 

This option… does this… 

Rate (BPM) Sets the base rate at which the effect runs, expressed 
in beats-per-minute (BPM).  
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This option… does this… 

Rate popup: 

· per cycle 

· per fixture 

This control affects whether the Rate is based on 
cycles-per-minute or fixtures-per-minute: 

Per-cycle - if the effect is an intensity chase at a Rate 
of 20 BPM Per-cycle, then the whole sequence will 
repeat 20 times each minute. 

Per-item - if the chase is at a Rate of 80BPM per-item, 
then the chase will cover 80 fixtures each minute. The 
loop time of a per-fixture effect varies with the 
quantity of fixtures used, and is slower with more 
fixtures. This means the fixture-to-fixture rate will be 
constant no matter how many fixtures are used. 

Enabled This checkbox disables or enables the selected effect. 

The Feature tab(s) for ‘Wave’ effects 
Effects can include one or more feature types (IPCGBG). Vista creates a feature 
tab for each type with controls for the effect waveform, size, rate multiplier, and 
direction. 

 

Click on the feature tab (i.e. Intensity) to see the controls: 

Ü The feature tab(s) will not appear unless the effect is selected in the left pane. 

This option… does this… 
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This option… does this… 

Size 

(was Amplitude) 

Size affects how much of the effect waveform is 
added to the feature. For example if you run an 
Intensity wave effect, set to size 50%, on a set of 
fixtures they will modulate between 0 and 50% 
intensity. 

For effects that run on more than one channel (i.e. 
Position and Colour mix) there is a separate size 
control for each channel. 

For swing effects there are no size controls since only 
a value of 100% will reach the endpoints.  

Rate 

(was Rate Multiplier) 

To maintain synchronization between the features of 
an effect you can scale the rate for each feature as a 
multiple of the base rate.  

To make a feature run slower than the base rate set 
the feature rate to lower value (e.g. x½ or x¼ ).To 
make a feature run faster than the base rate set the 
feature rate to a higher value (e.g. x2 or x4 )  

Direction Mainly useful for chasing effects, this controls 
whether fixtures are sequenced in ascending 
(forward), descending (backward) or both directions 
(bounce). 

 
Base tab 

Waveform buttons 

This tab shows the available effect waveforms, in 
graphical form. To select a waveform click on one of 
the buttons. 

When multiple waveforms are being used the 
buttons show the effect that will be created. For 
example: 

· Position – shows buttons for creating shapes 
including a Circle, Square, Can-can, Triangle, 
Figure 8, Spiral, Bally Hoo and Spread circle. 

· Colour Mix – shows buttons for a Rainbow 
wave, RGB, CMY and more. 

Base tab 

Visual editor 

Below the waveform buttons, Vista displays a 
preview of the waveform(s) in the effect. For position 
and colour effects this section also provides size 
controls for each of the feature waveforms. For 
example a position effect has one waveform 
operating on Pan and another on Tilt. 

You can change the offset of the waveform(s) by 
clicking in the preview window and dragging the 
waveform to the left or right. 
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This option… does this… 

 
Customise tab 

On this tab you can select the waveform type and the 
phase offset of the waveform. For position and 
colour effects, that operate on more than one channel 
there is also a waveform, rate multiplier and phase 
offset control for each channel. 

 

The Feature tab(s) for ‘Swing’ effects 
For swing effects there are no size controls since only a value of 100% will reach 
the endpoints. Likewise there is no direction control because ‘swing’ effects are 
designed to bounce between endpoints. 

 

Ü The feature tab(s) will not appear unless the effect is selected in the list pane. 

This option… does this… 

Stop Clicking on a ‘Stop’ icon pauses the swing effect so 
that you can set a value for the feature. To set a value 
choose a preset or set a value in the sidebar palette 
windows. 

Beats Sets the number of beats the effect will remain on 
each point before fading to the next point. 

Feature Shows the type of features included in the swing 
points. 

Value Shows a value or graphical representation of the 
setting for the swing point. 
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This option… does this… 

Curve Sets the fade curve to the swing point. 

Run effect Click the ‘Run effect’ button to start the swing effect 
running if it has been stopped. 

 Click the + (Plus) button to add a swing point. 

 Click the - (Minus) button to delete the selected 
swing point. 

 

The Sequence tab 
When you apply an effect to a number of fixtures you can use the controls on the 
sequence tab to set how the effect is applied to those fixtures. 

 

This option… does this… 

Overlap Affects how much each fixture overlaps the next 
when the effect is running:  

· At 0% each fixture runs the effect sequentially 
– there is no overlap 

· At 100% each fixture executes the effect 
simultaneously. 

This control works in conjunction with Spread to 
achieve synchronized chases & wave effects. 
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This option… does this… 

Stagger Vista dynamically calculates a waveform offset 
value for each fixture depending upon this control: 

· Stagger = 0% - all fixtures have a uniform 
offset  

· Stagger = 100% each fixture has a unique offset 
ranging from 0% to 100%. 

Normally this control will be left at 100% unless the 
Overlap control is at 100%, otherwise there will be 
periods when all fixtures will appear to be at rest. 

Order When an effect runs you can sort the fixtures in a 
number of ways: 

· ID sorts the fixtures by number order. 

· Selection sorts based on the order in which you 
selected them in the Chooser. 

· Random sorts the fixtures in a random order. 

· Position sorts the fixtures by their position on 
the Fixture Chooser layout. Fixtures are sorted 
from top left to bottom right. 

To reverse the sort order click on the drop down 
box and choose either ‘Ascending’ or ‘Descending’. 

Fan Curve Sets the distribution of fixtures, along the effect 
waveform. The normal setting is ‘Linear’and in this 
case the fixtures are evenly distributed. Other 
curves, such as square and inverse square will 
bunch some of the fixtures together and spread 
others out. 

Spread Shape 

 

The spread shape buttons control how the effect 
runs across the fixtures. There are 4 spread shapes 
available: 

· First to last. The effect starts on the first fixture 
and runs to the last. 

· Pairs, outside to inside. The effect starts on the 
2 end fixtures and into the centre. 

· Last to first.. 

· Pairs, inside to outside. The opposite of 3. 
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This option… does this… 

Multi-element fixture 
options 

When an effect runs on multi-element fixtures you 
can either: 

· Group all elements together and treat the 
fixture as a single unit or, 

· Run the effect across the individual elements of 
the fixture. 

Fixture Ganging 

Blocking 

Sets how the set of fixtures are grouped together. 
‘No Blocking’ indicates that the effect runs across 
the fixtures one at a time.  

Fixtures can be ganged so that two or more fixtures 
are doing the same thing. For example:  

· When set to 2, adjacent pairs of fixtures are 
ganged together in the effect. 

· When set to 2/1/3 for a set of 12 fixtures 
they’d be ganged in a pair, then a single, then 
threes. 

Fixture Ganging 

Repeats 

Allows non-adjacent fixtures to be ganged together. 

· a repeat of 2 sets every third fixture to be doing 
the same thing. 

· a repeat of 3 sets every fourth fixture to be 
doing the same thing. 

The ‘Preview’ panel shows how the fixtures will be 
ganged together. 

Preview Current 
Selection 

Click this button to show the fixture selection for 
this effect in the Chooser window.  Red order 
numbers appear on the fixture icons. 

Change Fixture 
Selection 

Click this button to update the effect fixture 
selection to match the order you set  in the chooser 
window. 

 

The Advanced tab 
This tab is used to: 

· Synchronise or offset the effect waveforms when there is more than one 
feature in an effect – for example an effect that includes both Intensity 
and Colour features. 

· Set how the effect interacts with other cues and effects during playback 

· Save an effect you’ve modified or created to the list of template effects. 
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This option… does this… 

Offset 

(Phase offset) 

Adjusting the Offset value, rolls the waveshape 
within its own window. For example a 0% Phase 
offset for a sine waveform would start and end at 
the midpoint while a 25% Phase offset would have 
the sinusoid start & end at the high point. 

You can adjust the offset of a feature by either 
dragging in the waveform window or entering a 
value between 0 and 360 in the offset field. 

+ Add Click the + icon to add a new effect type that is 
synchronised with the other features(s) in this 
effect. 

- Delete Click the - icon to delete the selected effect feature. 
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This option… does this… 

Basepoint 

 - Bound 

 - Free 

Sets what happens when fixtures that are running 
an effect receive a new setting for the same feature 
type. For example if a circle position effect is 
running on a set of fixture and a cue runs that sets 
those fixtures to a different position. 

If the basepoint is set to Bound the effect stops 
running. 

If the basepoint is set to Free the effect continues to 
run but will take it’s basepoint from the new event. 

If the ‘Don’t use own basepoint’ box is ticked, the 
effect will only run on a basepoint from a different 
event. 

Sync at Start Sets what happens as this effect starts when another 
effect is already running. 

Auto-sync the effect starts on the same phase as the 
already running effect 

Restart the effect always starts at it’s 0 point and so 
will always look the same when it starts. 

No-sync . The effect runs does not synchronize. 

Creating an effect from scratch 
To create your own effect: 
1. In the Programmer Fixture window, select the fixtures you want. 

2. Click the SmartFX button on the main toolbar or choose the ‘SmartFX Editor’ 
option from the Windows menu. Vista displays the Smart Effects window. 

3. Click the New button, at the bottom of the left pane, to display the Create 
Effect window. 

4. Click on one of the effect type buttons. Vista provides several effect types: 
· Wave effects where the setting for Intensity or Colour or Position or any 

other feature follows a waveform. 

· Swing effects that that move between two or more presets or IPCGBM 
settings. 

· Video effects that use an animated gif to control the Intensity and 
Colour of a group of fixtures – usually arranged in a matrix. 

5. Choose the Feature type you want to use in the effect  (e.g. intensity, or 
position or colour). 

6. ‘Type a name for your effect in the ‘Name’ box. 
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7. Click OK display your effect in the SmartFX window. 

8. Adjust the controls in the right hand panel of the window to apply the effects 
you want. 

Making your effect swing 
If you chose the ‘Swing’ button in the Create effect window, you have to define 
the end points of the effect (i.e. where it starts and where it finishes).  

In this case, when you click OK, Vista adds two swing points in the feature tab of 
the SmartFX window. 

To set values for the two points: 
1. Click the first  ‘Stop’ button. 

2. Use either presets, the palettes or the controls to set a value for the feature 
type you are using. 

3. Click the second ‘Stop’ button and define its settings in the same way. 

4. Click the ‘Run Effect’ button to start the effect swinging. 

Swing effects always have two end points but you can add more, intermediate, 
points to build more complex effects. Click on the + button to add another point. 

Saving your effect 
To save an effect you’ve created: 
1. Click on the ‘Save Template’ button. Vista displays a window asking for a 

name and location for the effect.  

2. Type a name for the effect and choose where to save the effect. You can save 
the effect in either the Factory or User or Show folder. Saving the effect in the 
Show folder makes it easier to transfer the effect between different consoles. 

3. Click on the OK button. Vista adds your effect to the list of effects. Next time 
you click the FX button on the Sidebar Components tab, your effect will be in 
the list. 
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Stopping an effect 
There are two ways to stop an effect and have the fixtures revert to their original 
or default values for the feature(s) that were running in the effect: 

· you can stop all effects that are running, or 

· you can stop just a particular effect, or 

· you can stop just particular effect type. 

Stopping all effects 
To stop all the effects that are running on your fixtures.  

1. Select the fixtures that you want to stop the effect running on. 

2. Choose the ‘Stop SmartFX’ option from the Tools menu. 

Stopping a particular effect(s) 
To stop one or more of the the effects that are running on your fixtures.  

1. Select the fixtures that you want to stop the effect running on. 

2. Click the SmartFX button on the main toolbar – usually F11, or select the 
SmartFX Editor  option from the Tools menu (Ctrl + K). 

3. Select the effect you want to stop from the list of effects. 

4. Click on the Disable button. 

Stopping effect running on a feature 
To stop effects that are running on a feature type – i.e. Intensity, Postion, Colour 
etc.  

1. Select the fixtures that you want to stop the effect running on. 

2. Click on the Palettes tab, in the sidebar, if it’s not already selected. 

3. Click on the feature type icon for the effect type you want to stop – Intensity, 
Position, Colour, Gobo or Beam. Vista opens a popup menu: 

  

4. From the popup menu select the ‘Stop Effect’ option. 
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9. Assigning Audio to a Cuelist 
You can assign an audio track to a cuelist or cue and play it in Vista. This can be 
useful if you want to programme for a particular piece of music or dialogue. 

To assign an audio file to a Cuelist 
1. With the cuelist open in the editor select the ‘Cuelist properties’ option from 

the Edit menu or, right click on the Cuelist icon in a Quick picker and select 
the ‘Properties’ option from the popup menu. Vista displays the Cuelist 
properties window: 

 

2. If it’s not already open click the arrow to open the ‘Audio Playback’ section. 

3. Click the browse button and navigate to the folder containing your audio 
files, select a track and click the Open button. Vista copies the audio file to 
the ‘Audio’ folder inside your Vista Data showfile folder. 

4. Click OK to close the Cuelist properties window. 

When you play this cuelist Vista plays the selected audio track with it but will 
only continue playing for the overall time of the Cuelist. To be able to hear the 
entire track you may need to add or lengthen cues. 

To assign an audio file to a specific Cue 
You can also assign audio to a single cue in Vista. This can be useful to play  
sound effects or short pieces of audio. To do this: 

1. With the cuelist open in the editor select the Cue then select  ‘Cue properties’ 
option from the Edit menu or, right click on the Cue tile and select the ‘Cue 
Properties’ option from the popup menu. 
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2. Follow steps 2 – 4 as above. 

Using Learn Timing to adjust cue timing 
You can programme a Cuelist then use the ‘Learn timing’ window to adjust the 
Cue start times based on your actions. This can be useful if you want to fine-tune 
Cue timing to an audio or video track. 

Using Learn Timing 
1. Open the Cuelist you want to use. 

2. Select the ‘Learn timing…’ option from the Tools menu. Vista opens the 
Learn Timing window: 

 

3. To keep the existing timing for cues tick the ‘Preserve Cue Duration’ 
checkbox. If this box is not ticked all cues (and their events) will be 
compressed to match the time between cue start times. However cue times 
are never lengthened. If the time between cues is longer than the existing 
time a delay time is added to the start of the cue. 
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Adjusting cues to timecode 
4. If you want to learn timing based on a Timecode source tick the ‘Enable 

Timecode’ checkbox. Vista will then display the Timecode viewer (and 
controls if you are using internal timecode). If you are not using timecode 
leave this box unchecked. 

Adjusting cues based on audio or video 
You can adjust cue timing to match the audio in a cuelist or while you are listing 
to or watching a recording. To do this: 

1. Click the skip to start button , in the Learn Timing window, twice to 
ensure you are at the start of your first cue 

2. When you are ready, click the play button , in the Learn Timing window 
or the Super Playback Play button, to set the start time of the first cue. If you 
have enabled timecode the timing field of the first cue will be automatically 
changed to a timecode type. If you are not using timecode the start of the 
first cue will be set to Halt. 

3. Continue to press the play button whenever you want the next cue to start. 
All subsequent cues are automatically set to ‘Follow’ mode with their start 
time adjusted in relation to the previous cue. 

4. When you are finished click the Done button to close the learn timing 
window. 

Vista automatically changes the cues start action to ‘Follow’ and adjusts the start 
time in relation to the previous cue. To see how your cues will playback in 
relation to the timeline and each other, click the  ‘View cues in layout mode’ 
button. 

 

Ü Tip: When you use ‘Learn timing’ with Timecode, Vista sets the first cue to 
start at a Timecode and then uses Vista’s internal clock to start the following 
cues. If you want every cue to be set to timecode mode you can change all 
the Follow cues convert their start times to Timecode. To do this: 

1. Select all the ‘follow’ cues by shift clicking in the cue tile view. 

2. Select the ‘cue properties’ option from the Edit menu. 

3. If it’s not already open click the triangle button beside the Timing option. 

4. Click on the green Follow  icon and change it to Timecode 
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10. Automating Playback 

Using Timecode to control Cuelists 
You can use Linear Time Code (LTC) or Midi Time Code (MTC) to trigger cues. If 
you are going to be running Vista in conjunction with a device that generates 
LTC (aka SMTPE) or MIDI  timecode, you can also simulate the timecode so you 
can get your show running without needing the actual timecode from the other 
device. 
To set up Vista to receive timecode: 
1. Choose the Timecode option from the File menu. Vista displays the timecode 

properties window: 

 

2. Set the Timecode source. The options are Linear Time Code (LTC), MIDI 
Time Code (MTC) or Vista’s Internal clock 

3. Set the Frame rate from the drop down menu. 

4. Set the Timecode Offset if required. The offset time is added to the incoming 
timecode. For example if the offset is 01:00:00:00 (1hr) and the incoming 
timecode is 00:00:10:00 (10 secs) Vista will treat it as though 01:00:10:00 (1hr 
10secs) is received. 

5. The Playback Lag compensation field is used to compensate for slow data 
transmission. If your cues are not running at the expected time you may 
need to enter a value in this field. For example entering 0.5s will mean that 
all your cues run half a second earlier than programmed. 

6. The Freewheeling time field is used to cope with dropouts or errors in the 
timecode coming from an external device. This field sets the number of 
seconds Vista will allow to pass while it simulates timecode and until it 
relinquishes control. 
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7. Hit the OK button to open the timecode window. If you are using an external 
timecode source this window will display the timecode being received. If 
you have set the source to ‘Internal’ the window will also show the internal 
timecode control buttons: 

             

This button… does this… 

Arm all Cuelists Sets the Timecode ‘Armed’ preference 
on all cuelists to ‘On’. 

Settings Opens the Timecode Properties 
window (see the previous section). 

 

Controls the internal timecode 
playback. Rewind to start , Play, Pause 
and Skip to end buttons. 

 

Moves the timecode to the time shown 
on the button. To change the setting, 
right click on the button and enter a 
new time in the popup window. 

 

Opens the ‘Locate to Time’ window 
where you can enter a time in Hours 
Minutes, Seconds & Frames.   

 

8. To close the window, click the ‘X’ symbol in the top right corner. 

Ü To disable timecode for all cues, choose the Disable option from the 
Timecode source drop down. This can be useful is you want temporarily to 
stop timecode from triggering your cuelists. 
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Adjusting the Timecode on multiple cues 
You can adjust the timecode settings for an entire cuelist by either setting an 
explicit timecode to start, or an amount of time to move all the cues by. To do this 
either: 

· Select the ‘Set Cuelist Timecode’ option from the Tools menu, or 

· Right-click on a cuelist in the playback window and choose 'Set 
Timecode Start’. 

Vista opens the Cuelist Start Timecode window: 

 

This field… does this… 

New Start Time Sets the timecode start time for the cuelist . 

Move Cuelist by Adjusts the timecode for each cue by the time 
entered. Negative values cannot be used. 

 

Using Date and Time to control cuelists  
You can set Vista to automatically play cuelists, trigger snapshots and more 
based on the date and time. 

Managing date and time events 
You can add, delete, edit, duplicate or test date and time events. To do this select 
the ‘Date and Time events…’ option from the Tools menu. Vista opens the Date 
and Time Events window: 
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This window displays a list of all your Date and Time events.  

This option… does this… 

New Opens the ‘New Date and Time Event’ window 
where you can set up an event to be triggered based 
on the date and time. 

Delete Deletes the selected event. 

Edit Opens the selected event so that you can modify it’s 
settings. 

Duplicate Duplicates the selected event. 

Test Now Click this button to test the event, no matter what 
the current time is. 

Global Enable You can disable all date and time events by un-
checking this box. 

Close Closes the window. 

Setting up a new date and time event 
To set up events that will be triggered based on the date and time, choose the 
‘Date and Time events …’ option from the Tools menu. Vista opens the Date and 
Time Events window 

This option… does this… 

New Opens the ‘New Event’ window where you can set 
up an event to be triggered based on the date and 
time. 

+ Add Click the + icon to add a new effect type that is 
synchronised with the other features(s) in this 
effect. 

Delete Deletes the selected event. 

Modify Opens the selected event so that you can modify it’s 
settings. 

Duplicate Duplicates the selected event. 

Checkbox If the checkbox beside an event is NOT ticked the 
event will not be activated. 
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This option… does this… 

Global Enable You can disable all date and time events by un-
checking this box. 

 

 

Disabling all date and time events 
You can also disable all date and time events by choosing the Disable All 
Time/Date Events option from the Vista menu. This can be useful is you want 
temporarily to stop events being triggered. 

Creating a New Event 
Date / Time events can automatically control playback and other actions. To 
create a new event: 
1. Choose the New Event... option from the Date/Time Events window. Vista 

opens the New Event window: 

 

2. Select the command to insert from the Action column: 
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This option… does this… 

Play, Back, Pause, 
Assert, Skip Fwd, 
Skip Back, Release,  

Acts on the Cuelist as if you had pressed the 
corresponding button on the playback controls for 
that clip. Select the Cuelist from the Target column. 

Flash Equivalent to pressing the flash button on a 
Cuelist’s playback controls. You must also enter 
either ‘on’  ‘off’ or ‘toggle’ in the Flash enabled box 
to set the flash button action. 

Inhibit Inhibits (blinds) or un-inhibits the clip. You must 
also enter either ‘on’  ‘off’ or ‘toggle’ in the Inhibit 
enabled box to set the flash button action. 

Rate The Rate field is a percentage field and only allows 
valid input (e.g. numerical % value). 

Release All Releases All active Cuelists. No other options are 
available when this command is selected. 

Timecode reset Resets the timecode to 00:00:00:00. 

Timecode enable Sets a Cuelist to be activated by Timecode. 

Jump Allows you to Jump to a specific Cue within a 
Cuelist. You can select a cue from the popup menu 
in the Cue field. 

Snapshot Loads the snapshot selected in the Target box. 

 

3. Select the Cuelist to be triggered from the target column. 

4. Enter an on or off command or rate setting or cue number, if applicable, in 
the option field. 

5. Type a label for the Event in Name box. 

6. Set the time of day, to trigger the event, in the Time box. The time is 
displayed as a 12 hour AM/PM clock. 

7. If you want an event to repeat periodically, check the Repeat box and specify 
the number of times to repeat and the Interval (in minutes), between 
repetitions. 

8. Select the days of the week you want the event to run on by ticking the check 
boxes. 

9. If you want an event to only be activated after a certain date tick the Start 
Date box and specify the date when the event should first be triggered. 
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10. If you want an event to stop running after a certain date tick the End Date 
box and specify the date when the event should last be triggered. 

11. Tick the Enabled checkbox to activate the event. If this box is not ticked the 
event will not run. 

12. Click the OK button to save the event. 
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11. The Playback Control Window 

Controlling and monitoring playback 
When you’ve got a full show going it’s likely that you’ll have multiple Cuelists 
on the console and being played back.  

 
To see what’s going on at any time, click the Playback Control button on the 
main toolbar at the top of the screen. Vista displays the Playback Control 
window: 

 

This screen lists all the cuelists that are playing and gives you a handy point from 
which to control and edit them. The window is made up of two panes that can be 
resized by clicking on the vertical dividing line and dragging the divider to the 
left or right. 

Cuelist pane 
The left side of the screen displays a list of all Cuelists and can display up to 
twelve columns that show playback status and some Cuelist properties.  

This column… indicates… 

Cuelist Name The name of the Cuelist. 
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This column… indicates… 

Current Cue Shows the current Cue name and number. Cuelists 
that have not been run show the first Cue name. 

Status The Playback State of the cuelist, including: 

 - HTP set on  

- On Playback.  The Cuelist is on a playback control. 

- SMPTE timecode locked. 

- Audio. 

- Inhibited. 

Active Shows if the Cuelist is playing or has been played. 

Priority Shows the priority of the Cuelist. 

Programming Shows the features (Intensity, Position, Colour, 
Gobo, Beam) programmed in this cuelist. 

HTP Shows the ‘HTP Intensity’ property setting. 

Release Time Shows the Cuelist’s release time. 

Inhibited Shows if a Cuelist has been inhibited (made blind). 

Notes This column is for notes and comments. To add a 
note click, double click on the notes cell. 

 

You can change the setting of a cell by double clicking on the cell and either 
selecting from a list of options or entering a new value. You can also right-click 
on the cell to open an editing window for that cell. Not all cells are editable. 

You can sort the Cuelist list by clicking on any of the column headings. For 
example to show all the Cuelists that are on playback controls, at the top of the 
list, click on ‘On Playback’. Click the column heading again to reverse the order. 

You can resize columns by clicking between the headings and dragging the 
column to suit. To show or hide columns right-click in the Cuelist pane and select 
‘Show/Hide fields’ from the popup menu. 

Cue pane 
The right column shows the Cues in the Cuelist selected in the left column and is 
divided into six columns that show Cue detail and progress: 

This column… indicates… 

ID Shows the Cue number. 
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This column… indicates… 

Cue Shows the Cue name. 

Programming Shows the features types programmed in this cue. 

 Click this button to play the cue. 

Progress Provides a visual display of the Cue’s progress and 
Shows the progress of the Cue as a percentage. 

 Click this button to skip to the end of the cue. 

Time While playing shows the elapsed time and time 
remaining I.E. 1/5 - Elapsed time is 1 second. Time 
remaining is 5 seconds 
While not playing shows the total fade time. 

Follow Action Shows how the cue starts. 
Start – the Cuelist starts ‘n’ seconds after the start of 
the previous cue 
End – the Cuelist starts ‘n’ seconds after the end of 
the previous cue 
Wait – the next Cue will play when Go is pressed 

Follow delay Shows the delay time for the ‘follow action’ 
described above. 

Notes This column is for notes and comments. To add a 
note click, double click on the notes cell. 

 

Control and Playback buttons 
You can use  playback button toolbar to control one or more Cuelists. To show or 
hide the playback buttons choose the ‘Playback Control’ option from the 
Toolbars submenu on the View menu : 

This button… does this… 

 
Jumps to the start of the Cuelist. 

 
Cues backwards to the previous Cue marker of the 
selected Cuelist. 

 
Pauses playback of the selected Cuelist(s). 

 
Commences (Go) Playback the selected Cuelist(s). 
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This button… does this… 

 
Cues forwards to the next Cue of the Cuelist. 

 
Jumps to the end of the selected Cuelist. 

 
Releases the selected Cuelist – fixtures return to their 
previous settings. 

Filtering the cuelists 
If the ‘Only show active cuelists’ button is highlighted only cuelists that are being 
played will be shown in the left pane. You can also set the this option on or off 
from the  View menu. 

Auto Scroll 
If the ‘Auto Scroll’ option is highlighted you the cue panel will scroll to keep the 
current cue visible. You can also set the this option on or off from the View menu. 

Dragable playhead 
If the ‘Dragable Playhead’ option is ticked, in the View menu, you can control a 
Cuelist’s playback by clicking on the overall progress  bars. You can also set the 
this option on or off from the View menu. 
 

 

Click or drag anywhere in the  bar to jump to that point. 

If the ‘Dragable Playhead’ button is highlighted click on it (so it is de-selected) to 
prevent accidental triggering of Cue . 

Search 
You can search for a cuelist or cue by clicking on the corresponding search 
button.  You can also do this by choosing the ‘Search’ option from the View 
menu. 
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Editing in the Playback control window 
There are two ways you change Cue names, times and end-of-Cue actions from 
within the Playback control window. You can: 

· Double-click on the Cue Name, Time, At End setting or Notes field and 
edit the field directly. 

· Right-click on the Cue Name, Time, At End setting or Notes field and 
select the ‘Edit field of selected Cue(s)’ option from the popup window. 

To edit a field directly 
1. Double-click on the Cue Name, Time, At End setting or Notes field. 

2. Choose from the list of options or enter a new name, time etc. 

3. Press the Enter key or click away from the field. 

To use the Edit field window 
1. Select one or more Cues. You can select a range of Cues by using the shift or 

control key. 

2. Right-click in the field that you want to change and select the edit option. 
Vista opens the Edit field window. 

3. Enter a new name, time etc. 

4. Click the OK button. 
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12. Using the console hardware 

Console layout 
Vista consoles and control surfaces provide the faders, encoders, switches and 
displays you’ll need to control your lighting rig. The layout of each product is 
slightly different and the quantity of playback controls varies. 

L5 Console 

 
The L5 console features: 

· LCD Pen/Tablet module that includes, the Grand Master & DBO, 12 
Function buttons, 2 sets of modifier buttons, a keyboard & trackpad 

· 2 Playback modules with faders 

· 2 Playback modules without faders 

· 1 Superplayback/Programming module. 

T4 Console 
The T4 (discontinued) console features: 

· LCD Pen/Tablet module that includes, the Grand Master & DBO, 12 
Function buttons, 2 sets of modifier buttons, a keyboard & trackpad 

· 4 Playback modules with faders 

· 2 Playback modules without faders 

· 2 Superplayback/Programming modules. 
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T2 Console 
The T2 (discontinued) console features: 

· LCD Pen/Tablet module that includes, the Grand Master & DBO, 12 
Function buttons, 2 sets of modifier buttons, a keyboard & trackpad 

· 2 Playback modules with faders. 

· 1 Playback module without faders. 

· 1 Superplayback/Programming module. 

I3 Console 
The I3 console features: 

· 2 Playback modules with faders. 

· 2 Playback modules without faders. 

· 1 Superplayback/Programming module. 

S3 Control Surface 
The S3 control surface features: 

· 2 Playback modules with faders. 

· 2 Playback modules without faders. 

· 1 Superplayback/Programming module. 

S1 Control Surface 
The S1 control surface features: 

· 1 Playback module with faders. 

· 1 Superplayback/Programming module. 

M1 Control surface 
The M1 control surface features: 

· 1 Playback module with faders. 

Grand Master and DBO 
The rotary Grand Master control scales the intensity of all output from the Vista 
system.  

The Dead Black Out (DBO) button takes all intensity to 0%, while it is held down.  
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Function keys 
The function buttons provide quick access to many commands and functions. 
The buttons are user configurable so you can assign functions you use frequently 
and have access to function at the press of a button rather than having to choose 
the option from a menu or icon.  

The number and location of the function buttons varies from console to console: 

· L5, T4 and T2 consoles  have 12 buttons located above the main display 

· I3 consoles have 6 buttons located at the top centre of the console 

· S3 control surfaces have 5 buttons located at the top centre of the console 

· S1 control surfaces have 6 buttons located below the GM & DBO 
controls 

· M1 control surfaces do not have function buttons. 
Your keyboard Function keys ‘F1 – F12’ can be used in place of these buttons. On 
the Vista PC version, the Function keys ‘F1 – F5 or F1 – F12’ can be used in place 
of these buttons. 

To assign a function to one of the buttons: 
1. Click the Console button to display the Console screen. The function keys are 

at the top of the Console screen. 

2. Right-click on a button and select a command from the popup menu. 

The modifier keys 

The LR key (L and T series consoles only) 
The LR button changes a pen tablet tap to a right tap. To ‘right-click’ hold this 
button down then tap the pen. 

The coloured modifier keys 
The coloured (Red, Yellow, Green, Blue) modifier buttons provide alternate 
functions when you press a button on the console while programming and 
during playback.  
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You can also use keyboard equivalents in place of the modifiers: 

· Shift is equivalent to the Red buttton 

· Control (Command) is equivalent to the Yellow button 

· Alt (Option) is the equivalent of the Green button 

· Control + Alt is the equivalent of the Blue button. 

The Super Playback / Programmer controls 
These controls are used during programming and playback. To switch functions 
press the ‘Menu’ button and then select from the three options: 

· IPCG – stands for Intensity, Position, Colour, Gobo, Beam and puts the 
controls into editing (aka programming) mode. In this mode the buttons 
and encoder wheels can be used to set Intensity levels, Pan Tilt and all 
the other features of your fixtures 

· Play – puts the controls into playback mode . In this mode the controls 
and buttons provide quick access to the regular and advanced cuelist 
playback options. 

· SFX – stands for Smart Effects. This mode lets you use the buttons and 
encoders control the most frequently used effects settings. 

 

Editor (aka Programmer) mode 
When you select fixtures in the Chooser or Timeline window the hardware 
controls can be used instead or the on screen palettes to adjust setting for 
Intensity, Position, Colour, Gobo and Miscellaneous parameters. 
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Programmer mode 
If the controls are not already in Programming mode press the menu button then 
the button labelled ‘IPCG’ to switch into to programmer mode: 

 

This button… does this… 

I /POS Press this button to put the encoders and lower 6 buttons in 
Intensity plus Position mode. Pressing it again cycles the 
controls through any available parameters or alternate 
modes (Angular position and Strobe & Shutter).  

Col Press this button to put the encoders and lower 6 buttons in 
Colour mode (HSV). Pressing it again cycles the controls 
through any available parameters or alternate modes (CMY, 
RGB, Colour Wheel Colour ) 

Gobo Press this button to put the encoders and lower 6 buttons in 
Gobo mode. Pressing it again cycles the controls through 
any available parameters or alternate modes. 

Beam Press this button to put the encoders and lower 6 buttons in 
Beam mode. Pressing it again cycles the controls through 
any available parameters or alternate modes. 

Custom Press this button to put the encoders and lower 6 buttons in 
custom feature mode. For more information on creating 
custom encoder pages see Creating Custom encoder pages on 
page 6-60 

Menu Opens the Super Playback top level menu screen. Double tap 
the menu button to switch between Playback and 
Programming mode. 

Home 

(Clear) 

Sets the associated feature to its default (or home) value.  

Hold the yellow modifier (or Ctrl key) to clear the feature 
settings. 
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This button… does this… 

Full 

(Zero) 

Sets the associated feature to its maximum values. I.E. this 
would set Intensity to 100. 

Hold the yellow modifier (or Ctrl key) to set the feature to its 
minimum value. 

>> For Gobo (or Colour) wheel features this button toggles 
between the fixtures wheels – i.e. Gobo wheel 1, Gobo wheel 
2, etc 

Mode For Gobo wheels that have rotating gobos this button toggles 
the rotation encoder between Index and Spin mode. 

< > This button reverses the direction of a spinning colour or 
gobo wheel or individual gobo. 

Encoders Rotate to set the associated parameter to the required value. 

<- Left arrow Selects the previous fixture. 

-> Right arrow Selects the next fixture. 

Super Fine Mode 
Hold down the Green modifier button or the Alt (Option) button, on your 
keyboard, to put the encoders into super-fine mode. 

Fixture Selection buttons 
The left and right arrow buttons located just above the encoder wheels can be 
used to select the previous or next fixture in a selection. 

If there’s no fixtures selected pressing the buttons will cycle through all the 
patched fixtures. 

After using the next and previous buttons you can reselect all fixtures by 
pressing both buttons together.  

Editor intensity 
The overall intensity from the Editor is controlled by the fader located on the left 
side, below the encoder wheels. 

Editor ‘Live’ time 
The fader located, on the right side, below the encoder wheels can be used to 
adjust the Live time. At the top (100%) position the Intensity, Position, Colour 
and other feature settings fade in over the ‘Live time’ set in the Editor window. 
At the bottom (o%) position the feature settings fade in over 0 seconds – i.e they 
snap to the new value. 
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Super Playback mode 
In playback mode the Super Playback section controls and buttons automatically 
link to the selected playback. This means that when you press the ‘Select’ (*) 
button on any cuelist playback you can control that cuelist with the faders, 
buttons and encoders in this section. 

Play controls 
The faders and buttons below the encoders provide quick access to all the cuelist 
play function. 

This button… does this… 

 
Jumps to the start of the Cuelist. 

 
Cues backwards to the previous Cue marker of the selected 
Cuelist. 

 
Cues forwards to the next Cue of the Cuelist. 

 
Jumps to the end of the selected Cuelist. 

 
Not used 

upper Not used 

 
Pauses playback of the selected Cuelist(s). 

lower Commences (Go) Playback the selected Cuelist(s). 

 (Left flash) 
Flashes intensity of the super playback Cuelist to the 
maximum value.  

 (Right) 

Crossfade  
Not used 

 

Ü You can configure these buttons in the Console window. See Assigning a 
component to the playback controls on page 12-13 
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Super Playback mode extended controls 
If the controls are not already in Playback mode press the menu button then the 
button labelled ‘Play’ to switch into to Playback mode. The top row of buttons let 
you select from the playback control pages: 

This button… does this… 

Control Selects the normal cuelist play mode controls. 

Chase Selects the cuelist Chase  controls. 

SmartFX Selects the cuelist SmartFX controls. 

Load 

/ Clear 

Press Load then any key on a normal playback to load that 
cuelist into the Superplayback. 

Press Yellow + Load (Ctrl + Load) to Clear the 
Superplayback. 

Lock Locks the current cuelist onto the Superplayback. When lock 
is selected pressing Select (*) on another playback will not 
change the Superplayback cuelist. 

Menu Opens the Superplayback top level menu screen. Double tap 
the menu button to switch between Playback and 
Programming mode. 

Cuelist Control (normal) mode 
In the Cuelist ‘Control’ mode you can control the playback rate and select from 
several play options using the bottom row of buttons: 

This button… does this… 

Rate Enables the left encoder for rate control of playback. Turn 
the encoder to the left to slow the playback rate and to the 
right to speed it up. 

100% Resets the playback rate to normal. At 100% the cuelist plays 
back using the fade times set in the cues. 

Jump Opens the cuelist jump window on the main screen. Used to 
jump from one cue to another cue out of sequence. Select the 
Cue you want to jump to in the Jump window.  See Using the 
Jump window on page 12-10 

Press Go to fade to that cue. 

Shuttle Enables the middle encoder for manual control of playback. 
Move the encoder clockwise to advance and anti-clockwise 
to go backwards. 
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This button… does this… 

Release Releases the cuelist. Fixtures return to the previous settings 
or to their defaults. 

Select Selects the cuelist on the SuperPlayback. 

Cuelist Chase mode 
In the Cuelist ‘Chase’ mode you can start a cuelist chasing, change the chase rate 
and select the chase direction: 

This button… does this… 

Rate Enables the left encoder for rate control of playback. Turn 
the encoder to the left to slow the playback rate and to the 
right to speed it up. 

Sync Synchronises the chase. 

Forward Turns the chase mode on and runs forwards. If the cuelist is 
already chasing forward pressing the button will turn chase 
mode off. 

Reverse Turns the chase mode on and runs backwards. If the cuelist 
is already chasing backward pressing the button will turn 
chase mode off. 

Bounce Turns the chase mode on in bounce mode (i.e. run from first 
to last cue then last to first cue). If the cuelist is already 
bouncing pressing the button will turn chase mode off. 

Random Turns the chase mode on and runs in a random order. If the 
cuelist is already in random pressing the button will turn 
chase mode off. 

Cuelist FX (effects) mode 
In the Cuelist ‘FX’ mode you can control the size, rate and phase of effects that 
are running on the console: 

This button… does this… 

Encoders Enables the encoders. To avoid accidentally changing FX 
settings turn the encoders off. 

Reset Resets the effect(s) Size to it’s programmed settings. 

Reset Resets the effect(s) Rate to it’s programmed settings. 
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This button… does this… 

All /Cuelist / 
Active. 

(press to toggle) 

All - selects all running effects for adjustment 

Cuelist - selects the effects in the selected cuelist for 
adjustment 

Active - selects the active effects for adjustment 

Forward / 
Backward 

(press to toggle) 

Changes the direction of the selected effect(s). 

Sync Re-synchronises the selected effects. 

Using the Jump window 
During playback you can use the jump window to quickly select a cue, out of the 
normal sequence,  and fade it in.  
To open the Jump window: 

· press a  Select button on any playback to bring that cuelist onto the 
super playback. 

· press the Jump button in the super playback 

Vista displays the Jump to Cue window: 

 

This option… does this… 

Cuelist Selects the cuelist to jump to. This field is automatically set 
to the cuelist on the superplayback. 

Cue Selects the cue to jump to. To find the cue you want to jump 
to type the cue number or a part of the cue name in the 
search box, or select the cue from the list. 

Cue Timing Crossfades using the new cues fade time. 
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This option… does this… 

Live Timing Crossfades using the Live time. 

Arm & Close Closes the Jump window with the selected cue ready to play.  
Press the Play button to complete the jump. 

To complete the Jump and fade in the selected cue, without using the Arm and 
Close option; 

· press the keyboard Enter key, or 

· use the Cuelist’s Go button, or 

· click the OK button. 

Playbacks with faders 
Depending on your console type you will have one of more ‘Playback with fader’ 
sets consisting of 5 playbacks. On the M1 console the playback set does not 
include a display. 

 

These playbacks consist of: 

· a Select button – normally used to select the playback 

· a display – used to display the name of the cuelist or other component 
that’s being controlled 

· a Go button – normally used to play the the cuelist or other component 

· a fader – used to control the intensity of a cuelist 

· a flash button – normally used to momentarily flash the intensity of a 
cuelist to full. 
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Playbacks without faders 
These button-only playback sets are available of the L5, T4, T2, I3, and S3 
consoles. 

 

These playbacks consist of: 

· a Select button – normally used to select the playback 

· a display – used to display the name of the cuelist or other component 
that’s being controlled 

· a Go button – normally used to play the cuelist or other component. 

Page controls 
Each playback module consists of 5 playbacks. Cuelists and other components 
can be assigned to these controls as pages. To change pages: 

· press the Page Up button to advance to the next page number 

· press the Page Down button to go back to the previous page number. 

Configuring the console for Playback 
Once you’ve stored a number of Cuelists, Groups, Presets, Extracts, etc, you can 
assign those components to the playback controls the way you want them, using 
Console screen. 
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When you click the Console button on the toolbar Vista displays the Console 
screen: 

 

On this window the Sidebar shows a quickpicker where you can display and 
filter the components you want to assign to the console. You can: 

· choose a component type (Cuelists, Groups, Presets, Extracts, Smart FX, 
Snapshots) from the top dropdown. 

· filter the list by selecting a set from dropdown. For example you can 
filter the list to show just Presets that include Colour. 

Assigning a component to the playback controls 
Once you’ve selected the component type you want you can drag and drop it 
onto the label area corresponding to the console’s LCD windows: 

 

Ü Tip: You can assign any combination of components to the playback controls 
– Cuelists, Groups, Presets, Extract, Effects, Favourites and Snapshots. 

Splitting playback controls 
When a component is assigned to a playback it uses all the controls that are 
available – the Go and Choose button plus the fader and flash button if available, 
but you can split a playback set to increase the number of components that can be 
placed on a page.  
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To do this, move the cursor to the top of the white label area. When the pointer 
changes to a split bar [=], click and drag down: 

 

Playbacks with faders can be split three ways. To do this move the cursor to the 
middle of the label area. When the pointer changes to a split bar [=] click and 
drag down. 

Ü Tip: You don’t have to split all the playbacks on a page the same way, you 
can split on two ways, another three ways and so on. 

Expanding playbacks 
Playbacks can also be extended to provide more physical button controls for 
playback of a cuelist. Up to five playbacks in the group can control a cuelist: 

 

To expand a Playback move the cursor to the right side of the label area. When 
the pointer changes to a split bar [||] click and drag to the right. 

Ü Tip: You can expand a Playback before or after a Cuelist has been assigned, 
but you can only expand into an area that is not occupied by another 
component. 

Configuring the playback buttons and faders 
Normal, split and expanded playbacks have their buttons and faders set up with 
the default configuration. To see how the buttons and faders are configured press 
the Help key [!] on L or T series consoles. On a Mac or Windows system hover 
cursor over an item to show a tooltip. 

Vista displays the button and fader functions on the LCDs and in the Console 
window: 
You can assign different actions to these buttons and faders to suit your 
requirements or playback style.  
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To assign an action: 
1. Click the Console button to display the Console screen. 

2. Click on the ‘Cuelist Buttons’ or ‘Cuelist Faders’ tab in sidebar. 

3. Click on the required button or fader action and drag it on top of the button 
or fader you want to use for that function. 

Some buttons and faders must be used together. For example if you make a fader 
a ‘Cross fader’ you should also assign a ‘Toggle Xfader’ button to the button 
below the fader. Likewise if you make a fader a ‘Rate fader’ you should also 
assign a ‘Toggle rate fader’ button to the button below the fader.  

Cuelist buttons 
The following button actions are available: 

This button action … does this… 

Unassigned The button has no action. 

Play Plays (starts playback of) a cuelist. 

Jump Opens the Jump window. See Using the Jump window 
on page 12-10 

Inhibit Stops the cuelist playback, Intensity is reduced to 0 
and all other parameters revert to their previous 
setting. Press the button again to enable or re-assert 
the cuelist. 

Flash Sets the button to momentarily flash Intensity to full. 
This is the default assignment for the square buttons 
below the faders. 

Flash Submaster Sets the button to momentarily flash Intensity to full 
on a Submaster. 

Pause Pauses playback of a cuelist. 

Edit Opens a Cuelist, for editing, in the Editor window. 

Skip Forward Steps forwards to the next Cue of the cuelist. 

Release Releases a cuelist. 

Skip Back Steps backwards to the previous Cue marker of the 
selected cuelist. 

Skip to End Jumps to the end of the cuelist. 
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This button action … does this… 

Select Selects the cuelist. This is the default assignment for 
all * buttons. 

Flash Latch Toggles the cuelist intensity between full and off. 

Solo Flashes the cuelist intensity to full and blackouts all 
other output. 

Re-assert Re-asserts a cuelist that has been overridden. 

Chase Toggle Toggles between Chase on and Chase off. 

Chase Direction Cycles between the available chase directions in this 
order: Forward, Backward, Bounce, Random. 

Chase Forward Sets the Chase direction to forwards (the normal 
setting). N.B. if the chase is already running forwards 
the button will toggle between chase off and chase 
forwards. 

Chase Backward Sets the Chase direction to backwards (or reverse). 
N.B. if the chase is already running backwards the 
button will toggle between chase off and chase 
backwards. 

Chase Bounce Sets the Chase direction to bounce. N.B. if the chase is 
already bouncing the button will toggle between 
chase off and chase bounce. 

Chase Random Sets the Chase direction to random. N.B. if the chase 
is already set to random the button will toggle 
between chase off and chase random. 

Skip to Start Jumps to the start of the cuelist. 

Exit Loop Stops a loop and goes to the next cue. 

Sync FX Re-synchronises running effects. 

Sync Chase Re-synchronises running chasess. 

Play Toggle Plays the next cue or releases the Cuelist if it is 
already playing. 
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Cuelist faders 
The following fader actions are available: 

This fader action … does this… 

Blank Fader has no action. 

Intensity Fader Sets the fader to control the Intensity of a cuelist. This 
is the default assignment for all faders. 

Cross Fader Sets the fader to manually crossfade between cues. 
Must be used in conjunction with a ‘Toggle Xfader’ 
button. 

Rate Fader Adjusts the playback rate. 

FX Size Controls the size of any effect in the cuelist. 

FX rate Controls the rate of any effect in the cuelist 

FX phase Controls the phase offset of any effect in the cuelist 

Live Timing Controls the ‘Live’ fade time – used for crossfades 
from the Editor etc. 

 

Ü Tip: You can save the button / fader configuration as a default to be used 
whenever a cuelist is assigned to a playback. To do this right-click on a 
cuelist and choose the ‘Save as default cuelist configuration’ option. 

Playback status indication 
For Cuelists the LCD and LEDs inside the playback buttons indicate the current 
status of each playback as follows: 

 Normal (2 Button Playback) Split (1 Button)  

 Lower Button Upper Button LCD Button 

Current   Inverted  

Active  Green   

Paused Green Flashing   Green Flashing 

Running Green   Green 

Completed Red   Red 

Overridden  Red Flashing  Red Flashing 
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Playback popup menu 
You can make changes to Cuelists Pages and other components using the 
Playback context menu. To open this menu right-click on the label area of any 
playback control. Vista displays the context menu: 

 
 

This option… does this… 

Cuelist Properties Opens the Cuelist properties window – see below. 

Set as default cuelist 
configuration. 

Sets the selected cuelist’s buttons and faders as the 
defaults for all new cuelists. 

Lock item Locks the selected component. Components that 
have been locked will not be altered or replaced 
when a new Page or Snapshot is loaded. 

Clear item Clears the selected playback – the assigned 
component is removed from the control. 

Clear page Clears all playbacks on the current page – the 
assigned components are removed and a blank page 
is left. 

Delete page Deletes the current page. 

Copy page Copies the current page 

Copy all pages Copies all pages on the playback set 

Paste page(s) Paste the pages or pages  

Set as default playback 
layout. 

Sets the selected cuelist’s buttons and faders as the 
defaults for all new cuelists. 

Snapshot enabled Allows the selected playback to be included in a 
snapshot. 
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This option… does this… 

Set as default cuelist 
configuration 

Sets the selected cuelist’s properties as the defaults 
for all new cuelists. 

Adjust contrast Adjusts the contrast of the selected LCD window  

Setting cuelist properties 
To set the cuelist properties, right click on the Cuelist name and the Properties 
option from the popup menu. For more information see Cuelist Properties on page 
7-26 

Group Masters 
You can assign any Group to a playback. To do this: 
To assign an action: 
1. Click the Console button to display the Console screen. 

2. Select ‘Groups’ from the drop down menu at the top of the  sidebar. 

3. Drag and drop the Group onto a playback position. A Group can be 
controlled by a single button, on a split playback, or by a playback with a 
fader and / or multiple buttons. 

 

Once you have assigned a Group to a playback you can select actions for the 
buttons and fader associated with the Group.  

To assign an action: 
1. Click the Console button to display the Console screen. 

2. Click on the ‘Group Faders’ or ‘Group Buttons’ tab in the sidebar. 

3. Click on the required fader or button action and drag it on top of the button 
or fader you want to use for that function. 
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Group Fader 
The following fader actions are available: 

This Group fader type does this… 

Scale ( - ) 

also known as an 
Inhibitive or 
Subtractive group 
master 

Reduces the intensity of fixtures in the group. When 
a Scale(-) fader is pulled down, while a cuelist is 
being played, the intensity of fixtures in that group 
will be reduced. 

Scale ( + ) 

also known as an 
Additive group master 

Increase the intensity of fixtures in the group. When a 
Scale(+) fader is pushed up, while a cuelist is being 
played, the intensity of fixtures in that group will be 
increased. 

HTP 

Highest takes 
precedence 

Control the the intensity of fixtures in the group on 
an HTP basis. If there’s no cuelist, containing the 
fixtures in the group being played the fader will set 
the level of the fixtures between 0 and 100%.  

This is the default fader setting for groups. 

 

Group Buttons 
The following button actions are available: 

This button action … does this… 

Blank The button has no action. 

Select Selects the group. This is the default button setting 
for groups on playbacks with a single button . 

Flash ( - ) When a Flash(-) flash button is pressed the intensity 
of fixtures in that group will go to 0%. 

Flash ( + ) 

 

When a Flash(+) flash button is pressed the intensity 
of fixtures in that group will go to 100%. 

Flash HTP 

Highest takes 
precedence 

Control the the intensity of fixtures in the group on 
an HTP basis. If there’s no cuelist, containing the 
fixtures in the group, being played the button will set 
the level of the fixtures between to 100%. 

This is the default flash button setting for groups. 

Solo Brings the intensity of fixtures in the group to 100% 
and blacks out all other fixtures. Releasing the button 
restores the previous fixture levels. 
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Pages 
Each Playback Group can be paged independently of the others, allowing for a 
wide variety of console configurations. To change pages, press the Up or Down 
arrow buttons located to the right of each playback group. On the console screen 
you can also select a page from the popup page selector. 

Locking a playback to prevent changing 
Playbacks can be Locked to prevent whatever is assigned to that location being 
changed when a new page or snapshot is selected. 

Components can be locked, so that they are not affected by Page changes or 
Snapshots being loaded. To do this right-click on LCD, in the Console window, 
and choose the ‘Lock item’ option from the popup menu. 

Page Holdover 
If a cuelist is playing when you change pages it is held and that playback does 
not load the contents of the new page. The playback that is held will join the new 
page when: 

· The cuelist is released or fully over-ridden or 

· You press the page up and down buttons simultaneously. 

Snapshots 
Snapshots allow you to store and recall the exact state of the console’s output, 
buttons, faders and other controls. They can be used to quickly re-configure the 
controls for playback, programming or a mixture of both. For example, you may 
have a snapshot set up for each song or part of a show. You might also have a 
snapshot for programming with the playback buttons assigned to provide quick 
access to Groups, Presets Extracts and Effects. 

Snapshots can not only recall Page and Cuelist settings but also the state of the 
Cuelist. For example if a Cuelist is active and in Cue 3 when the snapshot is 
recorded then the same state can be recalled. 

To record a snapshot 
1. Use the console window to assign components and configure the controls 

and pages the way you want them to be. 

2. Click the Create Snapshot button (normally Green + F9 or Alt+F9) on the 
main toolbar. Or select the ‘New Snapshot option from the Components 
menu. Vista displays the Create Snapshot window: 
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This option… does this… 

Name Sets the name for the snapshot 

Record Sets the options for the snapshot: 

Playback State The state of cuelists on the current pages will be 
included in the snapshot. For example if a Cuelist is 
active in Cue 2 when the snapshot is recorded it 
will also be active in Cue 2 when recalled. 

Fader Levels Includes the current fader levels in the snapshot. 

Workspace state Saves the contents (cuelists, groups and other 
components) of all playbacks. 

Ü Locked components are protected from any changes by snapshots. If a 
cuelist is part of a snapshot and it is also running on a module that will not 
be affected by the snapshot there can be a conflict.  
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In this situation: 

· If the cuelist is active on the unaffected module, it is not changed. 

· If the cuelist is inactive on the unaffected module, it is restored to the 
state stored in the incoming snapshot (i.e. activated or released). 

Assigning a Snapshot to a Playback 
You assign Snapshot to a playback button in the Console window.  

Recalling a Snapshot 
To recall a Snapshot, you can: 

· Use a playback button that has been set up as a snapshot, or 

· Right-click on a snapshot icon and select the ‘Apply’ option from the 
popup menu, or 

· Click on the snapshot in one of the Quick picker windows. 

Updating a Snapshot 
To update a Snapshot: 
1. Make sure the snapshot is active. 

2. Change the assignment and state of components and pages as required. 

Right-Click on the snapshot icon, in the Console sidebar or any QuickPicker  and 
select  the Update option from the popup menu. Vista displays the ‘Update 
snapshot’ window. 
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13. The Output window 

  

To open the Output window click on the icon on the main toolbar or select the 
‘Output’ option from the Window menu. Vista displays the Output window in 
icon view: 

 

You use this screen to display the state of fixtures that are active – that is fixtures 
that have one or more parameters that are being controlled by the playbacks. The 
window is split vertically with multi-parameter fixtures displayed in the top 
pane and conventional fixtures (i.e. dimmers only) being shown in the lower 
pane. 

If you have a large main screen or external monitors attached, you can add a new 
Output window and drag it so that it is always in view. To do this select the ‘Add 
Dockable window > Output’ option from the View menu. 

Adding output view tabs 
You can create as many different views of the output as you like, each arranged 
in its own away. To create a new output view: 

1. Select the ‘Add view’ option from the View menu. Vista creates a new view 
tab at the bottom of the window. 

2. Type a name for the layout and click OK. Vista creates a new layout and 
adds a corresponding ‘tab’ at the bottom of the layout panel. 
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To switch between layouts click on the tab you want to use. 

Configuring the Output window 
The Output window has a popup menu that lets you configure how the Output 
information is displayed. Right-click on the screen to show the configuration 
options: 

 

This option… does this… 

Text Mode Shows the actual values of the features. If a parameter is 
set to a preset value, the name of the preset will be 
displayed rather than the value. 

Graphic mode Shows a graphic representation of the features.  

Source mode Shows where each feature is coming from. For example 
a fixture might have Intensity and Position coming from 
a Cuelist and Colour from the Editor Live tab. 

Follow Fixture 
selection 

Shows the selected fixtures at the top of the view. 

Show all fixtures Shows all fixtures. 

Add selected 
fixtures 

Adds the fixtures, selected in the Fixture Chooser, to the 
output window. 

Remove selected 
fixtures 

Removes the selected fixtures from the output window. 

Show only selected 
fixtures 

Filters the window to only show the selected fixtures. 
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This option… does this… 

Clear view Clears all fixtures from the output window. 

Resize all columns Resizes all columns to their default size. 

Rename view Opens the Rename View window where you can type a 
new name for the selected layout view. 

Remove view Deletes the selected layout view. 

 

The Source view shows the source of control for each of the parameters. For 
example if a fixture’s colour settings have come from a cuelist named ‘Rainbow’, 
that name will be displayed in the Colour column for that fixture. 

Selecting fixtures 
If you click in the ID or name cell of a fixture in the tracking view window, Vista 
selects that fixture or adds it to the existing selection. 
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14. Appendix 1 – menu & toolbar 
reference 

Menus 

File menu 
 

This option… does this… 

New Show Creates a new show file, opening the Patch window. 

Open Show Opens an existing Show file. 

Save Show Saves the current show. 

Save Show As Saves the current show with a new name. 

Networking Opens the Vista Network window where you can 
setup connections with other Vista consoles for 
tracking backup and with D1 units for distributed 
processing. 

Export Opens the Export window where you can export a 
Show Archive File, the user added Fixture Library, the 
user created effects, or all show information. 

Import 

 - Show 

 - Effects 

 - User data 

 

Open a window to import a Vista show Archive (*.jvz) 

Opens a window to import a Vista effects file (*.jvfx) 

Opens a window to import a User Data archive 
(*.jvud) 

User Preferences Opens the system User Preferences window where 
you can configure preferences for naming formats, 
patching, console hardware characteristics, serial and 
Midi inputs and playback. 

Timecode Opens the Timecode properties window where you 
can enable or disable timecode and set the timecode 
source, frame rate and offset. 
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This option… does this… 

Lock 

 - Entire console 

 - Disable editing 

 - Lock current show 

 

Prevents any operation of the console. 

Only allows playback. 

Prevents any changes being made to the show file. 

Control panel 

(consoles only) 

Opens the system properties window where you can 
calibrate the screens, configure displays, local area 
network and date settings on a L, T or I series console. 

Quit Application Close the Vista application and exit. 

 

Edit menu 
 

This option… does this… 

Select All (Ctrl+A) Selects every fixture, in the chooser or patch window 
and every event in the timeline window . 

Undo (Ctrl+Z) Cancels your last action. 

Redo (Ctrl+Y) Repeats your last action. 

Cut (Ctrl+X) Cuts the selected objects. 

Copy (Ctrl+C) Copies the selected objects. 

Paste (Ctrl+V) Pastes the selected objects. 

Paste Special 

(Ctrl+Shift+V) 

Opens the Paste Special window so you can choose 
which attributes of the objects you copied to paste. 

Remove Cue Alias Removes the alias link from the selected cue. 

Delete (Del) Removes the selected event(s) from the timeline. 

Live Properties Displays the Properties window so you can make 
adjustments to the Priority and Stop Effects mode of 
the Live tab. 

Cuelist Properties Displays the Properties window so you can make 
adjustments to the selected cuelist. 
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This option… does this… 

Cue Properties Displays the Properties window so you can make 
adjustments to the selected cue. 

Highlight Opens a submenu where you can select options to 
edit, update or reset the Highlight settings. 

Lowlight Opens a submenu where you can select options to 
edit, update or reset the Lowlight settings 

Home Opens a submenu where you can select options to 
edit, update or reset the Home preset. 

 

Components menu 
 

This option… does this… 

New Cuelist Opens a new empty cuelist. Switches to the Chooser 
window if the Chooser or Timeline is not the top 
window. 

Open Cuelist Opens the Select Cuelist window where you can open 
an existing cuelist. 

Close Cuelist 
(Ctrl+W) 

Closes the selected cuelist. 

Save changes to 
Cuelist. (Alt+S) 

Saves all changes made to the selected cuelist. 

Discard changes to 
Cuelist 

Removes all changes made since the cuelist was 
opened or ‘Save changes’ was selected. 

Duplicate Cuelist Opens the Copy Cuelist As window where you can 
save a copy of the selected cuelist with a new name 
and number (ID) 

New Preset Opens the Create New Preset window where you can 
save a preset. 

New Extract Opens the Create Extract window where you can save 
a extract. 

New Snapshot Opens the Create Snapshot window where you can 
save a snapshot. 
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This option… does this… 

New SmartFX Opens the Create Effect window where you can save 
an effect. 

New Fixture Group Opens the Create Group window where you can save 
a group of fixtures. 

Update Fixture 
Group 

Opens the Update Group window where you can save 
changes to a group. 

 

Tools menu 
This option… does this… 

Cue only editing Sets the programmer to undo any changes made in the 
cue being edited, in the following cue. 

Mark Cue 

(Move in Black) 

Opens the Move in Black window. This enables you to 
move fixtures ( and / or set other features such as 
colour, gobo and beam) when their intensity is at zero 
so that the changes cannot be seen. 

Insert Commands Opens the Macro Properties window. This lets you 
add commands, in the cuelist’s timeline to activate 
other cuelists or actions. 

Edit Command Opens the Macro Properties window for the selected 
command.  

Select Audio Opens the select audio window for the selected cuelist. 

Date & Time events Opens the Date and Time Events window where you 
can configure actions (for example to play a cuelist) 
based on the date and time. 

Block cue (Ctrl + B) Copies all tracked information to the current cue and 
adds release events for other feature types in this 
cuelist. 

Unblock cue Removes all events added when a cue is blocked. 

Superblock cue 
(Ctrl + Shift + B) 

Copies all tracked information to the current cue and 
adds release events for other feature types. When a 
super-blocked cue is run any other cues being playing, 
that would affect the look of this cue are released. 

Store All Opens the Store Look window where the contents of 
the editor can be saved as a cue. 
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This option… does this… 

Store Part 
(Shift + Return) 

Opens the Store Current Events window where the 
contents of the editor can be saved as a cue with 
options for tracking, blocking and more. 

Update (Ctrl + U) Opens the Update Dialog window where the contents 
of the editor can be used to update a cue or preset. 

Clear All Opens a submenu with options to Clears all events or 
events by feature type from the selected cue or the 
editor’s Live tab. 

Clear / Close Clears the Live tab or closes the selected Cuelist. If the 
cuelist has unsaved changes opens the CloseCuelist 
window where any changes can be committed or 
discarded. 

Clear selected Clears all events from the selected fixtures. 

Home selected Inserts events to send all features of the selected 
fixtures to their home values. i.e. Intensity to 0%, 
position to 50/50, colour to clear, etc. 

Remove selected Opens the Remove Programming window where you 
can remove events from the selected fixtures. 

Cues 
 
 - (Ctrl + Shift + I) 
 - (Alt + I) 
- (Ctrl + I) 
 
 
 
 - (Ctrl + Left arrow) 
- (Ctrl + Right arrow) 

Opens the cues submenu with commands to: 
 - Append a new cue at the end of the cuelist. 
 - Insert a new cue before the selected cue. 
 - Insert a new cue at the playhead position. 
 - Insert a new cue after the selected cue. 
 - Delete the selected cue(s) 
 - Merge the selected cues 
 - Renumber the selected cue(s) 
 - Select the Previous cue 
 - Select the Next cue 
 - Set the cue follow mode to Auto,  From Start (of 
previous), From End (of previous) or Halt (the default) 

 - Move Start times of the selected cues. 
 - Select Audio 

Live timing Opens the Live Timing window where you can set the 
fade time for the Live tab of the editor. 

Fan mode Opens a submenu where you can set the fan mode for 
fixture selections. 

Jump (Ctrl+ J) Opens the cue JumpDialog window.  
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This option… does this… 

Highlight (Ctrl + H) Turns highlight on or off. When on the selected 
fixture(s) are set to the values stored in the highlight 
preset (normally 100% intensity, open white) 

Stop SmartFX Opens a submenu where you can All effects or effects 
by feature type that are running on the selected 
fixtures 

Smart FX editor 
(Ctrl + K) 

Opens the SmartFX panel in the sidebar where you 
can create a new effect or edit a running effect 

Blind Turns off all output from the editor 

Release All Releases all active cuelists 

Arm Timecode 
Cuelists 

Sets all cuelists, that include timecode cues, to listen 
for incoming timecode. 

Remove redundant 
cuelist events 

Removes events that don’t make any changes to the 
tracked state of the cuelist 

Learn timing Opens the Learn Timing window where you can set 
cue timecode values by playing the cuelist, in the 
editor, and hitting the Go button at the time you want 
the cue to start. 

Set Cuelist Timecode Opens the Cuelist Start Timecode window where you 
can edit the Start Timecode or a set an offset. 

Clean up show Removes orphaned programming. 

Midi Show Control Enables or disables Midi Show Control (MSC) 

 

Patch menu 
This option… does this… 

Show Patch Switches to the Patch window, if it is not already open. 

Delete fixtures Removes the selected fixtures from the patch. 

Rename fixtures Opens the Rename window where you can enter a 
custom name for the selected fixture(s). 

Renumber fixtures Opens the Renumber window where you can change 
the ID number for the selected fixture(s). The number 
must not be in use already. 
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This option… does this… 

Multi-patch fixtures Creates a copy of the selected fixture, with the same ID 
and places it in the dock. The new fixture can then be 
dragged to an available address on one of the universe 
tabs. Multi patching lets you treat 2 or more fixtures as 
one. 

Change Fixture type Opens the Change Fixture type window where you 
can change a fixture to a different type.  

Change Fixture type 
(All of selected type) 

Opens the Change Fixture type window where you 
can change all fixtures of the selected type to a 
different type.  

Clone Fixtures Makes a copy of the selected fixture(s) and places it in 
the Fixture pool at the bottom of the Patch window. 

Import Fixture 
Library 

Opens a file browser where you can import a Vista 2 
fixture type library archive (.jvft). 

Extract selected 
fixtures to user 
library 

Creates a copy of the selected fixture(s) in the User 
library. 

Fixture Editor Opens the Fixture Editor where you can create a new 
fixture file or edit an existing one. 

Import Patch file Opens the Import Patch file window where you can 
select a suitably formatted (.csv) patch file to import. 

Export Patch file Export a CSV file of the Patch information. 

Import Media Server 
thumbnails. 

Open the CITP window where you can select a media 
server with compatible support for CITP and import 
copies of the fixtures media thumbnails. 

Check for updated 
fixture profiles 

Checks the fixture library for newer versions of all 
patched fixtures. 

Use default media Used to reset fixtures to use their default colours, 
gobos and media. 

Connect Universes Opens the Connect Universes window where you can 
connect the Vista universes to DMX outputs, sACN, 
Artnet, and Pathport devices and the Jands UD512 
USB to DMX cable. 

Strike Sends a strike command to the selected fixture(s). 

Douse Sends a douse command to the selected fixture(s). 
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This option… does this… 

Reset Sends a reset command to the selected fixture(s). 

Park Fixtures Holds the fixture in it’s current settings.  

For example to provide fixed lighting for backstage. 
Once you’ve parked a fixture it will ignore all 
instructions until it is un-parked. 

UnPark Fixtures Sets a parked fixture to operate normally. 

Show Parked Fixtures Opens the Parked Fixtures window to display a list of 
parked fixtures and their settings. 

Console menu 
This option… does this… 

Show Console Switches to the Console window, if it is not already 
open. 

Desklights Opens the desklights window where you can adjust 
the brightness of the desklights connected to your 
console. 

Assign Custom 
Encoders 

Opens a window where you can assign features to the 
encoders and save custom pages. 

Rescan for USB 
devices 

Scans the USB bus for Vista USB devices – S3, S1, M1, 
E2 or UD512 

Add …. Console Adds the selected console or control surface type to 
the Console window. These windows can be dragged 
outside the main window. 

Add Virtual Super-
Playback 

Adds a Superplayback module to the console window. 
This window can be dragged outside the main 
window. 

Chooser menu 
This option… does this… 

Show Fixture 
Chooser 

Switches to the Fixture Chooser window, if it is not 
already open. 

Select All Fixtures Selects all fixtures on the current fixture chooser tab. 
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This option… does this… 

Deselect All Fixtures Deselects all fixtures across fixture chooser tabs. 

Invert selection Deselects all selected fixtures and selects all other 
fixtures on the current layout. 

Select Active Selects all fixtures whose intensity is above 0%. 

Select Programmed Selects all fixtures that have active programming. 

Undo selection Deselects the selected fixtures and selects the fixtures 
that were previously selected. 

Redo selection Reselects the fixtures that were selected before an 
undo selection action. 

Previous Fixture Selects the previous fixture. 

Next Fixture Selects the next fixture. 

Selection Tool Displays a submenu to select the Rubberband, Lasso 
or Dragover selection tool. 

Colours and 
Background 

Displays a submenu to customise the appearance of 
the fixture chooser window and icons. See Layout 
organisation on Page 6-6 

Shrink to fit Zooms the layout to fit the available window space. 

Label Position Displays a submenu where you can set the label 
position, for the selected fixture(s) to the top, bottom, 
left or right. 

Manage Layouts Opens the Layouts window where you can customise 
the current layout. See Layouts on Page 6-3 

Duplicate Layout Create a copy of the current layout with a new name. 

Layout options Displays a submenu where you can choose display 
options that apply to all layouts: 
 - False Intensity 
 - Show selection order 
 - Show grid 
 - Snap to grid 
 - Show names 
 - Show IDs 
 - Auto add new fixtures 
 - Preview refresh rate 
 - Detail level 
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Timeline menu 
This option… does this… 

Show Timeline Switches to the Timeline window, if it is not already 
open. 

Show tracked events Shows or hides features that are tracking through from 
previous cues. Tracked events are shown as lighter 
bars that cannot be selected. 

Align start Aligns the start points of the selected events. 

Align end Aligns the end points of the selected events. 

Set Event Timing Opens the Event Timing window where you can edit 
the timing information for the selected event. 

Reset to default 
timing 

Resets the selected event(s) so that it follows the 
default timing for its feature type. 

Fade Curve Sets the fade type for the selected event(s). 

Convert to Release 
Event 

Converts the selected event so that it releases the 
control of the feature. 

UnTrack events 
(Cue only) 

Undo the effect of the selected events in the following 
Cue. 

Stop Free Effects Sets the selected event(s) to stop any free effects for the 
same feature type. 

Mute Events Prevents the selected event(s) from being played back. 
The event bar will be greyed and when the cue is 
played the event will be ignored. 

Unmute Events Removes the muting from the selected event(s). 

Ignore Move in Black Sets the selected fixtures / events(s) to ignore Move in 
Black. 

Don’t Ignore Move in 
Black 

Removes the ignore Move in Black setting. 

Snap to Grid Sets events to snap to the timeline gridlines. 

Grid Size Sets the gridline increments. The default is 0.25s. 

14-10 Vista User Guide, Version 2.3 



Appendix 1 – menu & toolbar reference Menus 
 

This option… does this… 

Grid Origin Sets how the timeline ruler shows timing: 
 - Start of cue, shows 0s at the start of each cue 
 - Start of Cuelist, shows a single continuous timeline 
 - Current Position, sets the 0s position to the current 
position of the playhead. 

 - Timecode, shows timecode values. (HH:MM:SS:Fs) 

View menu 
This option… does this… 

Show Patch Switches to the Patch window. 

Show Console Switches to the Console window. 

Show Fixture 
Chooser 

Switches to the Fixture Chooser window. 

Show Timeline Switches to the Timeline window. 

Show Playback Switches to the Playback window. 

Show Output Switches to the Output window. 

Window Themes Opens the Vista ThemeDialog window where you can 
customise the colour of window elements or load one 
of the alternate themes. 

Vista Toolbar Shows or hides the window selection toolbar, at the 
bottom of the screen. 

Softkey Toolbar Shows the F1 – F12 softkey labels at the top of the 
screen. 

External window 1 - 2 Opens a touch screen friendly window with options to 
display Quickpickers and / or other windows 

Sidebar 
 
 
 - (Ctrl + 1) 
 - (Ctrl + 2) 

Displays a submenu with options to show the sidebar 
on either the left or right side of the screen and to set 
which tab is active: 
 - Palettes 
 - Components 

Command Line Shows or hides the Command Line window at the 
bottom of the Fixture Chooser & Timeline windows 
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This option… does this… 

Add Dockable 
window 

Displays a submenu where you can select a window to 
open on the desktop or an external monitor. The 
available windows include the Patch, Chooser, 
Playback, Output and DMX windows as well as: 
 - Multi Quick Picker – to display presets ,groups, etc 
 - Quick Picker 1-4 – a single quickpicker. 

Dockable windows can be dragged into the Chooser 
and Timeline windows and docked beside or between 
the other window sections.   

Toolbars * Displays a submenu to show or hide optional toolbars 
including, Update, Edit, Undo and more. The available 
toolbars depend on the current window. 

 Playback window only 

Only show Active 
cuelists  

Only show cuelists that are being played back. 

Follow on Go Automatically select the last played cuelist. 

Follow on Select Automatically select the cuelist on the selected 
playback. 

Search cuelists Opens a search box so you can find a cuelist by name. 

Auto Scroll Automatically scrolls the list of cues so that the cue 
being played is always visible. 

Dragable Playhead Allows the ‘position’ bar to be dragged to play the 
cuelist. 

Search Cues Opens a search box so you can find a cue by name. 

Toolbars Shows or Hides optional toolbars 

 Output window only 

Add View Creates a new output window and adds a selection tab 
at the bottom of the window. 

Add Intensity View Creates a new output window, that only shows 
Intensity and adds a selection tab at the bottom of the 
window. 

Load window layout Opens the Load Output Window to show a saved 
window layout. 

Save window layout Saves the current output window layout. 
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This option… does this… 

 Patch Window Only 

Table view Switches the Patch window to the (default) table view.  

List view Switches the Patch window to the list view. 

DMX view Switches the Patch window to the DMX view. 

Absolute Channel 
numbers 

Displays channel numbers consecutively irrespective 
of the universe. For example Universe 2, Channel 1 
displays as channel 513. 

Toolbars Shows or Hides optional toolbars. 

Help menu 
This option… does this… 

About Vista Displays information about your system including: 

· The Vista version and build number. 

· The Fixture Library version number. 

· The path to your User Data directory. 

· The channel count of your licence dongle(s). 

Export logs… Opens a window where you can save diagnostic and 
error log files. Always save and attach this file when 
opening a support request.  
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15. Appendix 2 – installing new 
software 

Software updates 
For the most up to date information on installing software updates or doing a 
clean installation on your console visit the Vista support page: 

http://jands.com/support-vista-v2/ 

Ü A full re-install on a L, T or I console will erase all saved shows and other 
data. You must manually backup or archive all your existing show data (the 
contents of the /data/ directory) to an external storage device. 

Creating a bootable USB drive 
Major upgrades, that require the console’s hard drive to be erased, can be 
installed from a suitably formatted USB device. For instructions on how to create 
a bootable USB FlashDrive on either a Windows or Mac computer see the 
‘Technical Bulletins’ section on the Vista support page: 

http://jands.com/support-vista-v2/ 

Connecting to the console via FTP 
You can take advantage of the Vista’s built-in FTP server to move files from a 
Mac or PC to the Vista or vice versa using FTP (File Transfer Protocol, a common 
method of file transfer). 

Hardware setup 
Connect the console and computer to an Ethernet hub or switch using a standard 
Ethernet cable, or connect the two devices to each other using a crossover 
Ethernet cable. 

Vista software setup 
Open the Network window from the Control panel option on the File menu,  and 
check the ‘IP Address’ setting. If the IP address is already set, make note of the 
address and close the Control panel. If there’s no IP address or it’s set to 0.0.0.0, 
you’ll need to assign one. The address is four groups of numbers from 0 to 255, 
all connected by periods. Typically, you’ll use an IP addresses starting with 
192.168 (e.g., 192.168.0.65). 

Vista User Guide, Version 2.3 15-1 



Connecting to the console via FTP Appendix 2 – installing new software 

Computer software setup 
Check that the computer’s TCP/IP properties are set to a different IP address in 
the same subnet (192.168.0.100, for example). The subnet mask should be, 
255.255.255.0.  

If necessary refer to your computer’s documentation for how to set the IP 
address. 

Using FTP 
On the computer start an FTP client such as Filezilla, FTP Commander or 
CuteFTP and open a connection to the console’s IP address (192.168.0.65). The 
connection requires a username and password as follows: 

Username: byron 
Password byron 

If you use  a graphical FTP client such as those mentioned above the contents of 
the consoles Show Data directory and sub folders will be displayed in a window 
such as this: 
 

Files can now be transferred to and from the Vista by dragging them between the 
Vista ( ‘remote site’ window) and the PC ( ‘local site’ window). 

Ü If the console is not booting properly it may be possible to copy files using 
this method. 
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16. Appendix 3 – Tracking Backup 
With Vista’s new tracking backup feature you can connect a computer, running 
the Vista application, or a second console that synchronises it’s show file and 
settings with your main console. If the main console fails for any reason, the 
backup system will automatically take control.  

The backup system automatically copies the show programming from the main 
console and you can start or stop them in any order and at any time. 

Setting up 
To set up a backup system the console(s) and computer(s) have to be physically 
connected via their Ethernet ports and their network settings must be configured 
correctly. 

Connecting the backup or D1 distributed processing unit  
To connect the main console or computer and the backup console or computer 
you can either: 

· Connect from the Ethernet port of the Console(s) and computer(s) to the 
Local Area Network (LAN) in your building, or 

· Connect from the Ethernet port of the Console(s) and computer(s) to a 
stand alone Router, or 

· Connect from the Ethernet port of the Console(s) and computer(s) to a 
stand alone Switch or Hub, or 

· Connect the Ethernet port of the Console(s) and computer(s) using a 
Crossover cable. 

Configuring the network settings 
All consoles or computers being used in a tracking backup system need an IP 
address on the same subnet as the others. If you are using a LAN or stand-alone 
Router a DHCP server will automatically assign Router IP addresses, provided 
your console’s or computer’s network interface is set to use DHCP. If you are 
using a Switch, Hub or Crossover cable you’ll need to set static IPs on all the 
devices in your backup system: 

Vista L, T & I series network settings 
To configure the network on a L, T or I series console: 
1. Select the Settings option from the File menu. Vista opens the Settings 

window. 
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2. Click the Network button. Vista opens the Network window: 

  

This field… does this… 

Hostname This field is not used but a name is automatically assigned. 

IP Address Set this field to DHCP if you are connecting to a LAN or 
stand alone router that has a DHCP server. 

If there is no DHCP server set this field to a unique Private 
IP address. For example: ‘192.168.0.10’ 

If your backup device is a second console it’s IP must be set 
to a different address, in the same range. For example: 
‘192.168.0.11’ 

IP Netmask Normally this field should be set to 255.255.255.0. If 
connecting to a LAN consult your IT department. 

Default 
gateway 

If you are connecting to a LAN consult your IT department. 

If you are using a Router with a DHCP server this field 
should be set to the IP of the router itself. 

If you are connecting with a Switch or Crossover cable or 
there is no DHCP server set this field to the same address as 
the console. 

 

3. Click OK to close the network window. 
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Computer network settings 
Configuration of the network settings on your PC will vary depending on the OS 
you are using but what you’ll need to enter is similar to the information detailed 
above. 

The most important thing is that each console or computer should have a unique 
IP and be on the same subnet. If you are using DHCP  this will be taken care of 
automatically. If you are using static IPs make sure each one is different. For 
example if the console or main computer’s IP is 192.168.0.10, your  backup device 
should be 192.168.0.11 (or any number between 1-254 but not 10). 

If you have changed your network settings restart the console or computer and 
confirm that the new settings have taken effect. 

Starting Tracking Backup 
To start Tracking Backup do this: 
1. On the main console or computer select the ‘Networking’ option on the File 

menu. Vista opens the Vista Network window: 

 

This field… does this… 

Name Shows the name of Vista consoles, computer systems and 
D1 devices that are detected on the local network. The 
console or computer you are working on is indicated by a * 
next to its name. 

Group Indicates the Group each device belongs to. Only devices 
that are in the same group can connect to each other. 

Devices that are not in the same group or are running a 
different software version are shown in red. 

To change the name or group of any device select the item in 
the list and press ‘Edit configuration’. 

Type Shows the console model or device type. 

Licensed 
Channels 

Shows the number of channels each device is licensed for. In 
a tracking backup system  the number of available channels 
is the sum of all connected devices. 

Vista User Guide, Version 2.3 16-3 



Starting Tracking Backup Appendix 3 – Tracking Backup 

This field… does this… 

Address Shows the IP of each device. 

Network Role Shows the role of each device. 

Sync / Re-Sync Syncs or re-syncs the show file to all devices in the group. 

Manual 
Connections 

Opens a window where you can enter an IP address for a 
known device that doesn’t appear in the Network window. 

Add to … 
Group 

Sets the selected device to the same group as the local 
console and opens a window where you can sync the show. 

Edit 
Configuration 

Open a window where you can set the name or group of any 
device on the network. 

Disconnect Disconnect the selected device from the current group. 

Failover now Press this button to have the slave console take over the 
show and all output. 

Connect to … 
Nodes 

Connects to compatible devices.  Vista systems  are 
connected as tracking backup slaves.   D1 units are 
connected for distributed processing. 

Show sync across devices may take a few minutes and when 
complete will be indicated in the ‘ Show Sync’ column. 

 

Ü The console or computer you are working on is marked with an asterisk (*). 

2. Configure each device that you want to use for tracking backup or 
distributed processing. When a device is added to an existing group Vista 
opens the Tracking Backup window on the Master and Slave device: 

 
Master 

 
Slave 
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3. On the Master click the ‘Sync Now’ button to copy the show to the slave 
device or ‘No’ to cancel and sync later. Alternatively click the ‘Join as Slave’ 
button on the slave device to copy the show from the Master. If you don’t 
want the slave to join the detected group click the ‘Start a new Vista 
Network’ button or ‘Quit’. 

4. If you didn’t sync the show file to all group devices at Step 3, use the 
‘Connect to Nodes’ button to start the process. 

5. Once all devices are configured click the ‘Close’ button. 

What happens if the Master fails 
If the Master or slave fails an alert window appears on the other console. 

 
 

Master Slave 

 

On the slave console there are two options: 
1. Click on the ‘Abort’ button to prevent the slave console from taking over the 

show and beginning to output. 

2. Click on the Failover now button to have the slave console take over the 
show immediately and begin to output. 

If neither  button is clicked the slave will take over when the countdown is 
finished. 

Ü If you are using networked DMX (i.e. sACN or Art-Net devices) output will 
automatically be transferred to the backup system. However if you are using 
the DMX outputs on your Vista console or control surface you must swap 
your DMX cables from the master to the backup console in the event of a 
failure. 

Manually switching to the backup console 
To manually switch to the slave device click on the ‘Failover Now’ button on the 
Failover tab. 
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Troubleshooting 
If you cannot see your slave console in the Vista Network window: 
1. Check all your Ethernet cables and connections. 

2. If you are using a computer turn off any firewall or port blocking. 

3. Check that the Group name is exactly the same on all devices in your backup 
system. 

4. Check that both the master and slave have IP addresses that are on the same 
subnet. 

5. Try adding the slave console’s IP address in the manual connections 
window. 

6. On your Vista L, T or I series you can check the IP by opening the Control 
Panel >  Network window from the File menu.  

7. On a Windows system you can find the IP address in Control panel > 
Network. On a Mac it’s in System Preferences > Network. 

8. Check the broadcast address (on the network tab of user preferences) is 
suitable for the network and the same on both the master and slave. 

9. On a Mac or Windows PC make sure that only one Network Interface is 
active. Having both the wired and wireless interfaces active may cause 
tracking backup to fail. 

10. Check that you can ‘Ping’ from the Master to the Slave and vice versa. 

11. Power down and re-start the console(s) and computer(s) you are using. 
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17. Appendix 4 –Distributed 
Processing 

The Jands Vista D1 expands the DMX processing capabilities of the entire Vista 
range. The rack mount D1 connects via Ethernet to a Vista console, Windows or 
Mac system and provides an additional 8192 channels (16 DMX universes).   

Setting up 
To connect  a D1 to a console  or  computer running Vista all devices have to be 
physically connected via their Ethernet ports and their network settings must be 
configured correctly. To do this: 

 

1. Connect from Ethernet Port A to your network using a Cat5 cable. 

2.  Connect power  using the supplied IEC power cable. 

3.  Connect one or more of the 8 DMX outputs to your lighting fixtures if 
required. 

When all cables are connected press the power button, on the front panel to turn 
on the unit. 

 

Once it finishes loading the program, the D1 displays the Home screen. On this 
screen you can see the D1 name and network address (if configured) and 3 
buttons to select the Monitor, Network and Setup windows. 
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Configuring the network settings 
All D1s  being used in a distributed processing system need an IP address on the 
same subnet as the console(s). If you are using a LAN or stand-alone Router a 
DHCP server will automatically assign Router IP addresses, provided the D1’s 
network interface is set to use DHCP. If you are using a Switch, Hub or 
Crossover cable you’ll need to set static IPs on all the devices in your backup 
system: 

Network settings 
To configure the network on a D1: 
1. Tap the Network button on the Home screen. Vista opens the ‘Configure IP 

Address’ window. 

2. Click the Network button. Vista opens the Network window: 

  

This field… does this… 

Using DHCP Select this option if your network has a DHCP server. 

Manually Select this option if you need to manually assign an IP 
address to the D1 unit. 

IPv4 Address Tap this field to set or change the IP address. 

The D1 must be set to a different address to all other devices 
on the network but be in the same range. For example if the 
console’s address is 10.101.0.10 and a backup computer is 
10.101.0.11 make the D1 address : ’10.101.0.12’ 

Port A / B Always select Port A. Port B is not enabled in the current 
software. 

IP Netmask Normally this field should be set to 255.255.255.0. If 
connecting to a LAN consult your IT department. 
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This field… does this… 

Default 
gateway 

If you are connecting to a LAN consult your IT department. 

If you are using a Router with a DHCP server this field 
should be set to the IP of the router itself. 

If you are connecting with a Switch or Crossover cable or 
there is no DHCP server set this field to the same address as 
used in the IPv4 Address field. 

 

3. Tap the Apply button to close the window. 

Setup 
Press the setup button to configure additional D1 settings. Vista opens the 
Network window: 

 

This field… does this… 

Name Sets the name of the D1 and is used to identify the unit from 
a console. 

Group Sets the Group name for the D1. Only devices that are in the 
same group can connect to each other. 

Network Ports 

Advanced 

Opens a window wher you can configure the TCP ports 
used for Vista networking . See below for more information. 

Update 

Apply Update 

Opens the update window where you can install a software 
update from a USB memory stick. 

Ü You can also set the D1’s name and group from the File > Networking 
window on your console. 
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Advanced Setup 
Press the Advanced button to configure the TCP ports used for Vista networking 
. Normally there is no need to change these settings. Vista opens the Network 
window: 

 

This field… does this… 

Vista Net Sets the TCP port used for Vista Net communications. 

Show Control Sets the TCP port used for Show Control communications. 

D1 Control Sets the TCP port used for communications with D1 units. 

Ü The ports used for Vista networking can be changed if they conflict with 
another service running on your network but none of the three port numbers 
should be the same as any other 

Monitor 
This window is not implemented in v2.3. 

Front panel LEDs 
The D1 front panel has indicator LEDs for power, disk activity, DMX activity and 
network activity. 

 

  

This LED… indicates this… 

PWR D1 is powered on. 

HDD The hard disk is being written to or read from. 
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This LED… indicates this… 

DMX 1 - 8 The physical DMX ports are in use. 

Network The Ethernet port is sending and receiving data. 

 

Shutting down the D1 
Press the power button once and tap shutdown on the LCD to powered down
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18. Appendix 5 – Vista statistics 

Checking system performance 
You can check the performance and status of all devices in a Vista network 
group. To do this select ‘Byron Statistics’  from the ‘Add Dockable Window’ 
option on the View menu : 

  

This field… indicates… 

Node Each processor (core) in each device is a Node. For example 
an L5 console has 4 cores so there are 4 rows that represent 
the 4 nodes on the console. 

Rate The processor refresh rate in Frames Per Second. 25fps is the 
normal rate. 

Ping (ms) The ping time between this node and the master in 
milliseconds. 

Channels The number of output channels this node is handling. 

Pool fixtures The number of fixtures, in the patch window pool, 
associated with this node. 

Show Sync The Sync status of this node. 

Show items The number of Fixtures, Groups, Cuelists, Cues, Events, 
Presets and Smart FX in the show file.. 
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This field… indicates… 

System The number of shared objects, the amount of memory and 
the CPU temperature for each node.. 

Statistics 
Refresh rate 

The refresh time interval for the statistics window. Normally 
set to 2 seconds. 

Disable HTP 
calcs 

For diagnostics. 

Disable FX calcs For diagnostics. 
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19. Appendix 6 – using VNC on L, 
T & I- series consoles  

VNC password 
The default password for VNC connections is ‘password’. 

Starting VNC 
To start the VNC server on a Vista L, T series or I series console: 
1. Restart the console. When the red Boot Menu  screen appears press any key 

to stop at this window. Then use keyboard  arrow keys to select a startup 
option. Select ‘VNC’ to start VNC normally or select ‘VNC 1024x768’ to start 
VNC and set the screen resolution to 1024x768 pixels. 

2. Vista will automatically start the VNC server. 

3. Vista is now running the VNC server. 

Connecting to Vista using a Windows PC 
The following procedure is for the VNC Viewer application from Real VNC 
(http://www.realvnc.com/download.html). Other VNC clients for windows 
work in a similar way: 
1. Check that the Vista and your PC are on the same subnet. I.E. if the Vista’s IP 

is 192.168.0.68, your PC should be 192.168.0.xxx (where xxx is 1-254 but not 
68). 

2. Start the VNC client. 
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3. In the ‘Connections Details’ window click the Options button, then the Misc 
tab: 

  

4. Tick the box marked ‘Shared Connection (do not disconnect other viewers)’. 
Click OK to close the options window. 

5. In the ‘Connections Details’ window enter the Vista IP (i.e. 192.168.0.65). 

6. Click OK to open the login window. 

7. Enter your password and click OK (leave the username blank). 

You should now be able to control the Vista. 

Connecting to Vista using a Mac 
The following procedure is for the Mac VNCViewer v2.01. 
(http://homepage.mac.com/kedoin/VNC/VNCViewer/index.html).  

Other VNC clients work in a similar way: 
1. Check that the Vista and your Mac are on the same subnet. I.E. if the Vista’s 

IP is 192.168.0.68, your PC should be 192.168.0.xxx (where xxx is 1-254 but 
not 68). 

2. Start the VNC client. 
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3. In the ‘Open Display’ window tick the box marked ‘Allow shared desktop’: 

  

4. In the ‘Hostname: display’ window enter the Vista IP (i.e. 192.168.0.68).  

5. Clear the entry in the box to the right of the IP (or enter 0). 

6. Click OK. VNC will open the login window. 

7. Enter your password and click OK (leave the username blank). 

You should now be able to control the Vista. 
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20. Appendix 7, Using Midi show 
control (MSC) with Vista  

You can activate and control cues by sending Midi Show Control (MSC) 
messages via:  

· the Midi in port on the Vista L, T, I and S series. 

· a USB to MIDI cable connected to a Mac or Windows system 

· a Mac or Windows network Midi port 

Configuring the Midi port 
Before you use Midi you have to set a ‘device ID’ that Vista will listen on. This 
should correspond to the ID the Midi controller is sending on. To set the device 
ID select ‘User preferences’ from the File menu and click on the ‘MIDI’ tab. 

 

Set the Midi Show Control Device ID to correspond with your controller or the 
Midi software package you are using . 

Ü Tick the ‘Use these settings for new shows’ checkbox to save these settings as 
defaults for new shows. 
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MSC lighting messages 
 
Midi controllers use standard terminolgy for lighting cues and cuelists 

This MSC term is equivalent to this Vista component… 

Q_number Cue Number 

<Q_list> Cuelist Number 

<Q_path> Not used 

 

Vista supports all the most commonly used MSC lighting messages. 

This message… does this… 

Go If a Q_number is specified, that cue plays. If no 
Q_number is specified, the next cues in numerical order 
and numbered identically and which are in Open Cue 
Lists GO. If a Q_number is sent without a Q_list, all cues 
with a number identical to Q_number and which are in 
Open Cue Lists GO.  

Go_Jam Starts a transition or fade to a cue simultaneous with 
forcing the Vista’s internal timecode clock to the 'Go 
Time' if the cue is a 'Timecode' cue. If no Cue Number is 
specified, the next cue in numerical sequence GOes and 
the clock of the appropriate Cue List Jams to that cue's 
time. If the next cue in numerical sequence is a 'Manual' 
cue (i.e. if it has not been stored with a particular 'Go 
Time,' the Go/Jam_Clock command is ignored. 

Go_Off Starts a transition or fade of a cue to the off state. The 
fade time is determined by cuelist’s release time. 

If no Cue Number is specified, the current cue GOes Off. 
If a Cue Number is specified, that cue GOes Off. 

Timed_Go Starts a timed transition or fade to a cue. If no Cue 
Number is specified, the next cue in numerical sequence 
GOes. Time is a standard time specification with 
subframes (type {ff}), providing anything from "instant" 
to 24 hour transitions.  

Stop Halts currently running transition(s). If no Cue Number 
is specified, all running transitions STOP. If a Cue 
Number is specified, only that single, specific transition 
STOPs, leaving all others unchanged. 
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This message… does this… 

Resume Causes Stopped transition(s) to continue running. If no 
Cue Number is specified, all Stopped transitions 
Resume. If a Cue Number is specified, only that 
transition Resumes, leaving all others unchanged. 

All_Off Turns all cuelist intensity output to 0% without changing 
any other features. Equivalent to fading the Grand 
Master to 0%. 

The console status prior to All_Off can be re-established 
by using the Restore command. Equivalent to fading the 
Grand Master to 0% 

Restore Re-establishes operating status to exactly as it was prior 
to ALL_OFF. 

Reset Releases all running cues..  

 

Midi control options  
You can send a message (for example Go) to several cuelists at once. To do this 
you first send an Open message to each of the cuelists. Vista supports the MSC 
messages to open and close cuelists. 

This message… does this… 

Open_cuelist Makes a Cue List available to all other commands and 
includes any cues it may contain in the current show. 

When OPEN_CUE_LIST is received, the specified Cue 
List becomes active and cues in it can be accessed by 
normal show requirements. Q_list in Standard Form 
must be sent. 

If the specified Cue List is already Open or if it does not 
exist, no change occurs. 

Close_cuelist Makes a Cue List unavailable to all other commands and 
excludes any cues it may contain from the current show. 

When CLOSE_CUE_LIST is received, the specified Cue 
List becomes inactive and cues in it cannot be accessed 
by normal show requirements, but the status of the cues 
in the list does not change. 

If the specified Cue List is already Closed or if it does not 
exist, no change occurs. 
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Midi Timecode options  
You can  also control Vista’s internal timecode clock with  Midi commands. 

This message… does this… 

Start_Clock Starts Vista’s internal timecode clock. If the clock is 
already running, no change occurs. If the clock is paused 
it continues counting from the time value which it 
contained while it was paused. 

If Q_list is not sent, the clocks in all Open Cue Lists Start 
simultaneously. 

If Q_list is sent in Standard Form, only the clock in that 
Cue List Starts. 

Stop_Clock Stops Vista’s internal timecode clock. If the clock is 
already stopped, no change occurs. While the clock is 
stopped, it retains the time value which it contained at 
the instant it received the STOP command. 

If Q_list is not sent, the clocks in all Open Cue Lists Stop 
simultaneously. 

If Q_list is sent in Standard Form, only the clock in that 
Cue List Stops.. 

Activating Snapshots with Midi  
Vista Snapshots can be activated with the MSC ‘Fire’ command . 

This message… does this… 

Fire Activates the specified Snapshot. 

The Fire command ‘Macro’ number activates the 
corresponding Snapshot ID number 

 

Ü Vista does not support these commands: 
Load, Set, Standby_Plus, Standby_Minus, Sequence_Plus, Sequence_Minus, 
Open_Q_Path, Close_Q_Path  
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21. Appendix 8, Using serial 
communication to control 
cuelists  

You can activate and control cues by sending text commands via the serial port 
on a Vista console or PC running the Vista application. Mac users will need a 
Keyspan 19H USB to serial converter to receive serial commands. 

Connecting to the serial port 
The cable that connects from the triggering device to the Vista should be a 
standard serial cable (also called a null-modem cable, or serial printer cable), not 
a serial cable extension. The important feature is that that pin2 at one end needs 
to be connected to pin 3 at the other end and vice-versa). 

Enabling the serial port 
The computer or other device sending the commands and the Vista must have 
their serial ports set to match each other. To set the Vista serial port select ‘User 
preferences’ from the File menu and click on the ‘Serial’ tab. Vista displays the 
Serial settings: 
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Vista L, T and I  consoles should be set to Serial Port 1, Baud Rate 9600, Data Bits 
8, Stop Bits 1, Parity None and Flow Control Xon/Xoff. 

PC (Windows) systems should be set the same way but the Com port can be 
changed to suit your computer’s configuration. 

On Mac systems the Keyspan 19HS device will appear in the Serial Port 
dropdown menu. 

Playback commands 
All commands should be sent to the Vista as single lines of text followed by 
Return or Enter. 

With serial commands you can only play the next cue in a cuelist. It is not 
possible to play a play a cue out of order. 

The syntax for sending commands is: 
Command {Cuelist ID} or {Name} or {Cuelist ID:Name} 

The supported commands to playback and load shows: 

This command… does this… 

Go Plays the next cue in the cuelist. Examples: 

Go 1, or  Go Dimmers,  or Go 1:Dimmers 

Pause {ID or 
Name or 
ID:Name} 

Halts playback of  the specified Cuelist. Example: 

Pause 5 

Rego {ID or 
Name or 
ID:Name} 

Resumes play of a paused Cuelist. Example: 

Rego 5 

Release Releases playback of  the specified Cuelist. Example: 

Release 1 

Load {show 
filename} 

Loads a show file. The full path to show showfile must 
be specified. Example: 

Load C:\ 

Setting fixture levels 
You can also send commands to set Fixture levels in the Programmer . The 
Syntax is: 

· {fixture id(s)} @ {level}  
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Where the fixture id is any combination of number, +, > and minus and level is a 
value between 0 and 100 or just f (or F) for full.  
Examples: 

· 1@F  -  fixture 1 to full  

· 1>10-5@ 75  -  fixture's 1,2,3,4,6,7,8,9 & 10 to 75%  

· 1>10-3>7@f  –  fixtures 1,2,8,9&10 to 100%  

Serial command acknowledgements 
Vista does not echo characters sent to the serial port but does send 
acknowledgements to confirm that commands have been received and either 
been accepted or have failed.  There are three response types: 

Commands that are understood and could be executed. 
Successful  commands  return the complete command appended with “OK”. For 
example 

 “go 1:List” it would return “go List:1 OK”. 

Commands that are understood but could not be executed. 
If the command is good but the object of that command is not known an error 
message will be returned. For example, if there was no Cuelist 100 

“go 100” would return “100 Unknown”. 

Invalid Commands 
If the command is not understood, the message “ ILLEGAL COMMAND” is 
returned. 

Ü Make sure that there is an end of line character (return or enter) at the end of 
each command. 

Ü Commands and cuelist names are *not* case sensitive. 

Ü Spaces before or after commands and cuelist names do not affect the 
behaviour. 

Vista User Guide, Version 2.3 21-3 



The Fixture Type Library Editor Appendix 9 – The Fixture Editor 

22. Appendix 9 – The Fixture 
Editor 

The Fixture Type Library Editor 
The new Fixture Type Library Editor is a separate application to the console 
software. On a Windows installation it can be found as an alias on the desktop 
and can be launched like any other Windows program. On a L, Tor I series 
console it is launched from the Patch window menu ‘Patch’ by selecting ‘Fixture 
Editor’. 

When launched a window is presented with an expanded directory of all 
fixtures, listed in manufacturer sub-directories, this is the factory default 
directory. Once this directory is collapsed, another directory is visible, this is the 
User Fixture Library and will initially be empty. 

Fixtures in the Factory directory cannot be modified, however, copies can be 
made and these will be placed in the User Fixture Library and are fully editable. 

 

It is recommended that the latest software library be installed and an exhaustive 
search of the fixture library be carried out to determine if the fixture required is 
not already in the library before writing your own fixture profiles. 
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Creating a Fixture Profile 
This section will detail, step by step, the process of creating a sample fixture 
profile. The fixture being a VL1100D Iris (I) Model. 
When the Fixture Type Editor is opened, the inbuilt library is automatically 
expanded, presenting a Manufacturers list containing all JANDS supplied 
fixtures. The fixture library is updated regularly and the latest revision should be 
installed to see if the fixture profile you require is in the list before writing your 
own fixture. 

For this tutorial, collapse the ‘Factory’ directory and select the ‘User Fixture 
Library’ 

 
 

From the Fixture menu select ‘New Fixture…’ 

 

 

A new, blank fixture window will open with five tabs across the top: 

 

This tab… is for… 
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This tab… is for… 

Main entering general fixture data. 

DMX Chart All DMX channel assignments and channel range values are 
entered in this tab 

DMX Macros Control macros, including strike, douse and reset are 
entered here. 

Notes Personal notes relating to the fixture can be entered here. 

History A chronological history of the fixture can be kept here. 

Main tab: 

 

This window is used to enter general information values for your fixture. To add 
or edit a value  double click in the field and either type directly in the field or 
select from the field’s popup menu. 

This field… is for… 

Manufacturer The name of the company that makes the fixture. 
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This field… is for… 

Full Name The complete, unabbreviated name as supplied by 
the manufacturer. 

Short Name An abbreviated name, of your choice, for the Fixture. 
This name will be used in the Chooser window when 
‘show Short Name’ is selected. 

Fixture Status Choose from the popup menu to select the 
appropriate status of the fixture file. 

Beam Type Choose from the popup menu to select the 
appropriate beam type of the fixture. 

Frame Type Choose from the popup menu to select the 
appropriate frame type, choose No Frame if the 
fixture has no framing mechanism. 

Movement Type Choose from the popup menu to select the 
appropriate movement type. 

Physical Type Choose from the popup menu to select the 
appropriate physical type. 

Light Generation Choose from the popup menu to select the 
appropriate light source. 

Maximum Pan Degrees Enter the maximum pan degrees as supplied by the 
manufacturer. This value is required in order for the 
flip function to work correctly. This information is 
generally not found in the DMX charts for a fixture, 
but, is usually found in the manufacturers 
specification sheet. 

Maximum Tilt Degrees Enter the maximum tilt degrees as supplied by the 
manufacturer. This value is required in order for the 
flip function to work correctly. This information is 
generally not found in the DMX charts for a fixture, 
but, is usually found in the manufacturers 
specification sheet. 

Element Count 
Horizontally 

Enter the number of horizontal, individually 
controllable elements within the fixture. Used for 
single fixtures with multiple elements such as LED 
fixtures. 

Element Count 
Vertically 

Enter the number of vertical, individually 
controllable elements within the fixture. Used for 
single fixtures with multiple elements such as LED 
fixtures. 
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This field… is for… 

Is a Scroller Defines whether the fixture is a scroller mechanism. 

Patch Part Count Determines how many patchable parts there are for 
the fixture. i.e. a par with a colour scoller will have 
two parts. One for the par and another for the 
scroller. 

Uuid This is a unique identifying number assigned to the 
fixture by the fixture editor and cannot be changed. 

Compatability Id This number is for advanced use. When an existing 
Factory fixture is duplicated and modified it will 
retain programmed attributes of the original (such as 
Preset information etc.) so long as this number is not 
altered. Once altered the fixture will become an 
independent fixture and lose those programmed 
attributes. 

Revision A revision number can be added here to keep track 
of multiple versions of the same fixture. 

Factory Version This is a factory library version tracking number. 

Carallon Version This version number is supplied by the Carallon 
database and is not relevant when writing fixture 
profiles. 

 

DMX Chart tab: 

 

This icon… does this… 

 

Opens the Add DMX Channel window 
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This icon… does this… 

 

Adds a DMX range to an existing channel. Inactive until a 
channel is created. 

 

Adds a Custom Mode to a channel, used when a feature range 
is not mappable to a generic control. i.e. Iris Pulse or Gobo 
Shake 

 

Adds a slot to a colour or gobo wheel channel. . Inactive until a 
channel is created. 

 

Use this button to delete selected DMX channels, Ranges, 
Modes or Slots. 

 

Add DMX Channel window: 

 
 

This field… is for… 
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This field… is for… 

Feature 
Class 

This determines which control palette the feature 
will reside in. Intensity Class reside in the Intensity 
palette, Beam in the Beam palette etc. 

Feature 
Type 

This determines which controls on the palette control 
which feature. For example one Beam Type may be 
Iris and another Zoom. Both features appear on the 
Beam contol palette, mapped to their respective 
controls. 

Feature 
Name 

This value is automatically set by the software unless 
a custom feature is created in which case a user 
assigned name must be applied. 

DMX Channel 
Type 

This will determine if the feature is 8 bit or 16 bit. 
The Fine channel field becomes active if 16 bit is 
selected here. 

DMX Channel 
Channel 

Is the Hi byte channel for the feature. 

DMX Channel 
Fine Channel 

Is the Lo byte channel for the feature (if applicable) 

DMX Channel 
Default Value 

This is the default DMX value for home and clear, 
ranging from 0-255. 

 

The DMX Chart window is used to enter all channel information for your fixture. 
Using the manufacturers DMX specification sheets, a channel list will be built in 
here, the channels can then have various attributes set. Addition of range 
mapping, slots for colours and gobos, mode settings for channels and any other 
information required to operate the fixture. 

Using the sample DMX specification for a VL1100D (I) Iris Model fixture this 
section will document how to enter data in the DMX tab for it. 
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DMX channel specification for a VL1100D (I) Iris Model 
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Channel 1: Intensity 
Click the DMX button to open the Add DMX Channel dialog. By default the 
dialog opens for the first time as below, it will open in the last opened state from 
now on. Notice the values are correct for this feature. Click OK to create. 

 

The Intensity 8 bit channel 1 has been created in the DMX Chart window. 

 

Channel 2 and 3: Pan Hi and Pan Lo: 16b 
Click the DMX button to open the Add DMX Channel dialog. Select Position in 
Class and Pan in Type. In the DMX channel section select 16 bit and assign the 
correct channel numbers. The Default value should be set to 127 as it is a 
midpoint default feature and the Hi Byte value only need be set. Click OK to 
create. 
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The Pan 16 bit channels 2 and 3 have been created in the DMX Chart window. 

 

Channel 4 and 5: Tilt Hi and Tilt Lo: 16b 
Click the DMX button to open the Add DMX Channel dialog. Select Position in 
Class and Tilt in Type. In the DMX channel section select 16 bit and assign the 
correct channel numbers. The Default value should be set to 127 as it is a 
midpoint default feature and the Hi Byte value only need be set. Click OK to 
create. 
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The Tilt 16 bit channels 4 and 5 have been created in the DMX Chart window. 

 

Channel 6: Edge 
Click the DMX button to open the Add DMX Channel dialog. Select Beam in 
Class and Focus in Type. In the DMX channel section select Standard and assign 
the correct channel number. The Default value should be set to 127 as it is a 
midpoint default feature. Click OK to create. 
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The Intensity 8 bit channel 6 has been created in the DMX Chart window. 

 

Channel 7: Zoom 
Click the DMX button to open the Add DMX Channel dialog. Select Beam in 
Class and Zoom in Type. In the DMX channel section select Standard and assign 
the correct channel number. The Default value should be set to 127 as it is a 
midpoint default feature. Click OK to create. 
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The Zoom 8 bit channel 7 has been created in the DMX Chart window. 

 

Channel 8: Frost 
Click the DMX button to open the Add DMX Channel dialog. Select Beam in 
Class and Zoom in Type. In the DMX channel section select Standard and assign 
the correct channel number. The Default value should be set to 0 as it is a 0 
default value feature. Click OK to create. 
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The Frost 8 bit channel 8 has been created in the DMX Chart window. 

 

Channel 9, 10 and 11: CMY Colour mix 
Click the DMX button to open the Add DMX Channel dialog. Select Colour Mix 
in Class and Cyan in Type. In the DMX channel section select Standard and 
assign the correct channel number. The Default value should be set to 0 as it is a 0 
default value feature, the Hi Byte default value only need be set. Click OK to 
create and repeat the process for Yellow and Magenta. 
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The three Colour Mix 8 bit channels 9,10 and 11 have been created in the DMX 
Chart window. 

 

Channel 12: Gobo Wheel 
Click the DMX button to open the Add DMX Channel dialog. Select Gobo Wheel 
in Class and Gobo Wheel in Type. In the DMX channel section select Standard 
and assign the correct channel number. The Default value should be set to 0 as it 
is a 0 default value feature. Click OK to create. 
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The Gobo Wheel 8 bit channel 8 has been created in the DMX Chart window. 

 

Channel 12: Gobo Wheel (cont.) 
Note there are three items added for this feature unlike previous features that 
have one simple range value assigned. 

Index Mode: Expand this section and select the range value section as below. 

 

As the specification requires the range for Gobo Wheel Indexing to be 0-127, the 
values need changing. On the right hand side of the DMX Chart window in the 
DMX range section. Apply the change as seen below and click apply. 
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The change to the channel range is reflected in the DMX Range column. 

 

Rotation Mode: Expand this section and select the range value section as below. 

 

As the specification requires the range for Gobo Wheel Rotation is  to be 128-255, 
only one range of values is required. By default most fixtures have clockwise and 
counter clockwise values as well as a stop value. The editor places ranges for 
these by default. The mechanism in our fixture only rotates in one direction so 
the first thing that is required is to delete the Anti-clockwise range, the Stopped 
range can remain and set to 127 if desired. This will make zero rotation on the 
controls  stop the wheel spinning at the last indexing value. 

Select the Anti-clockwise range: 

 

Now click the  button to remove the range. 

Channel 12: Gobo Wheel (cont.) 
As the ranges for Stopped and Clockwise rotation are the same as the 
manufacturers specification no other changes are required. The ranges for gobo 
wheel rotation are now set. 

 

Wheel Slots: Expand this section and Select it. Notice a single Open slot is loaded 
with a range of 0,0. 

 

Use the  button to create as many slots as is required. In this case add 
five slots to make a total of six. 
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As the Open slot values are already correct, select Slot #2. 

 

Channel 12: Gobo Wheel (cont.) 
 

On the right hand side of the DMX Chart window the controls are now available 
to add appropriate data with the selected slot. 

A Name may be applied, a Slot Type can be set (Gobo or Colour) a Category can 
be assigned, Category is useful in remodelling gobo patterns when changing 
fixture types, and an image can be set for preview on the console. 
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As with other features the DMX Range section is used to set the appropriate 
values for the slot,  as the specification below indicates, different values are 
required to operate the slot in either Indexing or Rotating modes. 

 

Channel 12: Gobo Wheel (cont.) 
Set the DMX Range values for Slot #2 as shown below, follow the same 
procedure for the remaining slots. The correct value for Slot #2 (18 or 146) will 
automatically switch between the two values depending on which control is 
currently being used on the console, i.e. indexing or rotating. 
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Click the Select Image button to open up the Images window, navigate to the 
gobos directory and search for the image required, select and open it then name 
it in the Name field. 

 

Tip: Switch the window view to Thumbnails for image previews. 

Channel 13 and 14: Gobo Rotation 
Click the DMX button to open the Add DMX Channel dialog. Select Beam in 
Class and Gobo Slot Rotation in Type. In the DMX channel section select 16 bit 
and assign the correct channel numbers. The Default value should be set to 127 as 
it is a midpoint default feature, the Hi Byte default value only need be set. Click 
OK to create. 
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The Gobo Wheel Slot 16 bit channels 13 and 14 have been created in the DMX 
Chart window. 

 

Channel 13 and 14: Gobo Rotation (cont.) 
Expand the Index Mode and Rotate ranges. 
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Select the range to edit and adjust the values on the right hand side of the DMX 
Chart window in the DMX range section. As this fixtures rotation Clockwise and 
Ant-clockwise are reverse to the default values inserted the ranges need to be 
edited. Apply the change as seen below to the Anti-clockwise range and click 
apply. Repeat this procedure for the Clockwise range, inserting the correct 
values. 

Anti-clockwise range values: 

 

Clockwise range values: 

 

As the default value for Stopped is already 127, this need not be adjusted. The 
Index Mode values supplied by default are the same as the fixture specification, 
so, it too, requires no adjustment. 

Channel 15: Iris 
Click the DMX button to open the Add DMX Channel dialog. Select Beam in 
Class and Iris in Type. In the DMX channel section select Standard and assign the 
correct channel number. The Default value should be set to 255 as it is a 255 
default value feature. Click OK to create. 
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The Iris 8 bit channel 15 has been created in the DMX Chart window. 

 

Channel 16,17 and 18: Timing channels 
These three channels differ from the previous channels created in that they do 
not map to generic controls. They will be Custom Feature channels that are 
associated with the Class of feature. 

For the Focus Time channel 17 (Varilite terminology states Focus is Position) click 
the DMX button to open the Add DMX Channel dialog. Select Custom Position 
in Class, Custom Position will automatically be assigned to Type and as we are 
creating a Custom Feature a feature name needs to be assigned, type in Focus 
Time. In the DMX channel section select Standard and assign the correct channel 
number. The Default value should be set to 0 as it is a 0 default value feature. 
Click OK to create. 
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Repeat this process for the remaining channels 17 and 18. Channel 17 will need 
Class and Type set to Custom Colour and named Colour Time, channel 18 will 
need Class and Type set to Custom Beam and named Beam Time. 

Channel 19: Control 
The Control channel is also created as a Custom feature, The Class needs to be set 
as Custom Misc and Name to Control. This will create the channel, values for the 
control macros will be set in the DMX Macros tab. 
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The Control 8 bit channel 19 has been created in the DMX Chart window. 

 

Channel 19: Control (cont.) 
To assign control macros, open the DMX Macros tab and enter the relevant 
information using the specification from the manufacturer. 

 

 

Syntax: channel @ value wait milliseconds, next command. 

Complex macros 
Some fixtures require more complex macros for strike/reset/douse. For example 
a fixture might require; ch1 to 255, ch4 to 17,ch 6 to 1, ch 8 to 0, ch 11 to 0 and ch 
15 to 84 and for these channels to be held for 6 seconds, and sent back to default 

In this case each command must state a wait time. The syntax is as follows: 

[channel] @ [value] # [wait time in milliseconds] 

So for the example above the macro would read as follows:  

1@255#0;4@17#0;6@17#0;8@0#0;11@0#0;15@84#6000 

That will send the specified values to all channels simultaneously and hold them 
for 6 seconds. 
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Saving the Fixture: 
Once all channel ranges have been created, spend a few  minutes checking them 
against the manufacturers specification. Click the OK button then choose OK 
from the resulting Save Fixture And Exit dialog. 

To use the fixture you will first need to exit the Fixture Library Editor, close the 
editor window and a confirmation dilaog will be presented. Click OK, the library 
will regenerate the library catalogues to incorporate your new fixture. Please be 
patient as this takes some time. Start Vista and the new fixture will be available 
for patching in the User Fixture Library. 

 

Channels with Custom Ranges 
While all the main features of fixtures are represented by generic controls on the 
console,  the ranges that do not fit the generic model are controlled by Custom 
Modes and Custom Ranges. A simple example of this is an Iris channel with 
pulse ranges. 

Iris: Example ranges: 

Iris closed to open: range: 0 – 128 

Iris Pulse-1 slow to fast: 129 – 190 

Iris Pulse-2 slow to fast: 191 - 255 

Create the custom ranges as below: 

 

The Iris Pulse controls will be found inside the Custom Iris widget in Vista: 
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Double click the widget to open the Custom Feature Browser, in order to access 
the custom Pulse range controls: 
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23. Appendix 10 – Crash Logs 

Retrieving Software Crash Files from a 
Console 
Although unusual software crashes can occur. If they do it is important that as 
much detail as possible is returned to Jands to enable the cause to be determined 
and eliminated. In order to simplify this process the console software includes a 
means to package all of the necessary files for return to Jands support. 

To generate a crash report package: 
1. Select the ‘Export logs…’ option from the Help menu. Vista opens the Export 

log files window. 

2. Select the file save location and change the filename if necessary. 

3. Click the Save button. 

Submitting a support request 
To submit a support request complete our online form at: 

http://jands.com/support-vista-v2/support-request-form/ 

Ü Be sure to complete all fields including your Vista the software version and 
build number, your console type and operating system. 

Ü Attach a copy the ‘Export logs’ file and include a description of what you 
were doing when the problem occurred. 
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24. Appendix 11 – the touchpad 
and the pen tablet 

Using the touchpad 
Like all pointing devices, the touchpad may take a short time to get used to. 
However you will soon find that using this device is natural and intuitive. 
Simply glide your finger across the surface of the pad to move the cursor and tap 
your finger to ‘click’. 

Click 
To click, lightly and quickly tap the surface of the pad once. Or, press the left 
button once. 

To double-click, double tap on the pad or click the left button twice.  

Right Click 
To right-click for submenus, tap the tap zone in the upper right corner of the 
touchpad or click the right button once.  

Drag 
To drag, draw, or highlight, double-tap rapidly and hold your finger down on 
the second tap, then glide to move. You may also hold the left button as you 
glide your finger. 

Glide Extend 
To drag further than the pad surface, lift and reposition your finger after 
reaching the textured edge. GlideExtend will virtually eliminate the edge of the 
pad while you drag. In other words, if you are dragging an item and you hit the 
textured edge, GlideExtend will hold the drag for three seconds while you 
reposition to complete the drag. To shut off GlideExtend earlier than three 
seconds, simply tap or click a button. 

Scroll 
To scroll, place your finger down the right edge of the touchpad and glide up or 
down. This feature requires third party software on Macintosh systems (see 
Macintosh advanced features section for USB version of Easy Cat). 
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Working with the grip pen  
This information is kindly provided by Wacom, the pen tablet manufacturer. 

As you work with the pen-tablet, you can rest your hand lightly on the display 
screen, just as if it were a drawing board or sheet of paper. Hold the Grip Pen as 
you would a pencil. Make sure the side switch is in a convenient location where 
you can press it with your thumb or forefinger, but won’t accidentally press it 
while drawing.  

 

Ü The Grip Pen should never be stored in a container where it will rest on its 
tip or eraser. When the pen is not in use, place your pen in the pen holder or 
lay it flat on your desk. 

Tip switch / Pen Tip  
The pen is activated as soon as it enters proximity, about 5 mm (0.2 in), above the 
Interactive Pen Display screen. This allows you to position the screen cursor or 
use the DuoSwitch without touching the pen tip to the display screen.  

When pressure is applied to the pen tip, the tip switch is turned on and the pen 
simulates a mouse button click. 

Eraser  
The eraser is not implemented in the Vista software.  

DuoSwitch (if available) 
The DuoSwitch can be used to perform a right click.  
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Using a pen  

Pointing and Selecting  
Move the Grip Pen above the pen tablet display screen to position the screen 
cursor. The cursor jumps to the location where you place the pen (absolute 
positioning). Press the pen tip on the display screen to make a selection.  

Clicking  
Tap the display screen once with the pen tip, or touch the pen to the display 
screen with enough pressure to generate a mouse click.  

Double-Clicking  
Quickly tap the display screen twice in the same place with the pen tip. Double-
clicking is easier when the pen is perpendicular to the tablet screen. 

Dragging  
Select an object, then slide the pen tip across the display screen to move the 
object.  

Erasing  
Erasing is not currently supported in the Vista system.  

Working with On Screen Display Settings  
The pen tablet display is equipped with an On Screen Display function. The OSD 
function enables you to adjust and optimize a variety of display settings at the 
touch of a button. The OSD controls are located above the tablet on the T series 
consoles and in the armrest of the L series.  

 

Selection buttons  
Use these buttons to select an option that can then be activated when you press 
the Enter button. 
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After activating a selected option, press the + button to increase a selected item 
value, and press the button to decrease it.  

The basic process for working with the OSD is as follows:  
1. Press the Menu button to open the OSD main menu.  

2. Use the + or - buttons to select an option. When the option you want to 
adjust is highlighted, press the Enter button. The current settings and 
adjustment sub-menu for that option will appear.  

3. Use the + or - buttons to adjust the option settings.  

4. When you have made your changes, press the Enter button to save. To exit, 
press the Menu button.  

Ü All settings are automatically saved when the OSD menu closes. If you make 
changes to the display appearance and cannot return to the original settings, 
use the Reset Recall option to return The pen tablet to its original factory 
defaults.  

Caring for the Cintiq pen tablet 
Keep the Grip Pen and the Cintiq LCD screen surface clean. Dust and dirt 
particles can stick to the pen and cause wear to the display screen surface. 
Regular cleaning will help prolong the life of your LCD screen surface and pen. 
Keep Cintiq and the Grip Pen in a clean, dry place and avoid extremes in 
temperature.  

Caution - If the pen tip becomes sharp or angular, it may damage the coating on 
the display screen. Please replace the pen tip if necessary.  

Cleaning the Pen-Tablet 
To clean the Grip Pen, use a soft cloth and mild detergent (such as dishwashing 
liquid) diluted with water. Do not use paint thinner, benzine, alcohol, or other 
solvents.  

To clean the display screen, use an anti-static cloth or a slightly damp cloth. 
When cleaning, apply only a fixture amount of pressure to the display screen and 
do not make the surface wet. Do not use detergent to clean the display screen; 
this may damage the coating on the screen. Please note that damage of this kind 
is not covered by the manufacturer’s warranty.  
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Replacing the Pen Tip 
The pen tip will wear with normal use. When the pen tip gets too short, you can 
replace it with one of the extra tips that came with the pen.  

 

To remove the old tip:  
Clasp it with a pair of tweezers, needle-nosed pliers, or similar instrument and 
pull the old tip straight out of the pen. 

To insert a new tip: 
Slide it straight into the barrel of the pen. Firmly push the tip until it stops. The 
new tip will slide into the correct position.  

If the pen tip wears and becomes angular, it may damage the coating on the Pen 
tablet display screen. To avoid this, periodic tip replacement is recommended.  

WARNING Prevent children from swallowing the pen tip or side switch. The 
pen tip or side switch may accidentally be pulled out if children are biting on 
them.  

Precautions on using and handling the Pen-
Tablet 

Temperature and Humidity  
Operating temperature and humidity 5˚ to 35˚C, 20 to 80% RH  

Storage temperature and humidity -10˚ to 60˚C, 20 to 90% RH  

CAUTION. Do not use or store the pen tablet where:  

· Temperature changes are severe or exceed specifications (e.g., outdoors 
or inside a vehicle).  

· The pen tablet and the Grip Pen are exposed to direct sunlight or heat 
from an appliance.  

· The pen tablet and the Grip Pen are exposed to water or any other kind 
of liquid.  

CAUTION. Do not use The pen tablet in a dusty environment; this may damage 
the unit 
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Handling  
WARNING: If the LCD screen has been damaged, DO NOT touch any liquid 
that may be leaking from it; this liquid is an irritant. In case of contact with skin, 
eyes, or mouth, rinse immediately with running water for at least 15 minutes or 
more. If contact is made with the eyes or mouth, also consult a physician.  

WARNING: Prevent children from swallowing the pen tip or side switch. The 
pen tip or side switch may accidentally be pulled out if children are biting on 
them.  

CAUTION: Do not disassemble the Grip Pen. This may cause the device to 
malfunction. In this case, Wacom shall have no responsibility to repair or replace 
the product. 

CAUTION: Do not scratch the display screen. Avoid placing sharp objects on 
the display screen surface.  

CAUTION: Avoid intensive shock or vibration to the pen tablet or the Grip 
Pen. Hitting or dropping the pen tablet display may damage the display screen 
or other components.  

CAUTION: Do not put heavy articles on the Interactive Pen Display or push 
against it with a strong force; this may damage the display screen or bend the 
stand.  

CAUTION: If the pen tip becomes sharp or angular, it may damage the coating 
on the display screen. Please replace the pen tip if necessary.  

CAUTION: Do not use any organic solvent (e.g., alcohol) or even mild 
detergent to clean the display screen. Use of these cleaners can damage the 
coating on the screen. Please note that damage of this kind is not covered by the 
manufacturer's warranty.  

To clean the display screen, use an anti-static cloth or a slightly damp cloth. 
When cleaning, apply only a fixture amount of pressure to the display screen and 
do not make the surface wet.  

To clean the pen tablet casing or Grip Pen, use a soft cloth with mild detergent 
(such as dish washing liquid) diluted with water. 
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25. Appendix 12  – technical 
details  

Power 
 T4 / T2 / 

I3 / L5 
E2 / S3 S1 M1 

Power Requirements: 100VAC to 240VAC +/- 10%, 50-60 Hz USB 
powered 

Power Consumption: 400 Watts 
max 

40 Watts 
max 

20 Watts max 2.5 Watts 
max 

Power Connector: IEC 3-pin USB 

Service & Maintenance 
With care Vista products will require little or no maintenance. However, the 
internal battery (in the T and I series only)will need to be replaced on a regular 
basis (see the following section). 

If the front panel requires cleaning, wipe with a mild detergent on a damp soft 
cloth. 

The CD drive mechanism battery (in the T4 / T2  console only) is mechanical and 
should always be treated with care. Never allow the entry of fluids into the slot. 

DO NOT spray liquids onto the front panel. 

DO NOT use solvents for cleaning the front panel. 

Warning: Do not allow the entry of liquids of any sort into the console chassis. 

The T4 / T2 CPU tray should be periodically cleaned to ensure dust does not 
build up near the fans. 

Battery replacement 
The Vista T and I series consoles have an internal battery that is used to maintain 
system BIOS settings. The battery should last approximately 5 years from the 
date the battery was made. If the console reports BIOS check errors, please return 
the console to an authorised agent for battery replacement. 
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Installation 
Vista consoles and control surfaces must be installed in a location that allows 
adequate ventilation around the rear of the product. There must be at least 
150mm of free space around the rear and sides of the console when in use. 
Failure to allow adequate ventilation may result in premature shutdown of the 
console. 

An external UPS may be connected if mains blackouts are anticipated. 

L5 / I3 / T4 / T2  Shut down 
Always use the correct procedure to shut the console down. Select ‘Shutdown’ 
from the File menu. 

General Specifications 

Inputs & Outputs 
Description Type Pin Outs Function 
DMX 512 (1-4) 5 pin Female AXR  1 

2 
3 
4 
5 

Shield 
Data – 
Data + 
Data – (DMX 4 only) 
Data + (DMX 4 only) 

Ethernet 
(100BaseT) 

RJ-45  1 
2 
3 
4 
5 
6 
7 
8 

Transmit + 
Transmit – 
Receive + 
Unused 
Unused 
Receive – 
Unused 
Unused 

SMPTE (Audio) 3 pin Female AXR  
 

1 
2 
3 

Shield 
LTC – 
LTC + 

MIDI In 5 pin Female DIN  1 
2 
3 
4 
5 

NC 
Shield 
NC 
RX+ 
RXD 
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Description Type Pin Outs Function 
MIDI Thru/Out 5 pin Female DIN 1 

2 
3 
4 
5 

NC 
Shield 
NC 
TX+ 
TXD 

COM (RS232) 9 pin D 1 
2 
3 
4 
5 
6 
7 
8 
9 

DCD 
RXD 
TXD 
DTR 
Gnd 
DSR 
RTS 
CTS 
RI 

Trigger In 6.5mm Jack Socket Tip 
Sleeve 

Trigger In 
Ground 

Trigger Out 6.5mm Jack Socket Tip 
Sleeve 

Trigger Out 
Ground 

Video 1 
Video 2 

15 pin High Density D 1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 

Red 
Green 
Blue 
NC 
Ground 
Red Ground 
Green Ground 
Blue Ground 
Vcc 
Sync Ground 
NC 
VD Data 
Horizontal sync 
Vertical sync 
VD Clock 

USB Type A 1 
2 
3 
4 

Vcc 
Data – 
Data + 
Ground 

Audio Mic 3.5mm Jack socket Tip 
Sleeve 

Signal 
Shield 

Audio Out 3.5mm Jack socket Tip 
Ring 
Sleeve 

Left 
Right 
Shield 

Audio Line In 3.5mm Jack socket Tip 
Ring 
Sleeve 

Left 
Right 
Shield 
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Description Type Pin Outs Function 
Desk Lamp 1 
Desk Lamp 2 

 1 
2 
3 

Chassis 
Lamp – 
12V 
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26. Index 
A 
ACN 

Streaming, 5-20 
add 

cue, 7-15 
adding 

events to the timeline, 7-43 
adjust 

timing, 7-45 
Advanced Properties, 5-10 
alias cues, 7-17 
alias cues, 7-23 
aligning 

start and end points, 7-46 
all events view 

filtering, 7-37 
All panel, 6-21 
Alt, 4-4 
applying 

saved timing, 7-34 
applying extracts, 6-55 
arranging the quickpicker, 6-42 
arranging the quickpickers, 6-39 
ArtNet 

Broadcast Mode, 5-19 
compatible devices, 5-18 

audio 
adjusting cues to, 9-3 

Audio, 9-1 
audio playback, 7-28 
autosave, 2-13, 2-14, 2-15 

B 
backup, 16-1 
backups 

exporting shows (backing up), 2-5 
battery, 25-1 
beam, 6-25 

setting, 6-25, 6-33 
blocking, 7-23 

include all tracked events in a cue, 
4-8, 7-18 

built in effect 
applying, 6-54 

buttons 
configuring, 4-10 

buttons, 4-2 
Shift, Alt, Ctrl, 4-4 

C 
calibrating the pen, 3-1 
changing 

a cue, 7-18 
universes, 5-5 

Channels, 5-12 
chase properties, 7-29 
checking that your fixtures are 

working, 6-20 
Chooser menu, 14-8 
chooser window, 6-1 

matrix, 6-11 
sort order, 6-17 

cli, 6-56 
cloning fixtures, 5-14 
CMY, 6-22 
colour 

setting in detail, 6-27 
colour 

setting, 6-22 
colour wheel, 6-23, 6-30 
Command Line Interface, 6-56 
commands 

within cuelists, 7-48 
components 

assigning to controls, 6-60, 12-13 
Components tab, 6-37 
configurations 

saving, 7-33 
configuring 

the sidebar, 4-10 
configuring 

buttons, 4-10 
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connecting to the console via FTP, 
15-1 

console 
I3, 12-1, 12-2 
M1, 12-2 
S1, 12-2 
S3, 12-2 
T2, 12-2 

console 
layout, 12-1 
setting up, 2-1 

console 
T4, 12-1 

console 
modifier keys, 12-3 

console 
configuring the console, 12-11 

console 
configuring the console, 12-12 

console 
pages, 12-21 

console 
snapshots, 12-21 

console control panel, 3-1 
console hardware, 12-1 
Console menu, 14-8 
console settings, 3-1 
control panel 

console settings, 3-1 
Control panel, 3-5 
controls 

effects, 8-4 
crash logs, 23-1 
creating 

a show, 2-4 
extracts, 6-55 
groups, 6-45 
presets, 6-46 
release events, 7-47 

Ctrl, 4-4 
cue 

adding and deleting, 7-15 
block, 4-8, 7-18 
changing single cues, 7-18 
merge, 7-16 
move or copy, 7-16 
properties, 7-21 

cue properties, 7-21 

cuelist 
adding audio, 9-1 
audio, 7-28 
block step, 4-8, 7-18 
chases, 7-29 
date & time control, 10-3 
default properties, 7-29, 7-30 
editing, 7-10 
midi control, 20-1 
moving around in, 7-12 
moving events around, 7-44 
navigator, 7-12 
notes, 7-30 
opening in the editor, 7-10 
playback control window, 11-1 
playback rate, 7-28 
playing, 7-12 
progress indicator, 7-42 
properties, 7-26, 12-19 
release timing, 7-28 
selection handles, 7-45 
serial control, 21-1 
timecode, 7-28 
timeline, 7-35 
timeline and, 7-7, 7-10 
updating during playback, 7-49 
using commands within, 7-48 
using timecode, 10-1, 10-3 
view as layout, 7-15 
view as table, 7-14 
view cue list, 7-13 

cuelist defaults, 7-29, 7-30 
cuelist notes, 7-30 
Cuelist pane, 11-1 
cuelist tabs, 7-11 
cuelists, 7-1 
cues 

adding audio, 9-1 
alias, 7-17, 7-23 
blocking, 7-23 
cue layout view, 7-15 
cue list view, 7-13 
cue table view, 7-14 

custom 
gobo, 6-32 
setting custom focus & frame 

values, 6-34 
setting custom values, 6-31 

custom values 
about, 6-35 
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customising 
control panel, 3-1 

D 
d1, 17-1 
Date & Time, 10-3 
date and time, 3-5 
DBO, 12-2 
default times, 7-31 
delete 

cue, 7-15 
deleting 

fixtures, 5-7 
shows, 2-7 

desk lights, 2-1 
detailed panels, 6-26 
disconnecting 

an interface box, 5-19 
displays 

setting up, 3-2 
distributed processing, 17-1 
DMXinterface 

configuring, 5-17 
dousing a fixture, 4-11, 5-14 
duplicating 

layout views, 6-6 

E 
edit 

cuelist, 7-10 
Edit menu, 14-2 
editing 

extracts, 6-56 
in the Playback control window, 

11-5 
presets, 6-48, 6-50, 6-51, 6-52 

editor status bar, 7-41 
effect 

applying, 6-54 
effects, 6-53, 8-12, 8-14 

applying template effects, 6-54, 8-1 
controlling, 8-4 
modifying template effects, 8-2 
rate control, 8-4 
reviewing, 8-2 
saving, 8-13 
stopping, 7-48 

types, 8-1 
using, 8-1 

effects window 
advanced tab, 8-10 
feature tab, 8-5 
sequence tab, 8-8 

Ethernet-DMX interface 
changing settings of, 6-2 
configuring, 5-17 
connecting, 5-18 
disconnecting, 5-19 
setting the port, 5-18 

event bars, 7-35 
about, 7-43 

events 
aligning start and end points, 7-46 
changed, 7-44 
fade curve, 7-47 
muting, 7-47 
release, 7-47 
release events, 7-47 
reset to default time, 7-47 
selection handles, 7-45 
snap, 7-44 

expanding playbacks, 12-14 
exporting shows, 2-5 
external displays, 2-1 
extracts 

applying extracts, 6-55 
creating extracts, 6-55 
editing, 6-56 

F 
fade curve, setting, 7-47 
feature 

summarise by, 7-36 
filters 

choosing, 7-37 
creating custom  filters, 7-37 
managing saved, 7-39 
one click, 7-40 

fine mode, 6-22, 12-6 
Fixture, 5-9 
Fixture editor, 22-4 
Fixture files 

editing, 22-4 
Fixture Id, 5-9 
Fixture Name, 5-9 
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fixture sort order, 6-17 
Fixture Type, 5-9 
fixtures 

adding to groups, 6-44 
adding to the patch panel, 5-2 
arranging fixtures in a layout, 6-1 
checking that your fixtures are 

working, 6-20 
choosing, 5-2 
cloning, 5-14 
controlling, 5-14 
deleting, 5-7 
dousing, 4-11, 5-14 
Fixtures screen, 6-1 
hiding and ‘unhiding’ fixtures, 6-

3, 6-5 
import patch from CSV, 5-15 
patching, 5-1 
properties, 5-8 
rearranging on the patch panel, 5-

5 
renaming, 5-6 
renumbering, 5-6 
resetting, 4-11, 5-14 
selecting, 6-12, 13-3 
sort order, 6-13 
sorting, 6-12 
striking, 4-11, 5-14 
summarise by, 7-36 

focus, 6-25 
frost, 6-25 
FTP, 15-2 

connecting via, 15-1 
function keys 

assigning, 12-3 

G 
gels 

manufacturer, 6-23, 6-30 
generic fixture model, 1-2 
gobo 

setting, 6-24, 6-31 
Grand Master, 12-2 
groups 

adding fixtures to, 6-44 
creating, 6-45 

H 
hardware 

programmer controls, 6-58 
Help menu, 14-13 
hiding 

fixtures, 6-3, 6-5 
highlight, 6-20 

preset, 6-50 
home 

preset, 6-51 
HSV, 6-22, 6-29 
hue, 6-22, 6-29 

I 
importing shows, 2-5 
input devices 

setting up, 3-2 
inputs & outputs, 25-2 
installation, 25-2 
intensity 

setting, 6-21 
setting in detail, 6-26 

interface, 4-1 
Invert pan, 5-10 
Invert tilt, 5-10 
IP Address, 3-4, 3-5 
IP Gateway, 3-5 
IP Net mask, 3-5 
iris, 6-25 

J 
jump 

using the keyboard, 12-10 

K 
keypad 

in the programmer, 5-4, 6-56 

L 
layout 

adding notes, 6-9 
arranging fixtures in, 6-1 
different views, 6-2, 6-3 

layout view 
activating, 6-6 
arranging, 6-6 
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duplicating, 6-6 
layout window 

adding notes to, 6-9 
arranging fixtures, 6-10 
grid, 6-10 

layouts 
managing views, 6-3 
options, 6-5 
organising, 6-6 
properties, 6-4 

LCDs 
screensaver, 3-3 

Learn Timing, 9-2 
Lee swatchbook, 6-23 
Limit, 5-10 
list view, 5-13 
Live Time Window, 6-52 
loading 

existing shows, 2-4 
logs, 23-1 
lowlight, 6-20 

preset, 6-50 

M 
manufacturer 

gels, 6-23, 6-30 
matrix 

placing fixtures, 6-11 
menu 

Chooser menu, 14-8 
Console menu, 14-8 
Edit menu, 14-2 
Help menu, 14-13 
Patch menu, 14-6 
Session menu, 14-1 
Step menu, 14-3 
Timeline menu, 14-10 
Tools menu, 14-4 
View menu, 14-11 

menu bar, 4-1 
menu reference, 14-1 
merge 

cue, 7-16 
midi control, 20-1 
midi input, 2-12 
midi show control, 20-2 
modifier keys, 12-3 

monitoring active cuelists, 11-1 
move or copy cues, 7-16 
moving 

events around, 7-44 
fixtures around the patch panel, 5-

5 
msc, 20-2 
muting 

events, 7-47 

N 
names 

renaming fixtures, 5-6 
navigating, 4-1 
network 

preferences, 3-4 
notes 

adding to the layout window, 6-9 

O 
Offset, 5-11 
output view tabs 

adding, 13-1 
output window, 13-1 

configuring, 13-2 
outputs & inputs, 25-2 

P 
Page controls, 12-12 
pages, 12-21 
palettes 

common features of the palettes, 
6-19 

summary & detailed views, 6-18 
tabs, 6-18 

parameters 
fine mode, 6-22, 12-6 

Park, 5-14, 14-8 
password-protecting shows, 2-7 
paste options, 7-16 
patch 

importing a CSV file to, 5-15 
viewing in different ways, 5-12 

Patch menu, 14-6 
patch panel 

adding the fixture to the patch 
panel, 5-2 
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moving fixtures around, 5-5 
rearranging fixtures on, 5-5 

patch window 
toolbar, 4-11 

patching 
adding fixtures to the patch panel, 

5-2 
adding fixtures to the rig, 5-1 
complete fixture list, 5-2 

patching your rig, 5-1 
pen, 24-2 

calibrating, 3-1 
playback 

assigning components to controls, 
6-60, 12-13 

popup menu, 12-18 
status indication, 12-17 
timecode, 10-1 

playback buttons 
assigning functions, 12-14 
group masters, 12-19 

Playback Control Window, 11-1 
Playback rate %, 7-25, 7-28, 7-29 
playbacks 

expanding, 12-14 
standard and split modes, 12-13 
with faders, 12-11 
without faders, 12-12 

position 
setting, 6-21 
setting in detail, 6-27 

power, 2-1, 2-2, 25-1 
preferences 

network, 3-4 
Preferences 

control panel, 3-5 
user, 2-8 

Preheat, 5-9 
presets 

availability, 6-44 
presets 

labels, 6-44 
presets 

updating, 6-45 
presets 

about, 6-46 
presets 

creating, 6-46 

presets 
editing, 6-48 

presets 
updating, 6-48 

presets 
highlight and lowlight, 6-50 

presets 
editing, 6-50 

presets 
editing, 6-51 

presets 
home, 6-51 

presets 
editing, 6-51 

presets 
editing, 6-52 

presets, updating, 7-49 
Priority, 7-25, 7-27, 7-30, 20-2 
prism, 6-25 
programmer hardware controls, 6-58 
programmer, using the keypad, 5-4, 

6-56 
progress indicator, 7-42 
properties 

cue, 7-21 
cuelist, 7-26 
fixtures, 5-8 
layouts, 6-4 
setting cuelist properties, 12-19 

Q 
quickpicker 

arranging, 6-39, 6-42 
multi, 6-40 
popup menu, 6-41 

q-view, 7-41 
Q-View, 7-42 

R 
raw 

setting raw intensity and position 
values, 6-26, 6-27 

remote control, 19-1 
renaming 

fixtures, 5-6 
renumbering 

fixtures, 5-6 
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rest 
fixtures, 4-11, 5-14 

reviewing effects, 8-2 
RGB, 6-22 
right-click 

using the LR button, 12-3 
rotation, 6-24, 6-31 

S 
saturation, 6-22, 6-29 
save 

filters, 7-39 
saving 

copies of shows, 2-5 
effects, 8-13 
password-protecting, 2-7 
shows, 2-4 
timing configurations, 7-33 

screensaver, 3-3 
selecting fixtures, 6-12 
selection 

display order, 6-13 
selection handles, 7-45 
selection order, 6-13 
selection tools, 6-12 
serial control, 21-1 
serial input, 2-11 
service & maintenance, 25-1 
Session menu, 14-1 
set timing window, using, 7-45 
setting 

beam, 6-25 
colour, 6-22 
gobo, 6-24 
position, 6-21 

setting cuelist properties, 12-19 
setting up, 2-1 
settings 

console, 3-1 
control panel, 3-1 

Shift, 4-4 
show 

creating a show, 2-4 
deleting, 2-7 
exporting shows (backing up), 2-5 
importing shows, 2-5 
loading existing shows, 2-4 

password-protecting, 2-7 
saving, 2-4 
saving copies of, 2-5 

shutdown, 25-2 
sidebar, 4-10, 6-18 

components tab, 6-37 
configuring, 4-10 
smartfx tab, 6-37 

slider 
intensity values, 6-21 
setting intensity values in detail, 

6-26 
smartfx 

event mode, 7-24, 7-25 
SmartFX, 6-53, 8-1 
SmartFX tab, 6-37 
snapshots, 12-21 
soft buttons, 4-2 
software updates, 15-1 
sorting 

fixtures, 6-12, 6-13 
specifications, 25-2 
split modes, 12-13 
standard mode, 12-13 
statistics, 18-1 
status 

editor, 7-41 
Step menu, 14-3 
Step pane, 11-2 
stopping 

effects, 7-48 
store 

selecting a cue and store options, 
7-8 

selecting a cuelist, 7-8 
store all, 7-1 
store part, 7-7 
storing 

modulating effects, 6-54 
swinging effects, 6-54 

Streaming ACN, 5-20 
striking a fixture, 4-11, 5-14 
summary 

by feature, 7-36 
by fixture type, 7-36 

summary views, 7-36 
Swap pan/tilt, 5-10 
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swing 
making an effect swing, 8-13 

swing effects, 8-7 
switching on, 2-2 
Symmetrical, 5-11 

T 
table view, 5-12 
technical information, 25-1 
template effect 

applying, 8-1 
modifying, 8-2 

the multi quickpicker, 6-40 
time and date, 3-5 
timecode, 7-22, 7-28, 10-1, 10-3 

adjusting cues to, 9-3 
Timecode, 10-1 
timeline 

about, 7-7, 7-10, 7-35 
adding events to, 7-43 
aligning start and end points, 7-46 
cuelist tabs, 7-11 
default times, 7-31 
event bars, 7-35 
fade curve, 7-47 
moving events around, 7-44 
reset event time, 7-47 
zooming in and out, 6-2, 22-13, 22-

17, 22-18, 22-19 
Timeline menu, 14-10 
timeline window, 7-11 
timing 

applying, 7-34 
making precise adjustments, 7-45 
using the set timing window, 7-45 

Timing 
Learn, 9-2 

timing configurations 
saving, 7-33 

toolbar reference, 14-1 
toolbars, 4-11 

chooser and timeline windows, 4-
12 

main, 4-1 
patch window, 4-11 

Tools menu, 14-4 
touchpad, 24-2 

tracking backup, 16-1 
transformers, 5-10 

U 
universes 

changing, 5-5 
update software, 15-1 
updating 

presets, 6-45, 6-48, 7-49 
USB interfaces, 5-18 
user preferences 

autosave, 2-13, 2-14, 2-15 
console, 2-9 
general, 2-8 
midi, 2-12 
naming, 2-9 
serial, 2-11 

User Preferences, 2-8 
using effects, 8-1 

V 
view 

summary, 7-36 
the rig, 5-12 
using different views, 6-2 

View menu, 14-11 
viewing 

patch in different ways, 5-12 
views 

list view, 5-13 
table view, 5-12 

vista 
statistics, 18-1 

vnc, 19-1 

W 
window basics, 4-1 
windows 

chooser, 6-1 
navigating, 4-1 

Z 
zoom, 6-25 
zoom in and out, 7-40 
zooming in and out, 6-2, 22-13, 22-

17, 22-18, 22-19 
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